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第 １ 章 　
序 論

1.1　本研究の目的と意義

　本研究の目的は，二方向に形成された生化学物質の濃度勾配下における血管内皮細
胞の遊走性を観察および評価可能なデバイスを構築することである．具体的には，ま
ず両脇にゲルが存在する捕捉部を持つ微小流路デバイスを設計および製作し，血管内
皮細胞からなるスフェロイドを捕捉できることを示す．次に，ゲルの外側にある流路
に二つの異なる種類および濃度の生化学物質を流すことで，スフェロイドを挟んで二
つの方向に異なる濃度勾配を形成できることを示す．最後に，提案するデバイスを用
いて，二方向から増殖因子や血管新生を促進する化学物質を導入した場合の，血管内
皮細胞の遊走性を定量評価できることを示す．
　血管新生は，既存の血管から新しい血管が形成される生理学的なプロセスであり，
血管内皮細胞の遊走を起点として開始される [1]．生体内では，その遊走の方向性の制
御が，正常な胚発生や発育に重要な役割を果たすことが知られている [2,3]．生体内で
血管内皮細胞の遊走の方向性を決定する重要な要因の一つが，種々の生化学物質によ
る複雑な濃度勾配の分布である [4]．そのような生化学物質の例として，これまでに，
血管内皮増殖因子（vascular endothelial growth factor，VEGF）[5–8]，スフィンゴシン
-1- リン酸（sphingosine-1-phosphate，S1P），[5,6,9–11]，ホルボール 12- ミリスタート 
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13- アセタート（phorbol 12-myristate 13-acetate，PMA）[5,6,12,13]，単球走化性タンパ
ク質 -1（monocyte chemoattractant protein-1，MCP-1）[6,14] 等による血管内皮細胞の遊
走の促進と調節への効果が，in vitro の実験系で示されてきた．また，通常の生体内に
は極微量しか存在しないが，過剰な塩化コバルト（CoCl2）が擬似的な低酸素状態を誘
導し，間接的に VEGF の産生を刺激することが報告されてきた [15]．近年，微小流体
デバイスを用いることで生化学物質の濃度勾配を形成し，ゲル上に播種された血管内
皮細胞の層 [16,17] や，ゲル中に包埋されたスフェロイド [18–20] からの血管内皮細胞
の遊走を，濃度勾配の起点，ここでは標的物質の流れる流路の方向へと制御する研究
が報告されてきた．しかし，これらのデバイスでは，標的物質の流れる流路からゲル
および血管内皮細胞の層に向かう一方向にしか濃度勾配を形成できないか，あるいは
複数の流路から異なる標的物質を流したとしても，それらの物質がスフェロイド周囲
のゲル中に混在するようになるため，複数の方向性を持った濃度勾配の形成が不可能
であった．
　そこで本研究では，二方向に形成された生化学物質の濃度勾配下における血管内皮
細胞の遊走性を観察および評価可能なデバイスの構築を目的とする．具体的には，ま
ず両脇にゲルが存在する捕捉部を持つ微小流路デバイスを設計および製作し，血管内
皮細胞からなるスフェロイドを捕捉できることを示す．次に，ゲルの外側にある流路
に二つの異なる種類および濃度の生化学物質を流すことで，スフェロイドを挟んで二
つの方向に異なる濃度勾配を形成できることを示す．最後に，提案するデバイスを用
いて，二方向から増殖因子や血管新生を促進する化学物質を導入した場合の，血管内
皮細胞の遊走性を定量評価できることを示す．本デバイスは，複雑な生化学物質の環
境を有する生体において，血管新生の方向性が決定される際の候補物質のスクリーニ
ングに有用なツールとして応用可能であると考えられる．本研究の発展により，血管
新生が関わる多様な領域，即ち胚発生のプロセスの研究，腫瘍の治療薬開発，再生医
療における三次元臓器の構築といった幅広い領域に寄与することが期待される．なお，
本論文題目に含まれる「化学濃度勾配」とは，"chemical gradient" を訳語化したもので
あり，増殖因子や化学物質の濃度勾配を表す．

1.2　研究の背景と従来研究

1.2.1　生体内での血管および血管内皮細胞の機能
　生体の血管は血液の流路として，組織中への酸素，ナトリウムイオンやカリウムイ
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オン等の電解質，ホルモンやサイトカイン，増殖因子等のシグナル伝達物質，タンパ
ク質や糖，脂肪酸，コレステロールといった栄養素となる種々の生化学物質の運搬，
そして各組織で生じた二酸化炭素，尿素，尿酸やクレアチニンといった代謝産物の除
去および運搬，さらには免疫細胞の輸送といった生命維持に重要な様々な役割を果た
している [21]．
　血管の中でも様々な生理活性機能を持ち，生理機能の発現に重要な細胞とされる
のが，血管の内壁を覆っている血管内皮細胞である．血管内皮細胞は，血管の物質
透過性や血管運動神経緊張度（vasomotor tone）[22]，白血球の輸送，止血，血管新生
の調節といった多様な働きをする [23]．また，血圧の調節のために平滑筋の弛緩を誘
導させ血管拡張を引き起こす一酸化窒素（NO）やプロスタサイクリン（prostaglandin 

I2，PGI2），アドレノメデュリン（adrenomedullin），血管収縮を引き起こすエンドセリ
ン（endothelin）といった様々な血圧調節物質の産生も担っている [24]．さらに，抗凝
固作用を持つトロンボモジュリンや血小板凝集を抑制するプロスタグランジンを産生
し，血液凝固を妨げているのも血管内皮細胞の重要な機能である [25]．こうした働き
は，血管内皮細胞が外部から受容した様々な刺激に応答して変化することが知られて
いる．これらの刺激には，小分子やホルモン，タンパク質，酸素，他の細胞といった
生化学的刺激 [26–28] と血流の剪断応力といった機械的刺激 [29–32]，細胞外マトリク
ス（extracellular matrix：ECM）といった物理的要因 [33,34] が含まれる．
　生体内で，血管と組織との物質の授受は，組織中に張り巡らされた毛細血管とそれ
らを取り巻くように存在する細胞との間で，細胞外マトリクスに充溢した間質液を介
した物質拡散を通じて行われている [35,36]．毛細血管は，主に血管内皮細胞のみから
構築された管腔であり，物質交換の機能を担っている．こうした物質交換において，
細胞の生存に重要な物質の一つは酸素である．このような酸素の拡散による供給と細
胞内での酸素の消費との平衡から，細胞が生存するためにはその周囲 150–200 µm 以
内に毛細血管が存在していなければならないことが分かっている [37]．一方で，血液
は主に心臓の左心室から大動脈へと送り出された後，末梢臓器に到達して物質交換を
行い，上下の大静脈に集められて心臓の右心房に帰ってくるという体循環を経て，さ
らに右心室から肺動脈を通って肺へと送り込まれ肺静脈を通って左心房に帰ってくる
肺循環を経て再び左心室に戻るという経路を循環している [21]．そのため，体内の全
ての末梢臓器に血液が送り込まれ，かつ各臓器を構成するすべての細胞との物質交換
を行うことが可能となるためには，血管は多数の分岐構造を有し，広範に組織を張り
廻るネットワークを形成することが必要である．この複雑な血管ネットワークの構築
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において重要な役割を果たすのが，血管新生である．

1.2.2　生体内での血管新生および血管内皮細胞の遊走の意義
　血管新生は，既存の血管から新しい血管が形成される生理学的なプロセスであり，
血管内皮細胞の遊走を起点として開始される．血管新生は，出芽，伸長，分岐，管腔
形成というプロセスをたどって進行し，その中で血管内皮細胞は増殖や遊走を含む複
合的な挙動を示すと理解されている．まず，VEGFR-2 が活性化した血管内皮細胞の内，
delta-like ligand 4（Dll4）の発現および分泌が高まった細胞が先端細胞（tip cell）とな
り，タンパク質分解酵素を分泌する糸状仮足を発現して ECM を溶解することで，既
存血管からスプラウトを形成する．先端細胞は標的物質の方向に遊走することで，新
生血管の伸長の方向を決定するとともに，周囲の血管内皮細胞を，VEGFR-2 の発現の
抑制により，増殖活性の高い茎細胞（stalk cell）へと誘導する．この茎細胞が先端細
胞に続くことで新生血管が伸長し，分岐しながらネットワーク形状を形成する．さら
に，茎細胞内部の液胞が発達して融合することで，管腔が形成され，これらのネット
ワークに血流が及ぶようになる．最終的には，ファランクス細胞（phalanx cell）によっ
て VEGF が中和されることで，血管新生が停止され，壁細胞の内皮細胞への接着によっ
て新生血管が成熟化する [38,39]．このように，血管新生においては血管内皮細胞が外
部からの刺激に応答して，先端細胞や茎細胞といった細胞に分化し，プロセスが進行
する．なお，血管新生には，発芽的血管新生（sprouting angiogenesis）と嵌入型血管新
生（intussusceptive angiogenesis）があるが，本文では血管新生と表記した場合，発芽的
血管新生のことを指す．
　血管新生は，生体内で正常な状態で起きる生理学的血管新生（physiological 

angiogenesis）と疾患時に起きる病的血管新生（pathological angiogenesis）とに大別される．
生理学的血管新生の多くは胚発生期に極めて重要な役割を果たすが，成人期にも卵巣
や子宮内の女性生殖管で毎月数日間重要な役割を果たしている [40]．また，創傷の治
癒時等にも 2 週間程度この生理学的血管新生が起きる [41,42]．これらの生理学的血管
新生の特徴は，短い期間で起きることである．また，生じた新生血管は，多くが退行
するが，そうでない場合は周皮細胞等によって囲まれ，成熟化した血管になる [43,44]．
一方で，病的血管新生は，腫瘍形成時および慢性炎症時に起こり，数ヶ月から数年に
わたって持続することが特徴である．この時，血管内皮細胞が急速に増殖を続けるため，
新生血管は周皮細胞に乏しく，自然に退行することはほとんどない [45,46]．
　こうした生体内における血管新生および血管内皮細胞の遊走では，その開始のタイ
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ミング，伸長および遊走の速さと方向性の制御が，正常な胚発生や発育に重要な役割
を果たす．これらの制御が上手くいかない場合，発育不良や失明といった疾患を負う
リスクもある [47,48]．生体内で血管内皮細胞の遊走の方向性を決定する要因は多岐に
渡るが，最も重要な要因の一つが，種々の増殖因子やケモカイン，ホルモンといった
生化学物質による複雑な濃度勾配の分布である [49]．従って，こうした生化学物質に
よる血管内皮細胞の遊走への速さや方向性への効果を調べることは，発生学の研究や，
疾患の治療法開発，さらには移植医療を目指した三次元組織構築といった幅広い領域
においてその発展に寄与すると考えられる．
　血管内皮細胞の遊走を促進する生化学物質の例として，血管内皮増殖因子（VEGF）
[5–8]，スフィンゴシン -1- リン酸（S1P）[5,6,9–11]，ホルボール 12- ミリスタート 13-

アセタート（PMA）[5,6,12,13]，単球走化性タンパク質 -1（MCP-1）[6,14] 等が挙げられ，
これらの生化学物質による血管内皮細胞の遊走の促進と調節への効果が，in vitro の実
験系で示されてきた．また，通常の生体内には極微量しか存在しないが，過剰な塩化
コバルト（CoCl2）が擬似的な低酸素状態を誘導し，転写因子 HIF-1 αのアップレギュ
レーションを介して VEGF の産生を刺激することが報告されてきた [15]．

1.2.3　生体外での血管内皮細胞の遊走性評価法
　これまで，種々の生化学物質による血管内皮細胞への増殖能，遊走能，管腔形成能
の促進効果または抑制効果を評価するために，多くの in vivo，ex vivo，および in vitro

の評価法が開発されてきた．in vivo および ex vivo の評価法は，より正確に生体の微小
環境を用いることで，適切な情報を得ることが可能である．それに対し，in vitro の評
価法は，血管新生のプロセスにおける特定の段階を観察するために使用され，初期評
価に用いられる [50]．
　in vitro 評価法で使用される血管内皮細胞としては主に，ヒト臍帯静脈内皮細胞
（human umbilical vein endothelial cells，HUVEC）[51]，ヒト皮膚微小血管内皮細胞（human 

dermal microvascular endothelial cells，HDMEC），ウシ大動脈内皮細胞（bovine aortic 

endothelial cells，BAEC）等が伝統的に使用されてきた．中でも HUVEC は，ヒト由来
の細胞であり，かつ豊富な先行研究により知見が蓄積されてきたため，モデル細胞と
して広く用いられている．また近年では，肺や脳といった様々な臓器の血管由来の内
皮細胞が初代細胞として製品化されている [52]．
 　in vitro での具体的な血管内皮細胞の遊走性評価法としては，創傷治癒アッセイ
（wound healing assay）[53]，ザイモグラフィ法（zymography）[54,55]，ボイデンチャン
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バアッセイ（Boyden chamber assay，トランズウェルアッセイ）[56]，金貪食法（phagokinetic 

track assay）[57]，そして本論文で注目するスプラウトアッセイ（sprouting angiogenesis 

assay）[58–60] 等がある（図 1.1）．
　創傷治癒アッセイでは，コンフルエントに増殖させた血管内皮細胞の層の一部を，
ピペットの先端や細胞スクレーパによって剥がし，近辺の血管内皮細胞の遊走を観察
する [53]．この評価法は，簡便に行うことができ，細胞の移動面積等の定量的なデー
タを取得することが可能である．しかし，コンフルエントな状態での細胞数や細胞密
度を再現良く一致させるのが困難であることから，再現性を得ることが難しいとされ
ている（図 1.1a）．
　ザイモグラフィ法では，血管内皮細胞から分泌されたマトリックスメタロプロテアー
ゼ（Matrix metalloproteinase：MMP）を電気泳動により分離精製し，それを ECM ゲル
に作用させて分解活性を評価する [55]．この評価法では，具体的に MMP のゲルの分
解活性を調べることができるため，血管内皮細胞の遊走性に関わる物質レベルの基礎
的な情報を得ることができる．しかし，MMP の分離精製等，工程が多く時間もかかり，
また血管内皮細胞の遊走を直接観察するものではないという欠点がある（図 1.1b）．
　ボイデンチャンバは，トランズウェルとも呼ばれる．培地が加えられた上側のメン
ブレンフィルタインサート（孔径数マイクロメートル）上に血管内皮細胞を播種し，
生化学物質が加えられた下側のウェル中に静置することで，フィルタを介して生化学
物質が血管内皮細胞に作用し，遊走性が向上した血管内皮細胞が細孔をすり抜けてウェ
ル中に遊走する [56]．この評価法では，染色により膜を通過した細胞数を数えて定量
的な評価を行うことが可能である．また，生化学物質の濃度変化に応じた遊走性の変
化を評価することができるという利点がある．ただし，最終的には生化学物質の濃度
勾配がチャンバ全体で平衡化するため，走化能（chemotaxis）ではなくケモキネシス能
（chemokinesis）を有する生化学物質を作用させた場合にも細胞がフィルタを通過して
しまい，生化学物質が持つそれらの性質を識別することが難しいという欠点がある（図
1.1c）．
　金貪食法は，金ナノ粒子で覆われた基板上に血管内皮細胞を播種して培養すること
で，金ナノ粒子の移動や細胞の貪食による消失により，細胞の移動の軌跡を得る評価
法である [57]．実際の血管内皮細胞の全体的な運動の結果を得ることができるため，
遊走の方向性等も調べることが可能である．しかし，金ナノ粒子で覆われた基盤は，
ECM とは異質なものであるため，生体内の血管内皮細胞の遊走を模倣できているとは
言えないという欠点がある（図 1.1d）．
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スプラウトアッセイでは，血管内皮細胞をゲルとゲルの間に挟み込む，あるいは血管
内皮細胞を播種したビーズまたは血管内皮細胞からなる細胞凝集塊であるスフェロイ
ドをゲル中に包埋することで，ゲル中へのスプラウトを生じさせる [58–60]．この評価
法では，スプラウトの面積や長さ，本数，分岐の数等により定量的なデータを得るこ
とができる．ECM や基底膜を再現するためのゲルの材料の選択によって結果が大きく
変動するので，ゲルの成分の最適化が重要であるとされている（図 1.1e）．この評価法は，
実際に血管内皮細胞が ECM 中を遊走することから，生体に近い振る舞いを観察可能
だと期待されている．そのため，近年は，スフェロイドを使ったスプラウトアッセイ，

創傷治癒
アッセイ
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[7,63–75]

[54,55]
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図 1.1 in vitro の遊走評価法．(a) 創傷治癒アッセイ（wound healing assay），(b) ザイモグラフィ
（zymography），(c) ボイデンチャンバアッセイ（Boyden chamber assay，トランズウェルアッセイ），
(d) 金貪食法（phagokinetic track assay），(e) スプラウトアッセイ（sprouting angiogenesis assay）．
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および微小流体デバイスと組み合わせたスプラウトアッセイが注目されている．

1.2.4　スフェロイドを用いたスプラウトアッセイ
　スフェロイドは，一種類あるいは複数種類の細胞（上皮細胞，間葉細胞，内皮細胞
等）により構成される，三次元の，丸みを帯びた細胞の凝集塊であり，細胞を非細胞
接着性のウェル中等で培養することで簡便に形成することが可能である [61,62]．近
年，血管の生理現象をより再現した腫瘍モデルの構築を目指して，血管新生および血
管内皮細胞の遊走を in vitro の系で調べるためのツールとして，血管内皮細胞そのもの
に代わり，三次元培養モデルとして有用であるスフェロイドが使用されてきた [7,63]．
中でも，ECM を模倣したゲル中でスフェロイドを用いて行うスプラウトアッセイが，
増殖因子，マイクロ RNA 等の血管新生に関与する生化学物質の分析 [7,64–67]，血管
新生阻害のための薬剤スクリーニング [68–70]，ティッシュエンジニアリングにおけ
る灌流培養技術の開発 [18–20] といった研究のためのプラットフォームとして注目さ
れてきた．こうしたスフェロイドには，血管内皮細胞のみからなるスフェロイドに加
えて，血管の周皮細胞（ぺリサイト）への分化能を有する間葉幹細胞（mesenchymal 

stem cells，MSCs）との共培養スフェロイドや，新生血管の安定化に寄与し，かつ FGF

や VEGF 等の種々の血管新生を促進するサイトカインや ECM 中のコラーゲン等の繊
維タンパク質を産生することで知られる線維芽細胞（fibroblasts）との共培養スフェロ
イド等が用いられてきた．これまで，そうした共培養スフェロイドを用いた評価系に
より，VEGF[7]，ヒト線維芽細胞増殖因子（human fibroblast growth factor，FGF）[64]，
R3- インスリン様増殖因子 (R3-insulin-like growth factor，IGF)[65]，miRNA[66,67] と
いった血管新生に関わる生化学物質の同定や，sunitinib[68]，vatalanib[69]，corydalis 

yanhusuo[70] といった血管新生阻害剤の候補物質の検出が行われてきた．
　また，機械刺激を用いたスフェロイドの培養として，材料化学を基板とした基質開
発 [71]，デバイスによる繰返し引張刺激 [72]，磁力を用いる手法 [73] によって，新生
血管を配向させたり，ECM を配列させたりした例が報告されている．さらには，線維
芽細胞 [74] または CD34 発現細胞 [75] との共培養等による血管新生への影響も報告さ
れてきた．

1.2.5　微小流体デバイスを用いたスプラウトアッセイ
　近年，微小流体デバイス技術の発展により，細胞や溶液の精密な操作や，薬剤投与
の評価等の研究が盛んになっている．微小流体デバイスの重要な利点として，溶液混
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合の制御，化学濃度勾配の形成，低試薬消費量，連続的な灌流と細胞上の圧力および
せん断応力の正確な制御等が挙げられる [76]．これらの利点を活用することで，より
生体の組織環境を再現した微小環境で細胞を培養することが可能である [77]．また，
スフェロイドまたは組織の一部を微小流路に設けた捕捉部に流し込み，捕捉すること
によって位置を固定したり配列させたりしながら培養や薬剤応答評価を行う技術が注
目されている [78–81]．微小流体技術を用いたスフェロイドの捕捉は，一般的な試み
ではなく，微小流体デバイス中でスフェロイドを扱うほとんどの研究では，スフェロ
イドの形成と培養を同一装置内で行う微小流体チップ（microfluidic spheroid formation 

chip，µSFC）が主として利用されている [82]．マイクロ構造またはマイクロウェルに
基づく µSFC は，大量のスフェロイドを作製可能な代わりに，アプリケーションが限
られるという欠点がある [82]．言い換えれば，様々な組み合わせや濃度での同時薬物
試験は，µSFC 上で行われることはほとんどない．ほとんどの µSFC は，薬物の 1 つの
濃度，または薬物の 1 つの組み合わせのみを用いて大量のスフェロイドに適用するよ
うな実験に用いられる．したがって，薬物の種類や濃度ごとに複数のチップを使用し
なければならない．一方で，培養専用チップ（microfluidic spheroid culture chip，µSCC）
では，チップの外で別の方法でスフェロイドの形成を進める必要があり，スフェロイ
ドの直径にばらつきが生じ得ること，取り扱いが面倒であること，低スループットで
あること等の欠点があるが，幅広いアプリケーションに対応したデバイス設計が可能
であるという利点がある [82]．
　微小流体デバイスと組み合わせたスプラウトアッセイとして，血管内皮細胞をゲル
上に播種し，ゲルに包埋した線維芽細胞を用いてそのエクソソームの濃度勾配を利用
したり [16,17]，間質流により形成した生化学物質の濃度勾配を利用したりする [83] こ
とで，血管新生を誘導した例が数多く報告されてきた [84–86]．
　さらに，微小流体デバイスとスフェロイドを組み合わせた培養として，ゲル中に包
埋されたスフェロイドからの血管内皮細胞の遊走を，流路の方向へと制御する研究が
報告された [18,19]．この研究では，最終的にゲル上に播種した血管内皮細胞からのス
プラウトとゲル中に包埋されたスフェロイドからのスプラウトを吻合させることで，
培地灌流可能なネットワークが構築された．
　以上述べてきた通り，こうした微小流体デバイスを用いることで生化学物質の濃度
勾配を形成し，ゲル上に播種された血管内皮細胞の層 [16,17,87–91] や，ゲル中に包埋
されたスフェロイド [18–20] からの血管内皮細胞の遊走を，濃度勾配の起点，ここで
は標的物質の流れる流路の方向へと制御する研究が報告されてきた．しかし，これら
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のデバイスでは，標的物質の流れる流路からゲルおよび血管内皮細胞の層に向かう一
方向にしか濃度勾配を形成できないか，あるいは複数の流路から異なる標的物質を流
したとしても，それらの物質がスフェロイド周囲のゲル中に混在するようになるため，
複数の方向性を持った濃度勾配の形成が不可能であった．

1.3　本研究の提案手法

1.3.1　  提案手法
　本論文では，両脇にゲルが存在する捕捉部を持ち，捕捉部のある中央流路，および
その両外側にゲルを挟んで隣接する二本の流路を持つ微小流体デバイスを提案する（図
1.2）．このデバイスは，中央流路に狭窄した流路（捕捉部）を有するため，スフェロ
イドを導入することで，狭窄した流路にスフェロイドが詰まり，それにより捕捉が実
現される．目的とする生化学物質を外側の二本の流路に個別に導入することで，異な
る生化学的勾配を形成することができ，様々な生化学的勾配の下での血管新生の方向
性を調べることができる．実験では，スフェロイドの捕捉とその後のスフェロイドの
ゲルへの付着を確認しており，スフェロイドに対して，二方向から別々の生化学物質
の濃度勾配を適用可能である．さらに，そのような条件下において，スフェロイドか
らの血管新生および血管内皮細胞の遊走を観察可能である．撮像した画像を用いて，
血管内皮細胞のゲル方向へのスプラウト領域の面積を数値データとして取得すること
で，血管内皮細胞の遊走性を定量的に評価することが可能である．本デバイスを用い

図 1.2  本研究の提案手法．(Attribution 4.0 International (CC BY 4.0)）
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ることで，様々な生化学物質を用いて，血管内皮細胞の遊走への効果を定量評価し，
それらの生化学物質による血管内皮細胞の遊走の促進効果および方向性に対する効果
を調べることが可能である．

1.3.2　本研究の位置付け
　本研究では，二方向に対して生化学物質の濃度勾配を形成し，血管新生および血管
内皮細胞の遊走への効果を，大きさと方向性の二つの要素に関して定量的に評価およ
び比較可能な培養系を構築する．それらの機能を実現する本デバイスの重要な特色は，
デザインした微小空間へのゲル形成機構およびスフェロイドの捕捉機構を組み合わせ
た流路の構造である．この構造は，先行研究における微小流体デバイス中でのスフェ
ロイドの培養に関する諸研究と，微小流体デバイスを用いたスフェロイドの捕捉技術
を組み合わせるという，筆者および共著者のオリジナルの発想によるものである．
　生化学物質による血管内皮細胞の遊走の大きさや方向性への効果を in vitro で調べる
ためのツールは，発生期の胚の応用的な培養や，特に腫瘍等の疾患治療のための薬剤
開発，さらには移植医療を目指した三次元組織構築に重要な内部への血管ネットワー
クの構築といった幅広い領域への応用可能性が期待される．本研究は，そうした応用
研究のための基盤となる研究であると位置づけることができる．

1.4　本論文の構成

　本論文は全 5 章から構成される．

第１章　序論
　本研究の目的と意義，本研究の背景，および従来研究について記述した．また，本
研究の提案手法および既存研究との位置付けについて説明した．

第２章　培養デバイスの作製と機能評価
　本研究で提案する，二方向に生化学物質の濃度勾配を形成可能なスフェロイド培養
デバイスの設計，および当該デバイスの局所的なゲル形成機能，スフェロイド捕捉機能，
および濃度勾配形成機能の評価について記載する．

第３章　培養デバイスを用いた血管内皮細胞培養機能の評価
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　作製した培養デバイスを用いて，スフェロイドおよび血管内皮細胞の培養を行い，
血管新生および血管内皮細胞の遊走が観察可能であることを示す．さらに，培地灌流
を伴う培養の効果について記載する．

第４章　二方向への生化学物質の濃度勾配下における培養
　提案するデバイスを用いて，二方向から増殖因子や血管新生を促進する化学物質を
導入した場合の，血管内皮細胞の遊走性を定量評価できることを示す．

第５章　結論
 　本研究の結論を述べる．
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第 ２ 章 　
培 養 デ バ イ ス の 作 製 と 　 　

機 能 評 価

2.1　緒言

　本章ではまず，本デバイスのデザインと作製方法について記載する．本デバイスは，
流路に形成された二つのゲルの間にスフェロイドを捕捉でき，ゲルの両外側の流路か
ら生化学物質を含む培地を送液することで，濃度勾配を形成可能となるよう設計，作
製した．さらに本章では，本研究で目的とする，二方向への生化学物質の濃度勾配の
存在下における血管内皮細胞の遊走性の観察・評価を実現するためのデバイスの要件
として，（i）ゲルの形成，（ii）スフェロイドの捕捉，（iii）各流路への送液，（iv）物質
の濃度勾配の形成の 4 つを規定し，それぞれが実現可能であることを実験により示す．

2.2　本デバイスの作製

2.2.1　デバイス概要
　本デバイスは，微小流路および培地チャンバの二つの部品からなる．図 2.1 に本
デバイスの作製プロセスを示す通り，全工程の概要は下記の通りである．まず微小
流路のモルドを作製し，パリレン被覆処理を行った後にポリジメチルシロキサン
（polydimethylsiloxane，PDMS）を用いて構造を転写する（図 2.1a）．次に，PDMS の転
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写構造物に穴を開けた後に，ガラスとボンディングすることで微小流路を作製する（図
2.1b）．最後に，培地チャンバを三次元造形により作製し，微小流路と接着剤で結合さ
せることで，本デバイスが完成する（図 2.1c）．培養時には，ピペットチップを微小流
路の送液口に差し込んで，培地チャンバに培地を満たす（図 2.1d）．以下では，微小流
路および培地チャンバの設計および作製の各工程について詳述する．

2.2.2　微小流路の設計
　微小流路は図 2.2 に詳細を示すように，ゲル溶液を導入するための上部流路および
下部流路，スフェロイドを装填するための中央流路，ゲルを形成するための領域（ゲ
ル形成領域）から構成されている．ゲル形成領域は，平面図から分かる通り中窪の構
造になっており，上部・下部流路側から中央流路側へ進むにつれ領域の幅が狭まる構
造を有する（図 2.2a）．さらに，ゲル形成領域の高さ（400 µm）が上部・下部流路と
中央流路の高さ（500 µm）の 80% に設定されている（図 2.2b）．これらの特徴のため，
図 2.3 に概念図を示す通り，上部・下部流路とそれに続くゲル形成領域で導入された
ゲル溶液は，ゲル形成領域から中央流路への漏出とゲル形成領域から上部・下部流路
への流失の双方が表面張力によって防がれると期待される設計となっている（図 2.3b）．
したがって，注入されたゲル溶液を上部・下部流路から吸引することで，ゲル形成領

図 2.1  本デバイスの作製プロセス図．（a）パリレン被膜されたモルドを用いた PDMS 転
写物の作製，（b）PDMS 転写物への送液口の作製とカバーガラスとの接着，（c） 微小流路の
作製および培養チャンバとの接着，（d）ピペットチップを用いた培地導入．(Attribution 4.0 

International (CC BY 4.0))

(a)

(c)

(b)

(d)

モルド
PDMS
転写物 カバー

ガラス

送液口

パリレン被膜

培地チャンバ

光硬化性樹脂

培地

ピペットチップ
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域のみにゲル溶液を残存させることができる（図 2.3c,d）．さらに，中央流路には幅
が狭窄した流路が存在し，そこに流されたスフェロイドが留まる構造になっている
[92,93]．このような構造により，スフェロイドを両側にゲルが配置された空間に捕捉
することができ，上部流路，下部流路，および中央流路の各流路からそれぞれ培地を
供給することにより，スフェロイドの培養を行うことができる（図 2.3e,f）．本研究では，
スフェロイド培養が可能であることを示すためのデモンストレーション用のデバイス
として，上部流路，中央流路とそれらの間に一つのゲル形成領域のみが存在する設計
の微小流路も用いた．このデザインの三次元モデルを三次元コンピュータ支援設計
（computer-aided design，CAD）ソフトウェア（In Design 2018 および 2020，Autodesk 社）
を用いて作製し，stl ファイルとして保存し，この後の工程の光造形装置へのデータ入
力に使用した．

2.2.3　微小流路の作製
　光造形装置（Perfactory 4 mini，EnvisionTEC 社）を用いて流路形成のためのモルド
を三次元造形した（図 2.4）．モルドの材料の光硬化性樹脂としては，HTM140 V2 お
よび R11（いずれも EnvisionTEC 社）を使用した．造形物を光造形装置から取り出し
た後，2- プロパノール（関東化学株式会社）の洗浄液中に入れ，超音波洗浄装置（UT-

(a) (b)

2 mm

500 μm

500 μm

1500 μm

2 mm

2 mm

上部流路

下部流路

中央流路
捕捉部

ゲル
形成
領域

ゲル
形成
領域

2 mm

500 μm

500 μm

100 μm

500 μm

400 μm

400 μm

図 2.2 微小流路のデザイン図．（a）平面図，（b）立体図と各部の名称．(Attribution 4.0 

International (CC BY 4.0))
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150HS，シャープ株式会社）を用いて，1 分間の超音波洗浄を行った．作製したモル
ドには，オーブン（IndM-300，アズワン株式会社）を用いて 50℃で 30 分間乾燥させ
た後に，PDMS への転写の鋳型として使用するために，パリレン蒸着装置（Parylene 

Deposition System 2010，日本パリレン合同会社）を用いてモルドの表面全域に約 4 µm

の膜厚でパリレン C（日本パリレン合同会社）を被覆した．このパリレン被覆処理を
行うことによって，PDMS が未硬化のままモルドの表面に残存してしまうことが防が
れる．続いて，PDMS（SYLGARD™ 184 Silicone Elastomer Kit，ダウ・東レ株式会社）
を本剤と硬化剤の重量比が 10：1 となるよう加え，自転・公転ミキサー（あわとり練
太郎，AR-100，株式会社シンキ―）を用いて 1 分間の混合および 1 分間の気泡除去を
行った．モルドを静置した 100 mm ディッシュ（100 mm 細胞培養表面処理済みディッ
シュ，Corning, Inc.）に約 25 g の混合した PDMS を流し込み，真空デシケータ（VL 型，
アズワン株式会社）内で真空状態下に 20 分間以上置くことで，気泡を除去した．こ
れにより，PDMS の硬化時にモルド周囲で気泡が生じて微小構造が転写されなかった

ゲル溶液

空気

ゲル スフェロイド

上部流路

下部流路

中央流路
ゲル
形成
領域

培地 A

培地 B

スプラウト

(a) (b) (c)

(d) (e) (f)

図 2.3  培養デバイスの作製プロセス．(a) 流路の構造概要，(b) ゲル溶液の送液，(c) ゲル溶液
の吸引による回収と空気による洗浄，(d) 局所的なゲル形成領域へのゲルの形成，(e) スフェロ
イドの捕捉，(f) 二方向からの生化学物質の導入．(Attribution 4.0 International (CC BY 4.0))
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り，PDMS がモルド周囲で未硬化のまま残存したりすることが防がれる．また，直径
100 mm のディッシュに約 25 g の PDMS を加えることで，本デバイス完成後の使用に
適した微小流路の高さを実現可能である．真空デシケータからディッシュを取り出し，
ホットプレート（アズワン株式会社）上で 75℃に昇温させ，90 分間保持することによ
り，PDMS を硬化させた．その後，ディスポーザブルスカルペル（No.22，カイ イン
ダストリーズ株式会社）を用いてディッシュから PDMS 転写物を切り出し，微小流路
の送・排液口となる箇所に生検トレパン（先端口径 1.5 mm，BPP-15F，カイ インダス
トリーズ株式会社 ) で穴を開けた．最後に，PDMS 転写物と丸カバーグラス（直径 30 

mm，厚み No．1：0.13–0.17 mm，松浪硝子工業株式会社）をエッチング装置（コンパ
クトエッチャー FA-1，サムコ株式会社）を用いて酸素プラズマ処理し，処理表面同士
を圧着した後に，ホットプレート上で 75℃に昇温させ，90 分間保持することによりボ
ンディングした．
　作製されたモルドと PDMS 転写物が設計に対して大きな誤差無く作製されたことを
確認するために，表面形状測定レーザー顕微鏡（株式会社キーエンス）で表面形状を
測定した（図 2.5a,b）．設計と PDMS 転写物との寸法を比較したところ，領域（i）の高さ：
496±7.5 µm，領域（i）の幅：457±8.6 µm，領域（ii）の高さ：393±4.9 µm，領域（ii）の幅：
459±8.2 µm，領域（iii）の高さ：379±2.1 µm，領域（iii）の幅：107±6.9 µm だった（図 2.5c，
n ＝ 3，mean±s.e.）．これらの結果から，本研究の作製手法を用いることで，設計時に
意図した機能的構造を損なわない範囲の誤差で微小流路を作製可能であることが示唆
された．

上部流路

下部流路

中央流路

1 mm

図 2.4 本デバイスの作製．(a) 三次元造形により作製したモルド，(b) 完成したデバイス．
(Attribution 4.0 International (CC BY 4.0))
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2.2.4　培地チャンバの設計および作製と微小流路との接着
　培地チャンバは，デバイス内に培地を保持できると同時に，側部のポートを介して
外部ポンプと接続できるよう設計した（図 2.6a）．ポートは内径が 0.8 mm，外径が 1.5 
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図 2.5 表面形状レーザー顕微鏡による解析．(a) モルドの計測図，（b）PDMS 転写物の計測図，
（c）設計・モルド・PDMS 転写物の各寸法の比較．n ＝ 3，mean ± s.e．
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mm の管構造を基本としており，培地チャンバの外側と内側を繋いでいる．ポートの
両先端には，円錐台様に外径が最大 2.0 mm となるまで太くなった構造があるため，シ
リコーンチューブ等の柔軟なチューブが嵌まり込んで外れにくくなっている．そのた
め，チューブをポートの両端に接続でき，それを介して外部ポンプからデバイス内部
への送液が可能である．また，培地チャンバの底面には高さわずか 0.1 mm の円形の段
差があり，その中央を中心とした直径 25 mm の円形の穴が窓のように開いた構造を有
する（図 2.6b）．この段差部分には微小流路の丸カバーグラスが丁度嵌り込む構造になっ
ているため，微小流路と培地チャンバを接合した際に，微小流路のガラスと PDMS の
透明さに起因する観察の利便性は損なわれない．Inventor 2018 を用いて設計したデー
タを stl ファイルとして出力し，三次元造形プリンタ（AGILISTA-3100，株式会社キー
エンス）を用いて培地チャンバを作製した．モデル材にはアクリル樹脂（AR-M2，株
式会社キーエンス）を，サポート材には水溶性樹脂（AR-S1，株式会社キーエンス）
を用いた．いずれの樹脂も，アクリル系モノマー，ウレタンアクリレート系オリゴマー，
光重合開始剤から構成されており，未重合の樹脂が残存することで，細胞の培養に悪
影響を与える可能性がある．そこで，造形した培地チャンバに付着したサポート材を

(a)

1.5 mm

2.0 mm

33 mm

0.8 mm

0.1 mm

(b)

25 mm

図 2.6  培地チャンバの構造設計．(a) ポートの設計，(b) 段差の設計．
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除去するため，超音波洗浄機を用いて水道水で約 30 分間の超音波洗浄を行った．水道
水を用いた一度の洗浄のみでは，ポート内のサポート剤を除去しきれないため，スプ
レーボトルの噴射口をポートの開口部に押し当て，70% エタノールをポート内に吹き
込んでポートの内部を洗浄した．さらに，再び超音波洗浄機を用いて，70% エタノー
ル中で約 30 分間の超音波洗浄を行った．最後に，水道水で複数回よく洗浄することで，
可能な限りサポート材を除去した．洗浄後の培地チャンバは濡れているため，エアブ
ローガンで水滴を除去し，3 時間以上乾燥させた．さらに，50℃のオーブンで 30 分以
上乾燥させ，パリレン蒸着装置を用いて表面全域に約 4 µm の膜厚でパリレン C を被
覆した．パリレン C は，生体適合性および生体安定性に優れており，医療機器の表面
改質にも用いられている．そのため，本論文ではパリレン C の被覆を行うことにより，
培地チャンバの樹脂由来の物質が細胞培養時に悪影響を及ぼす可能性を低減すること
を狙った．最後に，微小流路を先述した培地チャンバの段差構造にはめ込み，エポキ
シ系接着剤（アラルダイト RT30，ハンツマン・ジャパン株式会社）を用いて接着した．
本研究で用いたエポキシ系接着剤は 24 時間かけて硬化が進行するため，接着作業後は
一晩以上かけて自然乾燥させた．
　以上の工程により，本デバイスが完成した（図 2.7a）．図 2.7b は完成したデバイス
の微小流路に赤と青のインク（株式会社パイロットコーポレーション）を導入し，倒
立顕微鏡（IX71，オリンパス株式会社）を用いて撮影した写真である．ゲル形成領域
に光硬化性樹脂（Norland Optical Adhesive 63，Norland Products Inc.）を流し込んで紫外
光により硬化させることで，2 色のインクが混ざらないよう上部流路，中央流路，お
よび下部流路をそれぞれ隔てた．

2.3　局所的なゲル形成機能の確認

　微小流路の設計の通りにゲル形成領域にゲルが局所的に形成されることを確認する
ため，蛍光ナノビーズを懸濁させたゲル溶液の微小流路への導入を行った．本操作は，
操作中のゲル溶液のゲル化を防ぐため，溶液調製を氷上で，デバイス操作をクールプ
レート（LP-C，トスク株式会社）上で設定温度を 0℃にして行った．また，デバイス
の操作時は，微小流路の内部でのゲル溶液の挙動を確認するために，実体顕微鏡（SZX7，
オリンパス株式会社）にアダプター（NY-1SW1，マイクロネット株式会社）を介して
取り付けたカメラ（EOS 80D，キャノン株式会社）のモニターを通じて観察を行いな
がら操作を行った．まず本デバイスの微小流路および培地チャンバ内を，70% エタノー
ルを用いて滅菌した．さらに，70% エタノールをエアブローガンで除去した後に，紫
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外光およびオゾンガスによる滅菌機（CoolCLAVE Plus Ozone and UV Personal Sterilizer，
Genlantis Inc.）を用いて滅菌処理を施した．この滅菌処理を行うことで，カビや微生
物によるコンタミネーションのリスクが減少する．ゲル形成には，フィブリンとコラー
ゲンの混合ゲルを使用した．詳述すると，まず 7.2 mg/mL フィブリノーゲン溶液（ウ
シ血漿由来，Sigma-Aldrich Co.，LLC），0.29 mg/mL 中性化 I 型コラーゲン溶液（DME-

02，低グルコース DMEM 溶解型，株式会社高研），0.26 U/mL アプロチニン溶液（ウシ
肺由来，Sigma-Aldrich Co.，LLC），0.45 U/mL トロンビン溶液（ウシ血漿由来，Sigma-

Aldrich Co.，LLC），および 36 µM 塩化カルシウム溶液（関東化学株式会社）をリン
酸緩衝液（PBS(-)，細胞科学研究所）により溶解させた混合溶液を調製した．フィブ
リノーゲン溶液は，10 mg/mL または 30 mg/mL の濃度となるようにフィブリノーゲン
の粉末を PBS(-) に加え，3 時間かけて 37℃の恒温水槽に浸漬させることで，溶解さ
せた．それぞれの溶液は，調製時にフィルタ（膜孔径 0.22 µm，SLGV033RS，Merck 

Millipore Ltd.）を用いて滅菌処理を行い，-80℃（フィブリノーゲン溶液）または -30℃
（フィブリノーゲン以外の溶液）の冷凍庫にストック化して保存しておいたものを使
用した．フィブリノーゲン溶液については，15 分間以上，37℃の恒温水槽に浸漬させ
ることで融解した後に使用した．次に，調製した溶液をマイクロピペット（Eppendorf 

Research® plus，200 µL，Eppendorf AG）を用いて上部流路および下部流路に混合溶
液を約 10 µL ずつ導入し，ゲル形成領域が混合溶液で満たされ，中央流路に少しだけ
漏れ出して凸型メニスカス様の形状になるように，デバイスを軽く振動させた（図
2.8a,b）．ゲル形成領域は，流路の高さが上部，下部，および中央流路の高さと比較し

500 μm

(b)

光硬化性
樹脂

(a)

Φ37 mm

下部流路

上部流路

中央流路

図 2.7 作製された培養デバイスと微小流路の構造．(a) 作製された培養デバイス，(b) インク
を導入した微小流路．
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て低く，また平面図的に上部流路および下部流路から中窪になった構造を有するため，
混合溶液が上部流路および下部流路から中央流路に漏出しにくくなっている．ただし，
振動を与えるごとにゲル形成領域から中央流路側に混合溶液が漏出していくため，振
動を与えすぎると，混合溶液が中央流路に完全に漏出してしまう．ゲル形成領域に混
合溶液が充満した後に，上部流路および下部流路から混合溶液をマイクロピペットを
用いて吸い出した（図 2.8c,d）．その結果，混合溶液の回収に伴って空気が逆側の送液
口から入り込み，上部流路および下部流路内の混合溶液が洗い流された．この際にも，
先述した構造のため，ゲル形成領域内の混合溶液は保持され易くなっており，実際に
上部流路および下部流路へと回収されることなく，ゲル形成領域に残存した．導入時
に混合溶液が中央流路側にやや漏出したとしても，二か所のゲル形成領域から中央流
路に漏れ出した混合溶液同士が接触しない程度の漏出であれば，本手順で混合溶液を
吸い出すことで，ゲル形成領域のみに混合溶液を残存させることが可能であった（図

空気

空気

ゲル形成領域
に隔離された
ゲル溶液

ゲル溶液

上部流路
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中央流路
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図 2.8 微小流路へのゲル溶液の導入．(a) ゲル溶液導入前の微小流路，(b) 上部流路および下
部流路へのゲル溶液の導入，(c) 下部流路のゲル溶液の吸引除去，(d) 上部流路のゲル溶液の吸
引除去，(e) ゲル形成領域に隔離されたゲル溶液．(Attribution 4.0 International (CC BY 4.0))
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2.8e）．なお，本実験では混合溶液をゆっくりと導入できるようするために，マイクロ
ピペットの使用時に通常の使用法のようにプッシュボタンを押して溶液を出すのでは
なく，容量調節リングを容量を小さくする向きに回すことで溶液を出すという工夫を
行い，混合ゲルが中央流路に漏出してしまうという失敗を防いだ．混合溶液をゲル形
成領域に隔離した後，培地チャンバに約 500 µL の PBS(-) を入れ，35mm ディッシュ
の上蓋を被せて，37℃のインキュベータ内で 1 時間以上静置することで，ゲル化させ
た．PBS(-) を培地チャンバ内に加えたのは，ゲルが乾燥により収縮してしまうことを
防ぐためである．結果として，デバイス中の二箇所のゲル形成領域に，ゲルが形成さ
れた（図 2.9）．なお，図 2.8 および図 2.9 では，混合溶液およびゲルの可視化のため
に，混合溶液中に 0.04%(w/v) の蛍光ナノビーズ（FluoSpheresTM，carboxylate-modified 

microspheres，0.2 µm，yellow-green fluorescent (505/515) または red fluorescent (580/605)，
2% solids，Life Technologies Corp.）を加え，実験を行った．これらの結果から，本デ
バイスを用いることで，設計した二箇所のゲル形成領域に，局所的にゲルを形成可能
であることが示された．

2.4　シリンジポンプを用いたゲル形成の検討

　前節ではマイクロピペットを用いた手動でのゲル溶液の導入によって局所的なゲル
形成を達成したが，ゲル溶液の導入のスピードの調節やゲル形成領域へのゲル溶液の
充填といった作業を手によって行っているため，形成されるゲルの形状は実験者の技
術に依存する部分が大きいと考えられる．そこで，より高い再現性でゲル形成を行う

(a) (b)

500 μm500 μm

図 2.9 蛍光ナノビーズを含んだゲルが形成された微小流路．(a) 明視野像，(b) 蛍光視野像．
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ことが可能な手法として，シリンジポンプを使った手法を試行した．デモンストレー
ション用として作製した，上部流路，中央流路とそれらの間に一つのゲル形成領域の
みが存在する設計の微小流路を有するデバイスを用いて，シリンジポンプでインク
（4001，Dark Green Ink，Pelikan Vertriebsgesellschaft mbH & Co. KG）を流すことで，ゲ
ル形成領域のみにインクを残存させることが可能かを検証した．シリンジ（5 mL，SS-

5ESZ，テルモ株式会社），メスルアーフィッティング（VRF106，株式会社アイシス），
およびシリコーンチューブ（外径 2 mm，内径 1 mm，アズワン株式会社）と連結さ
れたフッ素樹脂（ethylene tetrafluoroethylene：ETFE）チューブ（外径 1/16"，内径 1.00 

mm，VICI AG.）を二組用意し，それぞれデバイスの上部流路の 2 箇所の送液口に差し
込んだ．片側の送液口には，インクで満たしたシリンジをシリンジポンプ（KDS200，
KD Scientific Inc.）に装着して送液を行った．一方で，もう片側の送液口（排液口）か

図 2.10 インクを用いた片側のみにゲル形成領域を有するデバイスにおけるデモンストレー
ション．(a) インク導入前の微小流路，(b) 上部流路へのインクの導入，(c) 上部流路のインク
の吸引除去，(d) ゲル形成領域に隔離されたインク．

500 μm 500 μm

500 μm 500 μm

(a) (b)

(c) (d)
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らは，空のシリンジを装着したシリンジポンプを用いて溶液を吸引した．それぞれ
のシリンジポンプの流量を様々な条件で試したところ，50 µL/ 分の流量で送液し，44 

µL/ 分の流量で吸引するという条件で実験を行い，ゲル形成領域がインクで満たされ
たことをカメラで確認した後に，直ぐに送液口に差し込まれた ETFE チューブを引き
抜き，排液口からの吸引のみを続行することによって，中央流路への漏出なく，ゲル
形成領域のみにインクを残存させることが可能だった（図 2.10）．この際に，ゲル形成
領域の全域にインクが充足しない内に ETFE チューブを引き抜いて送液を中断してし
まうと，ゲル形成領域へのインクの残り方が少なくなってしまい，逆に，ETFE チュー
ブの引き抜きのタイミングが遅れると，中央流路にインクが漏出してしまった．また，
20 µL/ 分というより低流量で送液すれば，厳密なタイミングの制約を回避できるので
はないかと考えて試したところ，ゲル形成領域の全域にインクが充満するまでに数分
間の送液が必要となってしまい，実用性に欠ける手法となった．結果として，本手法
を用いるとむしろ中央流路への漏出をはじめとする失敗が起きやすく，ゲル形成の失
敗が増大することが分かった．さらに，溶液の損失量が大きいことや，マイクロピペッ
トを用いる手法と比較して溶液の導入に時間がかかること等から，溶液の導入手法と
して不向きであることが分かった．従って，本研究では以降，2.3 節に記載したマイク
ロピペットを用いた手法をゲル形成の手法として採用した．以降の実験では，特別な
記述が無い限りは，2.3 節の手法を用いたものとする．

2.5　スフェロイド捕捉前における中央流路の流れ

　ゲル形成後の中央流路におけるスフェロイド捕捉の際の流れの速さと流線の形状を，
シミュレーションにより計算した．シミュレーションには，COMSOL Multiphysics®

（COMSOL Inc.）を用いた．実際のデバイスの寸法を用いて，捕捉部の円を中央の x 座
標を x = 0 µm，中央流路の下部流路側の壁面の y 座標を y = 0 µm，中央流路の底面の z

座標を z = 0 µm と定めて三次元モデルを作製した．ただし，ゲル形成領域のゲルを壁
とみなせると仮定した．静水圧による中央流路への培地の流れを計算するために，中
央流路の送液口および排液口における流体の流入・流出条件を圧力により設定した．
送液口と排液口における流体の圧力差が静水圧の差のみによって決定すると仮定した．
この時，微小流路の送液口と排液口にかかる静水圧は次式 2.1 により表される．

        ・・・式 2.1
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ただし，Δ P：圧力差 [Pa]，ρ：流体の密度，g：重力加速度，h：流体の液面の高さ

まず，排液口における流体の液面高さは，培地チャンバ内の培地の液面高さであるた
め，培地チャンバの底面積 8.6 cm2 および培地チャンバ内に加えた培地量 4 mL（1 mL 

= 1 cm3）より，47 mm である．また，送液口における流体の液面高さは，挿入された
チップに加えられた培地の量によって変動する．チップに 50–300 µL のインクを加え，
液面高さを測定したところ，50 µL の時に 20 mm，100 µL の時に 25 mm，200 µL の時
に 35 mm，300 µL の時に 40 mm であった ( 図 2.11)．これらの結果を式 2.1 に代入する
と，排液口における静水圧Δ P は 45 Pa，送液口における静水圧Δ P は，50 µL の時に
200 Pa，100 µL の時に 240 Pa，200 µL の時に 340 Pa，300 µL の時に 390 Pa となった．
以上の結果をCOMSOL Multiphysics®の初期条件に代入し，計算を行った．結果として，
中央流路の送液口からの流れが，捕捉部の狭窄した流路に集束する流れが形成される
ことが分かった（図 2.12a）．平面（z = 200 µm）における流れの速さを可視化したところ，
狭窄部を通る際に流れの速さが増加し，狭窄部通過後は狭窄部通過前よりも速い流れ
が形成されることが分かった（図 2.12b）．続いて，中央流路に平行で中央を通る線分
（y = 250 µm, z = 200 µm）を関心領域（Region of Interest，ROI）に定め，線分上におけ
る流速をプロットしたところ，図 2.12c のグラフが得られた．得られたグラフの数値
から，各条件における中央流路の捕捉部より送液口側の領域における平均流速を計算
したところ，50 µL の時に 64 mm/s，100 µL の時に 79 mm/s，200 µL の時に 110 mm/s，
300 µL の時に 120 mm/s であった（図 2.12d）．
　これらのシミュレーションによる結果との整合性を検証するために，実際のデバイ
スを用い，マイクロビーズ（平均直径 10.28 µm，PS-R-10.3，microParticles GmbH）を

図 2.11 インクを用いたチップの液面高さの測定．（a）50 µL の時，（b）100 µL の時，（c）200 

µL の時，（d）300 µL の時．

(a) (b)

(c) (d)
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図 2.12  COMSOL Multiphysics® を用いた微小流路内の流れのシミュレーション．（a）流れの
ベクトル表示，（b）z = 200 µm の x-y 断面における速度分布，（c）y = 250 µm，z = 200 µm の
線分における速度のプロット，（d）チップに導入した培地の液面高さと微小流路内の流速を表
したグラフ．

(a)

(b)

(d)

(c)
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懸濁した培地を中央流路に流し，ハイスピードカメラ（HAS-U2，株式会社ディテクト）
による観察を行った．マイクロビーズの懸濁培地を導入するために，まず中央流路内
を培地で満たした後，捕捉部が存在する側の送液口に，先端を切ったピペットチップ
（200 µL，深江化成株式会社＆ワトソン株式会社）を差し込んだ．差し込んだピペット
チップに，50 µL，100 µL，200 µL，および 300 µL のマイクロビーズ懸濁培地を加え
ることで，静水圧により中央流路内に流れを生じさせた．撮影した動画を Tif ファイ
ルとして保存し，Fiji ソフトウェア（ImageJ ソフトウェアをベースに開発されたオー
プンソースの画像処理パッケージ，http://fiji.sc.）を用いて解析し，マイクロビーズの
速さと挙動を得た．詳細な解析方法を下記に記す．まず，Fiji ソフトウェアで，File > 

Import > Image Sequence により，動画の Tif ファイルを開く．次に，Analyze > Set Scale

により，流路幅の実測値（470 µm）を用いて，スケールを設定する．続いて，Plugin > 

Tracking > Manual Tracking を選択し，Manual Tracking のプラグインを起動させる．設
定したスケール情報をもとに，x/y calibration に数値を入力する．また，動画の情報を
もとに，Interval に数値を入力する．Add Track を押して手作業でマイクロビーズを追
跡し，追跡が完了したら End Track を押す．10 個以上のマイクロビーズの追跡が完了
したら，結果を csv ファイルに保存し，各マイクロビーズの速さ（Velocity）の平均値
を Excel 上で算出し，さらにその平均値の平均値および標準誤差を算出した．この作
業を 4 つの試料で行った．マイクロビーズの追跡によって得られた挙動から，中央流
路における捕捉部の流路幅が狭まった領域に向かって収束するような流線が形成され
ていることが分かった（図 2.13a）．また，得られた結果により作成された，マイクロ
ピペットに導入された培地量と流れの速さの関係性を示したグラフが，図2.13bである．
結果として，ピペットチップに導入されたマイクロビーズ懸濁培地の体積量の増加に
伴って，マイクロビーズの流速が線形的に増大することが分かった．これらの結果は，
ピペットチップを介して中央流路に導入されたスフェロイドが，流路中央に収束する
培地の流れによって捕捉部の中心に運ばれ，スフェロイドと二つのゲルとの偏りの無
い接触を実現し，最終的にスフェロイドの両方のゲルへの接着を補助する機能が本デ
バイスの捕捉手法にあることを示唆している．さらには，中央流路に流したマイクロ
ビーズが上部流路や下部流路に漏出しなかったという基本的な結果から，本デバイス
により二つのゲル形成領域に形成されたゲルは，上部流路と中央流路，および下部流
路と中央流路をそれぞれ隔て，少なくとも直径 10 µm 程度のサイズの粒子では通るこ
とができないことが示された．以上の結果は，COMSOL Multiphysics® を用いたシミュ
レーションによって示された流速と概ね一致すると考えられる .
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図 2.13 スフェロイド捕捉前における中央流路の流れ解析．(a) マイクロビーズの Particle 

Tracking，(b) ピペットチップに導入した培地体積とビーズの速度の関係を示したグラフ．n = 

10，mean±s.e. (Attribution 4.0 International (CC BY 4.0))
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2.6　細胞培養およびスフェロイドの形成

　続いて，スフェロイドを形成した．本研究では，ヒト臍帯静脈内皮細胞（Human 

Umbilical Vein Endothelial Cells：HUVEC，PromoCell GmbH）と，ヒト肺線維芽細胞（Human 

Pulmonary Fibroblasts：HPF，PromoCell GmbH）またはヒト皮膚線維芽細胞（Normal 

Human Dermal Fibroblasts：NHDF）からなる共培養スフェロイドを主に用いた．また一
部の実験では，HUVEC と HPF にヒト乳腺癌由来細胞（Michigan Cancer Foundation-7：
MCF-7）を加えて形成した三培養スフェロイドを用いた．HUVEC は，各種の増殖因
子や化学物質に応答して周囲の ECM を分解して遊走することから，多くの研究にお
いて血管モデルの形成や血管新生アッセイに用いられており，本研究でも，血管新生
および血管内皮細胞の遊走性を評価するための細胞として用いた．また HPF および
NHDF は，コラーゲン等の ECM の成分を産生したり，VEGF や FGF 等の血管内皮細
胞の遊走に関わる種々の増殖因子を分泌したりし，管腔形成にも寄与することが知ら
れている．以下では，それぞれの細胞の培養条件について記す．HUVEC の培養には，
血管内皮細胞専用培地（Endothelial Cell Growth Medium-2 BulletKit™，EGM-2，Lonza 

Group AG）を用いた．EGM-2 は，基礎培地（Endothelial Cell Basal Medium，EBM）に，
2%（v/v）ウシ胎児血清（fetal bovine serum：FBS），0.04%（v/v）ヒドロコルチゾン，0.4%

（v/v）ヒト線維芽細胞増殖因子 -2（human fibroblast growth factor-2，FGF-2），0.1%（v/

v）血管内皮増殖因子（vascular endothelial growth factor，VEGF），0.1%（v/v）R3- イン
スリン様増殖因子 -1(R3-insulin-like growth factor-1，IGF-1)，0.1%（v/v）ヒト上皮増殖
因子（human epidermal growth factor，EGF），0.1%（v/v）ゲンタマイシン / アンホテリ
シン -B，0.1%（v/v）ヘパリンが含まれている．本研究ではさらに，微生物によるコ
ンタミネーションの防止のため，1%（v/v）ペニシリン / ストレプトマイシンを加えて
用いた．本研究では，通常の HUVEC の他に，緑色蛍光タンパク質発現型 HUVEC（green 

fluorescent protein-expressing HUVEC：GFP-HUVEC，Angio-Proteomie）および赤色蛍
光タンパク質発現型 HUVEC（red fluorescent protein-expressing HUVEC：RFP-HUVEC，
Angio-Proteomie）を用いた．蛍光タンパク質発現型の HUVEC を用いることで，特別
な固定や染色を行うことなく，HUVEC の遊走を観察することが可能である．HPF，
NHDF および MCF-7 の培養には，ダルベッコ変法イーグル培地（4.5g/L グルコースお
よび L- グルタミン含有，Dulbecco's Modified Eagle's Medium，DMEM，ナカライテス
ク株式会社）に 10%（v/v）FBS（Thermo Fisher Scientific Inc.），1%（v/v）P/S，および
250 µM L- アスコルビン酸りん酸エステルマグネシウム塩 n 水和物（和光純薬工業株
式会社）を加えた培地を用いた．いずれの細胞も，100 mm ディッシュに 3–5×105 の細
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胞密度で細胞を播種し，MCF-7 以外は約 2 日ごとに，MCF-7 は約 4 日ごとに継代を行っ
た．スフェロイドの形成は，96 ウェルプレート（MS-9096U または MS-9096V，住友ベー
クライト株式会社）を用いて，１つのウェルあたり 200 µL の EGM-2 培地中に次の条
件に示す比率（細胞数）で各種の細胞を懸濁させ，共培養または三培養することで形
成した．本研究で用いた条件は多岐に渡り，各実験ごとに異なるが，主に用いた条件は，
条件 1．HUVEC：HPF ＝ 1：4（5,000：20,000），条件 2．HUVEC：NHDF ＝ 1：4（3,000：
12,000），条件 3．HUVEC：HPF：MCF-7 ＝ 1：3：1（5,000：15,000：5,000），条件 4．
HUVEC：HPF ＝ 1：4（200：800）等がある．図 2.12 は形成されたスフェロイドであ
る．それぞれ，GFP-HUVEC：HPF ＝ 5,000：15,000（図 2.14a），RFP-HUVEC：NHDF

＝ 5,000：15,000（図 2.14b）の条件で形成されたスフェロイドである．既存の報告か
ら，HUVEC と NHDF や HPF との共培養スフェロイドでは，二種類の細胞が一様に分

図 2.14 蛍光発現型 HUVEC を用いて形成したスフェロイド．(a) RFP-HUVEC と HPF の共培
養スフェロイド，(b) GFP-HUVEC と HPF の共培養スフェロイド．

100 μm

100 μm

100 μm

100 μm

(a)

(b)
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布した構造を有することが知られている [19]．これは，接着性が同等程度の細胞同士
の自己組織化によって生じることが，差次接着性仮説 (Differential Adhesion Hypothesis)

により説明されている [94,95]．本研究により形成されたスフェロイドは，蛍光観察か
ら HUVEC がスフェロイドの全域に渡って存在することから，一様な分布であると考
えられる．
　本研究では，PDMS マイクロウェルアレイを用いたスフェロイドの形成手法につい
ても検討を行った．本手法は，PDMS マイクロウェルアレイ，即ちマイクロメートル
サイズの規格化されたウェルが整列したシートに細胞を播種することで，細胞の播種
密度に依存せず均一な形状のスフェロイドを多数形成することが可能な手法である．
PDMS マイクロウェルアレイを，マイクロメートル単位の流路の作製が可能な技術で
あるソフトリソグラフィ技術を用いて作製した．まず，2D CAD ソフト L-Edit を用い
て，直径 200 µm の円が 200 µm の間隔で並んだパターンを設計した．設計したパター
ンの紫外光を，表面にクロム膜とネガティブ型フォトレジストが塗布されたガラス基
板にマスクレス露光装置（Nano System Solutions (RAYTEX)）を用いて照射した．その
基板に，水酸化テトラメチルアンモニウム液による現像，HY 液によるエッチングの
処理を行うことでフォトマスクを作製した．続いて，シリコンウエハ上にスピンコー
タ（MS-A100，Opticoat，ミカサ株式会社）を用いて，ネガティブフォトレジスト（SU-

8 100，日本化薬株式会社）を高さ約 200 µm になるようコートし，ホットプレート上
で 95℃に昇温し保持することでプリベイクした後，30 分以上かけて常温に冷却した．
作製したフォトマスクを介して露光装置（マスクアライナー，ユニオン光学株式会社）
により，SU-8がコートされたシリコンウエハに紫外光を露光した．露光後，SU-8がコー
トされたシリコンウエハを 95℃の温度条件でポストベイクし，30 分以上かけて常温に
冷却した後，現像液（SU-8 developer，MicroChem Corp.）を用いて未硬化の SU-8 を溶
解除去することで，SU-8 のパターンを現像し，2- プロパノール（和光純薬工業株式会
社）を用いてリンスした．次に，現像した SU-8のモルドを 100 mm ディッシュに静置し，
そこに 2.2.2 項と同様の方法で，PDMS を流し込み，真空状態下に 20 分間以上置いた
後に，ホットプレート上で 75℃に昇温させ 90 分間保持することにより，PDMS を硬
化させた．硬化した PDMS をシリコンウエハから剥がし取ることで，SU-8 モルドの
マイクロウェルアレイのパターンが転写された，PDMS マイクロウェルアレイを得た．
PDMS マイクロウェルアレイを 60 mm ディッシュ（Corning，Inc.）に静置し，上述し
た HUVEC：HPF ＝ 1：4 の条件で細胞を懸濁した EGM-2 培地を加えた．15 分間イン
キュベータ内で培養し，細胞をマイクロウェル内に沈降させた後，角カバーグラス（30 
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mm × 40 mm，厚み No．3：0.25–0.35 mm，松浪硝子工業株式会社）でマイクロウェル
の外に沈降した細胞を掻き取って除去した（図 2.15）．その後，2 日間インキュベータ
内で培養することによって，スフェロイドを形成した．本論文の実験では，特に断り
が無い場合，96 ウェルプレートを用いた手法で形成したスフェロイドを用いた．一部
の実験では，PDMS マイクロウェルアレイを用いて形成したスフェロイドを用いた．

2.7　 スフェロイドのサイズ計測

本研究では，形成したスフェロイドのサイズを計測するために，Fiji ソフトウェ
アのマクロ機能を利用して，Python で自動解析のためのマクロを組んだ（付録，図
S1）．処理内容を簡潔に説明する．まず，処理したいスフェロイドの画像フォルダを
選んで，フォルダ内の全ての画像を順に読み込む．開いた画像に対して，Analyze > 

Set Measurements で area（面積），perimeter（周長），shape fit feret's（フェレー径）の計
測を選択し，Analyze > Set Scale で，画像に合ったピクセル /µm 比を設定する．Image 

> Type > 8-bit で画像を 8 ビット化し，Process > Subtract Background で，“rolling ball”
（転がるボール）アルゴリズムにより，直径 1000 µm の円を仮定して背景の減算を行
う．Image > Adjust > Auto Threshold によって画像を自動的な閾値で二値化し，Process 

100 μm

200 μm

図 2.15  マイクロウェルアレイを用いたスフェロイド形成．
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> Binary > Fill Holes でスフェロイドの領域を塗りつぶす．さらに，Process > Filters > 

Median により，スフェロイド領域の境界部分の粗さを取って凹凸を減らす．最後に，
Analyze > Analyze Particles により，面積が 10000 µm2 以上の領域（即ち，スフェロイド
の領域）を検出し，面積，周長，フェレ―径を記録する（図 2.16）．本研究では，この
解析により得られた面積および周長から，下記の式 2.2 により近似的なスフェロイド
の直径を算出した．　　
　　　　　　　　　　　　　　　　
          ・・・式 2.2

これにより算出された近似直径を用いて，以下の式 2.3 から近似面積を算出し，面積
の実測値と比較したところ，近似面積の値は実測値の 85–90% の範囲に収まった．

          ・・・式 2.3

なお，Median によるスフェロイド領域の境界部分のスムース化処理を行わなかった場
合，境界部分の詳細な凹凸が残ってしまうために周長が長くなってしまう．そのため，
算出された近似面積の値は面積の実測値の 60–70% となる．この結果から，Median に
よる処理を加えたことで，近似直径の値がより正確な直径に近い値となることが分かっ
た．

図 2.16 スフェロイドの自動解析によるデータ取得の概念図．(a) マクロに入力されたスフェ
ロイドの画像，(b) マクロで処理された画像．

(a) (b)
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2.8　スフェロイドの捕捉

　続いて，形成したスフェロイドをデバイスの捕捉部に捕捉した．まず，ゲルが形成
されたデバイスの上部流路，中央流路，および下部流路の各流路に培地を導入した．
この際に，ゲルがゲル形成部の中央に凹んで形成されていた場合，その凹んだ部分に
気泡が残りやすい．そこで，マイクロピペットを用いて，培地を吸って出すことを繰
り返すことで，気泡を除去した．また，送液口に気泡が残る場合も多いが，それらは
ピペットチップを用いて吸い取ることで除去可能である．流路内に気泡が残っている
と，培地が流路と培地チャンバの間を自由に流れることが出来ず，スフェロイドの捕
捉時に流れが生じないという問題や，培養時に培地供給が不足するといった問題が起
き得る．そのため，気泡を除去しておくことは重要である．続いて，先端を切ったピペッ
トチップを用いて，96 ウェルプレートから一つのスフェロイドを 150 µL の培地ごと
吸い取り，そのピペットチップを，2.5. 節で記述したように中央流路の送液口に差し
込んだ．ピペットチップを差し込んだまま，マイクロピペットから外すことで，ピペッ
トチップ内の培地と中央流路の逆側の送液口の培地との静水圧差により，中央流路に
培地の流れが生じ，それによってスフェロイドが捕捉部まで運ばれる．スフェロイド
の大きさが流路の幅（500 µm）および高さ（500 µm）を大きく超える場合は，送液口
から先の流路内へとスフェロイドが運ばれないことがある．その際には，逆側の送液
口にピペットチップを差し込んで，マイクロピペットで培地を吸引することで，スフェ
ロイドの捕捉部までの運搬を補助することが可能である．さらに，差し込んだピペッ
トチップに追加で培地を加えることで，スフェロイドが捕捉部から外れて逆流してし
まうことを防ぐことが可能である．このようにしてスフェロイドの捕捉部への捕捉に
成功した（図 2.17）．捕捉されたスフェロイドとゲルとの接触を可視化するために，蛍
光ナノビーズを混合したゲルを形成し，そこに GFP-HUVEC と HPF からなるスフェロ

(i)

捕捉部

(ii) (iii)

100 μm 100 μm 100 μm

図 2.17 スフェロイド捕捉時の連続写真．(Attribution 4.0 International (CC BY 4.0))
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イド（直径約 700 µm）を捕捉した．共焦点顕微鏡（LSM780，Carl Zeiss AG）を用い
た Z-stack 撮像により，ゲルとスフェロイドの立体的な位置関係を撮像した（図 2.18）．
y-z 断面の観察から，ゲルがゲル形成領域を満たすように形成されるだけではなく，中
央流路の底面にも薄く覆うように形成されたことが分かった．ゲルの断面像から，凹
型メニスカス様の形状を取ることが分かった．この原因は明らかに出来ていないが，
デバイスの使用前にオゾン -UV 滅菌処理を行ったことで，ガラスからなる微小流路底
面の親水性とそれに付随する濡れ性が向上し，その状態がある程度保持されたことが

100 μm

緑：GFP-HUVEC
　　（スフェロイド）
赤：蛍光マイクロビーズ
　　（ゲル）

100 μm

100 μm

図 2.18 共焦点顕微鏡による捕捉されたスフェロイドの断層像．
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原因の一つだと考えられる．また，スフェロイドとゲルが密着した位置関係で接して
いることが分かった．このスフェロイドとゲルの接触は，x-z 断面からも同様に観察さ
れた．これは，スフェロイドが静水圧によってゲルに押し付けられた際に，ゲルの形
状に噛み合うように柔軟に変形しているためだと考えられる．これらの結果から，本
デバイスによる捕捉の機構を用いることで，スフェロイドがゲルと接触した状態が実
現され，培養によるスフェロイドのゲルへの接着を補助可能なことが示唆された．こ
れ以降，本研究では，スフェロイドのデバイスへの捕捉を行った日を培養 0 日目と定
義する．

2.9　スフェロイド捕捉成功率の評価

　スフェロイドの捕捉後，温度 37℃，5%CO2 雰囲気のインキュベータ内（三洋電機株
式会社または PHC 株式会社）で一晩培養することで，スフェロイドをゲルに接着させ
た．この培養以降では，特別な記載が無い限り，フィルタ付きの細胞培養用パーソナ
ル容器（マイキャニスタ，ワケンビーテック株式会社）内にデバイスを入れることで，
コンタミネーションを防止しながら培養を行った．一晩の培養後（培養 1 日目）に観
察を行ったところ，捕捉されたスフェロイドのゲルへの接着には 3 通りの形式が見ら
れた．それぞれ，1．両側成功（スフェロイドが両側のゲルに接着した状態），2．片側
失敗（スフェロイドが片側のゲルにのみ接着し，もう片側のゲルには接着しなかった
状態），および 3．両側失敗（スフェロイドがどちらのゲルにも接着しなかった状態）
の 3 通りである．このうち，両側成功のみをスフェロイドの捕捉成功と定義し，以降
の培養で血管内皮細胞の遊走性評価に用いた．HUVEC：HPF ＝ 1：4（5,000：20,000）
の条件で形成した培養 2 日目のスフェロイドを，合計 86 個のデバイスに捕捉した．こ
れら全ての試料をそれぞれ観察し，2.7. 節の解析手法により算出されたスフェロイド
の近似直径を用いて，それぞれの試料において捕捉されたスフェロイドの近似直径と，
スフェロイドの接着の形式の分布をグラフに表した（図 2.19）．結果として，スフェ
ロイドの捕捉成功率は，73%（直径（φ）= 400–500 µ ｍ，片側失敗率 18%，両側失
敗率 9%，n = 11），71%（φ = 500–600 µ ｍ，片側失敗率 18%，両側失敗率 12%，n = 

17），76%（φ = 600–650 µ ｍ，片側失敗率 12%，両側失敗率 12%，n = 17），76%（φ
= 650–700 µ ｍ，片側失敗率 24%，両側失敗率 0%，n = 33），88%（φ = 700–800 µ ｍ，
片側失敗率 13%，両側失敗率 0%，n = 8）だった．両側失敗は，培養中におけるスフェ
ロイドとゲルとの接触が不十分である場合に起こると考えられる．これには，スフェ
ロイド捕捉時にゲルとスフェロイドとの間に気泡が詰まってしまい，スフェロイドが
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ゲルと接触していなかったという例や，ゲルがゲル形成領域を充分に満たしておらず，
中央流路に対して凹んで形成されていたために，スフェロイド捕捉中にゲルとの接触
が不十分であったという例があった．各直径の条件間で成功率に大きな差が無いのは，
スフェロイドの大きさが異なっていたとしても，スフェロイド捕捉時の培地の流れに
よってスフェロイドが捕捉部の中央に運ばれるため，スフェロイドが両側のゲルと均
等に接着しやすくなっているからだと考えられる．また，直径 650 µm 以上のスフェ
ロイドにおいて両側失敗率が 0% となったのは，流路（幅および高さが共に設計値 500 

µm）を構成するガラスと PDMS パターンがスフェロイドよりも硬いため，スフェロイ
ドが流路の形状に合うように柔軟に形状を変形され，それによりスフェロイドとゲル
との密着性が高くなったことによると考えられる．これらの結果から，本デバイスは，
様々なサイズのスフェロイドを 70% 以上の高効率で捕捉しかつ両側のゲルに接着させ
ることができると示された．
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図 2.19  スフェロイドの直径と捕捉成功率を示したグラフ．(Attribution 4.0 International (CC BY 

4.0))
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2.10　スフェロイド捕捉中における中央流路の流れ

　2.9 節に記述した高いスフェロイドの捕捉成功率に，スフェロイドを捕捉部に捕捉し
ている最中における中央流路での培地の流れが寄与している可能性を示すため，スフェ
ロイド捕捉中の培地の流れをマイクロビーズを用いて可視化し，ハイスピードカメラ
で観察した．まず，2.8 節に記載した方法と同様にして，スフェロイドを捕捉部に捕捉
した．その後，2.5 節に記した方法と同様に，中央流路の送液口に差し込んだピペット
チップに 50 µL，100 µL，200 µL，および 300 µL のマイクロビーズ懸濁培地を加えて，
中央流路内に流れを生じさせた．本節の実験で使用したデバイスは，2.5 節で用いたも
のと同じ 4 つのデバイスである．また，解析手法も同様である．そのため，2.5 節の結
果と比較することで，同じデバイス内におけるスフェロイド捕捉前後の中央流路の流
れについて比較することが可能である．マイクロビーズの追跡によって得られた挙動
から，中央流路を直線状に流れたマイクロビーズが，捕捉されているスフェロイドの
手前で流路の端側へと方向を変化させて流れ，またスフェロイドの周囲に沿うように
して再び捕捉部中央の狭窄した流路に向かって収束するような流線を形成することが
分かった（図 2.20a）．また，得られた結果により作成された，マイクロピペットに導
入された培地量と流れの速さの関係性を示したグラフが，図 2.20bである．結果として，
ピペットチップに導入されたマイクロビーズ懸濁培地の体積量の増加に伴って，マイ
クロビーズの流速が増大したが，その増大の仕方は線形的ではなく，培地の体積量が
増えるにつれてマイクロビーズの速さの増加は小さくなった．この結果から，スフェ
ロイドが捕捉された状態で中央流路に流れをかけると，培地の体積量の増大に応じた
静水圧の増加によってスフェロイドが捕捉部の狭窄した流路に押し込まれ，中央流路
を塞ぐことで，中央流路における培地の流れが遅くなることが示唆された．これらの
結果から，スフェロイド捕捉後の中央流路における培地の流れが，捕捉されたスフェ
ロイドを捕捉部の中央に保持し，その効果がピペットチップに導入された培地の静水
圧が保たれる限り持続することを示唆している．このスフェロイドの保持効果によっ
て，一晩の培養期間の間，スフェロイドがゲルに接触した状態が保たれ，スフェロイ
ドのゲルへの接着が補助されている可能性が考えられる．

2.11　流れに対するデバイスの捕捉部の耐久性評価

　スフェロイドの捕捉が失敗する場合として，スフェロイドに高すぎる圧力を印加し
たことでゲルが破損する場合，またはスフェロイドが捕捉部の狭窄した流路から押し
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図 2.20 スフェロイド捕捉時における中央流路の流れ解析．(a) マイクロビーズの Particle 

Tracking，(b) ピペットチップに導入した培地体積とビーズの速度の関係を示したグラフ．n = 

10，mean±s.e. (Attribution 4.0 International (CC BY 4.0))
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出される場合を可能性として想定することができる．本節ではそれらの可能性につい
て調べるために，具体的には，スフェロイド捕捉時における流れに対するゲルの耐
久性と，スフェロイドが捕捉部から流失する流れの条件を調べるために，デバイス
外部のポンプを用いて中央流路に送液を行った．シリンジ（50 mL，SS-50ESZ，テル
モ株式会社）およびシリコーンチューブと連結された ETFE チューブを，デバイスの
中央流路の捕捉部側の送液口に差し込んだ．赤色蛍光マイクロビーズ（直径 15 µm，
microParticles GmbH）を懸濁させた EGM-2 培地で満たしたシリンジをシリンジポンプ
に装着して送液を行った．倒立顕微鏡を用いた観察の結果，蛍光マイクロビーズがス
フェロイドの周縁部を通る軌跡で中央流路を流れた様子から，シリンジポンプを用い
た送液が可能であることが示された（図 2.21）．
　続いて，流れに対するゲルおよびスフェロイドの耐久性を調べるために，ポンプを
用いて一定流量で 5 分間，EGM-2 培地を流した．送液後 5 分間以上の間隔を設けてか
ら，流量を増大させて次の送液を行い，これをゲルの破損とスフェロイドの捕捉部か
らの脱離および流失が起きるまで繰り返した．結果として，スフェロイドが狭窄した
流路に押し込まれて変形する様子と，ゲルが押されて変形し上部流路側および下部流
路側にはみ出る様子が観察された．結果として，スフェロイドの流失よりも先に，ゲ
ルが培地の圧力によって変形し，破損する様子が観察された（図 2.22a,b）．図 2.22c

のグラフは，それぞれの流量条件下におけるスフェロイドの変形量を表している．解
析は倒立顕微鏡で撮影した動画を Tif ファイルとして保存し，Fiji ソフトウェアを用
いて下記の手順で行った．まず，動画の Tif ファイルをドラッグ & ドロップで読み込
み，Analyze > Set Scale によりスケール設定をする．Toolbar の Line Selection Tools から
Strait Line を選択し，送液前と送液開始 5 分後のスタック画像から，スフェロイドの狭
窄した流路側の末端の変形による変化位置を線分で指定し，Analyze > Measure を実行

図 2.21 スフェロイドの捕捉時における蛍光マイクロビーズの流れ．
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して線分の長さのデータを得る．5 つの試料を用いて実験を行った結果として，いず
れの試料においても，500 µL/ 分の以上の流量に至るまでにゲルが破損してしまうとい
うことが分かった．ゲルによって中央流路から上部流路および下部流路へのアクセス
が防がれている状態下においては，中央流路に流れた培地は，捕捉部の狭窄した流路

図 2.22 スフェロイドの捕捉時におけるゲルの耐久性．(a) ゲルの変形，(b) ゲルの破損，(c) 培
地の送液流量とスフェロイドの変位量との関係を示すグラフ．n = 5．
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を通って流路外に流れるか，あるいは流路の壁面およびゲルを押すか，送液口に差仕
込まれた ETFE チューブを押すかの 3 通りの方法で圧力が分散され得ると考えられる．
主に考えられるのは，狭窄した流路を流れるという場合であるが，捕捉部の狭窄した
流路（幅：150 µm，高さ：400 µm）は中央流路の捕捉部までの領域（幅：500 µm，高さ：
500 µm）と比較して流路断面が縮小しているため，流れが収縮することで縮小損失が
生じると予想される．しかも，本節の実験では，捕捉部にスフェロイドが存在するた
め，狭窄した流路が詰まっており，その効果はより大きくなると考えられる．さらに，
狭窄した流路から再び中央流路の捕捉部以降の領域（幅：500 µm，高さ：400 µm）に
流れが進んだ時，今度は流路断面の拡大によって拡大損失が生じると予想される．こ
れらの理由から，本節の実験における狭窄した流路の流路抵抗は大きいと考えられる．
そのため，変形しやすいゲルにかかる圧力が大きく，それがゲル破損の原因であると
考えられる．ただし，本節の実験における中央流路の流れにおいて，渦や乱流が生じ
るのかについては実証出来ていないため，さらなる実証実験が必要である．
　ゲルが破損した後にも，流量を増大させながら送液実験を繰り返した．結果として，
スフェロイドが捕捉部の狭窄した流路に押し込まれて変形し，最終的には捕捉部から
押し出されて流失する様子が観察された（図 2.23a）．他の例としては，変形して破損

図 2.23 スフェロイドの捕捉時におけるスフェロイドの耐久性．(a) スフェロイドの変形およ
び流失，(b) 変形したゲルに嵌まり込むスフェロイド．
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した片側のゲルの方向にスフェロイドが流され，ゲルの破損時に生じた亀裂部分にス
フェロイドが嵌り込むという例も見られた（図 2.23b）．これらの結果を 2.10 節の結果
と総合すると，スフェロイドの捕捉時における中央流路の捕捉部側への送液は，静水
圧を用いた 2.10 節の手法では，ゲルの破損を伴わずにスフェロイドを安定して捕捉可
能な方法として用いることが出来たが，ポンプによる送液を行うと，300 µL/ 分程度の
流量であってもゲルに圧力がかかり，破損するという結果に終わる可能性があること
が分かった．これらのことから，静水圧を用いたスフェロイドの捕捉手法の実用性が
支持された．

2.12　中央流路の流れに対するスフェロイドとゲルの接着性評価

　スフェロイド捕捉後の中央流路への送液可能性を評価した．2.11 節で述べた通り，
中央流路への捕捉部側からの送液は，ゲルの破損やスフェロイドの捕捉部からの流失
を招く可能性があり，送液には適していないことが示唆された．そこで，本節では，
捕捉部の逆側から送液を行うという手法について検討する．スフェロイドのゲルへの
接着後に，2.11 節と同様のセットアップで，シリンジおよびシリコーンチューブと連
結された ETFE チューブを用意し，デバイスの中央流路の捕捉部と逆側の送液口に差
し込んだ．まずは，中央流路への送液可能性を確認するため，赤色蛍光マイクロビー
ズを懸濁させた EGM-2 培地で満たしたシリンジをシリンジポンプに装着し，50 µL/ 分，
100 µL/ 分，200 µL/ 分，300 µL/ 分，400 µL/ 分，500 µL/ 分の流量で送液を行った．ハ
イスピードカメラを用いて，1 秒間に 3000 コマでマイクロビーズの挙動を撮像した．
観察の結果，マイクロビーズが中央流路内を流れることが確認され，またその際にス
フェロイドがゲルから剥がれることは無かった（図 2.24a）．2.5 節および 2.10 節と同
様に Fiji ソフトウェアの Manual Tracking を用いて，ハイスピードカメラで撮像したマ
イクロビーズの挙動を追跡したところ，捕捉部の狭窄した流路を流れる際に，マイク
ロビーズの流速が最大となるという特徴を有することが分かった（図 2.24b）．この原
因は，流路が狭窄しているため，培地が狭窄した箇所を流れる際に，流線が流路の中
央に集束するためであると考えられる．各流量条件ごとに 3 つのマイクロビーズを追
跡して得た解析結果をまとめたグラフが図 2.24c である．平均流速は，各流量条件ご
とに追跡した 3 つのマイクロビーズの流速の平均値を示す．また，最大流速は，各流
量条件ごとに追跡した 3 つのマイクロビーズの 1 コマあたりの最大速度の平均値を示
す．グラフから，培地の流量の増加に伴って，平均流速と最大流速のいずれもが増加
する傾向にあることが分かった．ただし，最大速度に関しては，300 µL/ 分の流量でマ
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イクロビーズの流速がほとんどプラトーに達した．この結果から，300 µL/ 分以上の流
量条件では，流路の狭窄した箇所，即ちスフェロイドの周囲を流れる培地の流速はほ
とんど変わらなくなることが示唆された．ただし，以降の 3.5 節の実験で示すように，
3000 µL/ 分を超えるような高流量条件下では，より強い流れがスフェロイドにかかる
と考えられる．
　上述した実験と類似の実験を，上部流路，中央流路とそれらの間に一つのゲル形成
領域のみが存在する設計の微小流路を有するデバイスを用いても行った．マイクロ
ビーズを 20 µL/ 分の流量で流して挙動を観察した結果，マイクロビーズがスフェロイ
ドの周縁部分を通過して流れることが分かった．さらに，Fiji ソフトウェアの Manual 

図 2.24 ゲルに接着したスフェロイドへの送液．(a) 蛍光マイクロビーズの中央流路への送液，
(b) マイクロビーズの最大流速時の移動域，(c) 培地のピペットチップへの導入量とマイクロ
ビーズの平均流速および最大流速を示すグラフ．n = 3，mean±s.e.
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Tracking を用いた解析の結果，前述した結果と同様に，流路が狭窄した箇所を通る際に，
マイクロビーズの流速が最大となることが分かった（図 2.25）．この結果から，スフェ
ロイドが接着するゲルが一つしかなかったとしても，スフェロイドがゲルから外れる
ことなく，中央流路に培地を送液できることが示された．
　本節の結果から，本デバイスを用いることで，原理上は中央流路を介して微小流路
外部の培地チャンバの培地をスフェロイドに供給可能であり，通常の培地交換や観察
といった作業に伴うと想定される揺れ等ではスフェロイドがゲルから外れるといった
ことなく培養を継続することが可能であると推測できる．さらに，本デバイスを用い
ることで，スフェロイドに対する流れ刺激や中央流路への生化学物質の供給を伴う培
養への応用の可能性が示された．

2.13　 上部流路および下部流路への送液機能の検証

本デバイスの特徴である二方向への生化学物質の濃度勾配の形成を実現するにあた
り，まず上部流路および下部流路への送液機能を確認した．2.11 節および 2.12 節と同
様のセットアップで，シリンジおよびシリコーンチューブと連結された ETFE チュー
ブを用意し，デバイスの下部流路の送液口に差し込み，シリンジポンプを用いて赤色
蛍光マイクロビーズを懸濁した EGM-2 培地を 50 µL/ 分，100 µL/ 分，200 µL/ 分，300 

µL/ 分，400 µL/ 分，500 µL/ 分の流量で送液した．結果として，下部流路に蛍光マイ

図 2.25  片側のみにゲル形成領域を有するデバイスにおけるスフェロイド捕捉後の中央流路の
流れ．(a) Manual Tracking によるマイクロビーズの流れの軌道，(b) 時間ごとのマイクロビーズ
の移動速度を示したグラフ．
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クロビーズが流れる様子が観察された（図 2.26a,b）．さらに，蛍光マイクロビーズが
ゲル形成領域を通って中央流路に漏出することは無かった．これらの結果は，2.5 節や
それ以降の節でも示されてきた通り，ゲルの形成により中央流路と上部流路，および
中央流路と下部流路とが隔てられたことを示している．さらに，下部流路に蛍光マイ
クロビーズが流れたという結果から，ゲル形成時にゲル溶液が下部流路を塞ぐように
残存することはなく，局所的なゲル形成というデバイスの設計が機能したことが示唆
された．2.5 節，2.10 節や 2.12 節と同様に，ハイスピードカメラを用いて撮像した蛍
光マイクロビーズの挙動を Fiji ソフトウェアの Manual Tracking で解析したところ，蛍

図 2.26 下部流路への蛍光マイクロビーズの送液．(a) 蛍光視野での送液時の様子，(b) Manual 

Tracking によるマイクロビーズの軌跡，(c) 蛍光マイクロビーズ含有培地の送液流量とマイク
ロビーズの流速の関係を示したグラフ．n = 3，mean±s.e.
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光マイクロビーズを懸濁した培地の流量に対する蛍光マイクロビーズの流速を表すグ
ラフが得られた（図 2.26c）．結果として，蛍光マイクロビーズを懸濁した培地の流量
の増加に応じて，蛍光マイクロビーズの流速が増加することが分かった．この結果から，
本デバイスを用いることで，下部流路への送液が可能であり，それにより生化学物質
の導入が可能であることが示唆された．なお，流量が大きい 400 µL/ 分や 500 µL/ 分の
条件下では，流速の標準誤差が大きくなっているが，これは，下部流路内の位置によっ
て流速に分布が生じていることが原因だと考えられる．本論文ではデータとしての解
析は行っていないが，撮像したハイスピードカメラの動画から，下部流路における曲
がり部の外側（つまりゲル側）や内側（つまり送液口側）を通るマイクロビーズは，
中央を通るマイクロビーズと比較して，流速が遅いことが観察された．上部流路と下
部流路は中央流路の中央を通る面を対称面として面対称の構造となっており，実質的
に同じ構造を有する．そのため，本節では下部流路への送液実験のみを行ったが，上
部流路に関しても同様の結果が得られると考えられる．

2.14　蛍光物質を用いた濃度勾配の形成

　本節では，本デバイスの特徴である二方向への生化学物質の濃度勾配の形成機
能を実証する．まず，設計したデバイスによる濃度勾配の形成機能を COMSOL 

Multiphysics® を用いたシミュレーションにより評価した．実際のデバイスの寸法を用
いて，中央流路，上部および下部流路，ゲル形成領域，スフェロイド（直径 500 µm

とした）からなる二次元モデルを作製した．VEGF の培地，ECM，および細胞膜にお
ける拡散係数の文献値を参考にし，中央流路と上部および下部流路における拡散係数
は水中での拡散係数と同等であると仮定して 2.5×10-9 m2/s，ゲル形成領域における拡散
係数を 2.0 mg/mL のコラーゲンゲル中における 40 kDa の蛍光デキストランの拡散係数
と同等であると仮定して 6.6×10-11 m2/s，スフェロイドにおける拡散係数は細胞膜にお
ける拡散係数と同等であると仮定して 1.2×10-11 m2/s とした [88]．濃度の初期条件は，t 

= 0 分において，条件 1（上部流路：0 mol/m3，下部流路：2 mol/m3），条件 2（上部流路：
1 mol/m3，下部流路：3 mol/m3），条件 3（上部流路：2 mol/m3，下部流路：4 mol/m3），
条件 4（上部流路：3 mol/m3，下部流路：5 mol/m3）の 4 条件を設定した．以上のパラメー
タを用いて，稀釈輸送法によりフィックの第 2 法則（式 2.4）に従うモデルとしてシミュ
レーションを実行し，微小流路内における 24 時間後までの濃度分布を算出した．
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         ・・・式 2.4

ただし，J は流束，D は拡散係数，c は濃度，u は速度を表す．

結果の一部として，濃度の初期条件が条件 2（上部流路：1 mol/m3，下部流路：3 mol/

m3）の時の，開始時（0 分後），1 分後，5 分後，10 分後，60 分後，24 時間後における
微小流路内の濃度分布を図 2.27a に示した．また，2 つのゲル形成領域とスフェロイド
が存在する中央流路の捕捉部を通る線分を上部流路から下部流路にかけて規定し，線
分における時間ごとの濃度分布の変化をプロットした（図 2.27b）．これらのシミュレー
ションの結果から，本デバイスを用いて上部・下部流路の片側のみに生化学物質を導
入する，あるいは上部・下部流路の両側にそれぞれ異なる濃度の生化学物質を導入す
ることにより，数分の内に 2 つのゲル形成領域とスフェロイドにおいて生化学物質の
濃度勾配が形成され始め，60 分以内におおよそ安定して形成された濃度勾配が 24 時
間後まで保持されることが示唆された．
　続いて，上述したシミュレーションの結果との整合性を検証するために，実際のデ
バイスを用いて，蛍光物質を上部流路および下部流路に導入し，蛍光強度分布の時間
変化を測定した．まず，蛍光タンパク質発現型ではない通常の HUVECを用いて，1ウェ
ルあたり HUVEC：HPF ＝ 1：4（5,000：20,000）の条件でスフェロイドを形成し，デ
バイスに捕捉した後に一晩培養することで，スフェロイドをゲルに接着させた培養 1

日目の試料を用意した．本節の実験で用いた蛍光物質は，フルオレセインイソチオシ
アネート（fluorescein isothiocyanate，FITC）標識デキストラン（FITC- デキストラン，
70 kDa，Sigma Chemical Company），ローダミン B イソチオシアネート標識デキストラ
ン（RITC- デキストラン，70 kDa，Sigma Chemical Company）であり，いずれも 2 µM, 

4 µM, 6 µM, 8 µM, 10 µM の濃度になるように PBS(-) に溶解させた．まず，本デバイス
を用いて生化学物質の濃度勾配を形成可能であることを示すため，条件 1（上部流路：
10 µM 70 kDa FITC- デキストラン，下部流路：PBS(-)），条件 2（上部流路：10 µM 70 

kDa FITC- デキストラン，下部流路：10 µM 70 kDa RITC- デキストラン）の 2 つの条
件で実験を行った．具体的には，上部流路および下部流路の 4 箇所の送液口に，先端
を切ったピペットチップを差し込み，各流路につき 200 µL ずつ PBS(-) または，PBS(-)

に蛍光物質を溶解させた溶液を加えた．加えた時間を開始時間（0 分後）として，1 分
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図 2.27  化学物質をデバイスに導入した際に形成される濃度勾配のシミュレーション結果．  　
(a) 時間ごとの化学種の濃度分布の推移，上部流路から 1 mol/m3，下部流路から 3 mol/m3 の化
学種を拡散，(b) 異なる初期濃度条件における時間ごとの濃度分布のプロット．
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ごとの蛍光のタイムラプスを倒立顕微鏡で 60 分間撮像した．また，試料をインキュ
ベータ内に静置し，開始時間から 24 時間経過後にも蛍光画像を撮像した．結果として，
流路に導入された蛍光物質が徐々にゲル内部を浸透する様子が観察された（図 2.28a）．
また 24 時間の培養後にも，開始時間から 45 分後（図 2.28b）とほとんど変化は無く，
上部流路に導入した蛍光物質は上部流路と上部流路側のゲルに，下部流路に導入した
蛍光物質は下部流路と下部流路側のゲルにそれぞれ留まっていた（図 2.28c）．Fiji ソ

図 2.28 蛍光デキストランの導入による濃度勾配の形成．(a) 経過時間ごとの正規化された蛍
光強度の位置分布，(b) 蛍光デキストラン導入 45 分後の流路内の蛍光，(c) 蛍光デキストラン
導入 24 時間後の流路内の蛍光．
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フトウェアを用いてそれぞれの条件における，開始時間（0 分後），1 分後，2 分後，3

分後，4 分後，5 分後，10 分後，20 分後，30 分後，40 分後，24 時間後の各画像を解
析した．手順としては，まず Toolbar の Area Selection Tools にある Rectangle を用いて，
上部流路側のゲルの末端から下部流路側のゲルの末端へと広がる長方形（長辺約 1,500 

µm，短辺約 200 µm）の領域を指定し，Analyze > Tools > ROI Manager で起動した ROI 

Manager を用いて ROI を定めた．それぞれの時間ごとに同一の ROI で Analyze > Plot 

Profile を用いて，選択範囲の濃度プロファイルのプロットを表示し，Data > Save Data

でプロットの csv データを保存し，グラフの作成に用いた．図 2.28a は各条件における
時間ごとの標準化された蛍光強度比のプロットを表している．結果として，条件 1 で
は開始時間から 10 分後に蛍光強度比が斜めの直線状の遷移を示した．この結果から，
本デバイス中では，70 kDa 程度の分子量の生化学物質は，導入から 10 分のうちに，
ゲル中に濃度勾配を形成することが示唆された．また，24 時間後のプロットでは，ゲ
ルが存在する範囲においては一様な蛍光強度比を示していた．ただし，中央流路では
蛍光強度比が勾配を形成していた．また，下側流路側のゲル形成領域以降では，上部
流路に導入された蛍光物質由来の蛍光強度比はほとんど 0 を示した．これらの結果か
ら，24 時間経過後には，ゲル内における生化学物質の濃度勾配は消失するが，中央流
路では濃度勾配が維持されることが示唆された．また，導入された生化学物質が微小
流路全域に拡散することは無く，導入された流路側に残存することが示唆された．以
上の結果から，本デバイスを用いて，まず一方向への生化学物質の濃度勾配を形成す
ることが可能であると示された．
　次に，上部・下部流路の両側からそれぞれ異なる濃度の生化学物質を導入した際の
濃度勾配の形成を観察するために，条件 3（上部流路：2 µM 70 kDa RITC- デキスト
ラン，下部流路：6 µM 70 kDa RITC- デキストラン），条件 4（上部流路：4 µM 70 kDa 

RITC- デキストラン，下部流路：8 µM 70 kDa RITC- デキストラン），条件 5（上部流路：
6 µM 70 kDa RITC- デキストラン，下部流路：10 µM 70 kDa RITC- デキストラン）の 3

条件で蛍光物質による蛍光強度分布のタイムラプスを撮像した．Fiji ソフトウェアを
用いてそれぞれの条件における，開始時間（0 分後），1 分後，2 分後，3 分後，4 分後，
5 分後，10 分後，20 分後，30 分後，40 分後，50 分後，60 分後，24 時間後の各画像を
解析し，蛍光強度のプロットを作製した（図 2.29）．結果として，開始時間から 20 分
後にかけて急速にゲル内およびスフェロイドの捕捉された中央流路の捕捉部に蛍光強
度の勾配が形成された．さらに，24 時間後の蛍光強度の分布は，中央流路において上
部・下部流路にそれぞれ導入された RITC- デキストランの蛍光強度が滑らかに繋がる
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ように勾配を形成した．これらの結果を図 2.27b に示されたシミュレーションの結果
と比較すると，本結果においては，導入された RITC- デキストランの濃度比が蛍光強
度の比とは必ずしも一致しなかったものの，シミュレーションで示された結果と同様
に，60 分以内での濃度勾配の形成や，24 時間後における濃度勾配の保持といった基本
的な傾向は一致していると考えられる．以上の結果から，本デバイスをシミュレーショ
ンと組み合わせて用いることで，二方向に任意の生化学物質の濃度勾配を形成するこ
とが可能であると示唆された．

2.15　結言

　本章ではまず，二方向への生化学物質の濃度勾配の存在下における血管内皮細胞の

図 2.29 異なる濃度の蛍光デキストランを導入した際の時間ごとの蛍光強度の分布．(a) 条件 3

（上部流路：2 µM 70 kDa RITC- デキストラン，下部流路：6 µM 70 kDa RITC- デキストラン），
(b) 条件 4（上部流路：4 µM 70 kDa RITC- デキストラン，下部流路：8 µM 70 kDa RITC- デキ
ストラン），(c) 条件 5（上部流路：6 µM 70 kDa RITC- デキストラン，下部流路：10 µM 70 kDa 

RITC- デキストラン）．
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遊走性の観察・評価を実現するためのデバイスの要件として，（i）局所的なゲルの形成，
（ii）スフェロイドの捕捉，（iii）各流路への送液，（iv）物質の濃度勾配の形成の 4 つ
の機能を規定した．実際にデバイスを設計および作製した後，蛍光ナノビーズを添加
した溶液を用いてゲルを局所的に形成可能であることを示し，蛍光タンパク質発現型
HUVEC を用いて形成したスフェロイドを捕捉した．さらに，蛍光マイクロビーズを
用いて中央流路および下部流路にポンプを用いた送液が可能であることを示した．最
後に，蛍光物質を含む溶液を上部流路および下部流路に導入し，蛍光強度の解析から
デバイスの流路内に蛍光物質の濃度勾配が形成されることを示した．上述の結果から，
本デバイスを用いることで，設計した二箇所のゲル形成領域にゲルを形成し，それら
のゲルの間にスフェロイドを捕捉し，さらに流路内に生化学物質の送液を行うことで，
二方向に生化学物質の濃度勾配を形成できることを示した．
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第 ３ 章
培 養 デ バ イ ス を 用 い た 血 管

内 皮 細 胞 培 養 機 能 の 評 価

3.1　緒言

　本章では，本デバイスを用いてスフェロイドおよび血管内皮細胞を培養し，血管新
生を含む血管内皮細胞の遊走を実現することにより，本デバイスが細胞の培養と観察
に利用可能であることを示す．具体的には，まず，本デバイスに血管内皮細胞と線維
芽細胞からなるスフェロイドを捕捉し培養することによって，スフェロイドから両側
に存在するゲルに向かって管腔構造や分岐形状を有する新生血管が形成されることを
示す．また，本デバイスのゲル上に血管内皮細胞を播種して培養することによっても，
管腔構造を有する新生血管の形成や血管内皮細胞の遊走が起きることを示す．続いて，
本デバイスにスフェロイドを捕捉し，ゲルを介した逆側に血管内皮細胞を播種して培
養することによって，内部に送液可能な新生血管が形成されることを示す．本章の後
半部分ではさらに，本デバイスを用いた応用的な培養として，培地灌流を伴う培養を
実施し，その培養への効果を調べることにより，本デバイスにより培地灌流が可能で
あることの概念実証を行う．
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3.2　デバイス内におけるスフェロイド培養

　本節では，本デバイスを用いることで，スフェロイドの培養と，血管新生を含む
血管内皮細胞の遊走が可能であることを示す．まず，上部流路，中央流路とそれら
の間に一つのゲル形成領域のみが存在する設計の微小流路を有するデバイスを用い
てスフェロイドの培養を行った．このデバイスでは，三次元造形により作製した培
地チャンバは使用せず，PDMS の流路パターン転写物を 35 mm ガラスベースディッ
シュ（3960-035，厚さ：0.15–0.18mm， AGC テクノグラス株式会社）にボンディン
グして作製した（図 3.1）．また，ゲル形成領域の高さ（200 µm）が流路の高さ（500 

µm）の 40% になるよう設計されている．まず，2 章に詳述した通り，作製したデバイ
スの一箇所のゲル形成領域にゲルを形成し，NHDF：HUVEC ＝ 4：1（12,000：3,000）
の細胞数比で作製したスフェロイドを捕捉した．カルセインを用いて標識したゲルに，
RFP-HUVEC を含むスフェロイドを捕捉した様子を，共焦点顕微鏡を用いて Z-stack で
観察したところ，一方向のみにゲルが形成されるデバイスにおいても，スフェロイド
が捕捉部でゲルと接触した状態となることが確認された（図 3.2）．
　そこで，蛍光物質を含まない通常のゲルを形成し，GFP-HUVEC を用いて形成され
たスフェロイドを捕捉した後，培地チャンバ内に 4 mL の EGM-2 培地を加えて培養を
行った．20 日間の培養の結果，スフェロイドからゲルの方向に，血管新生を伴う血管

1 cm

ガラスベースディッシュ

上部流路の
送液口・排液口

中央流路の
送液口・排液口

(b)

1 mm

上部流路
（高さ 500 μm）

中央流路
（高さ 500 μm）

(a)

ゲル形成領域
（高さ 200 μm）

図 3.1  片側のみにゲル形成領域を有するデバイス．(a) 微小流路のモルド．(b) デバイスの全
体像．(© 2020 IEEE)
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内皮細胞の遊走が観察された（図 3.3a）．Fiji ソフトウェアを用いて，GFP-HUVEC 由
来の緑色蛍光を示す領域を二値化して表示し，その面積を計測したところ，培養時間
と緑色蛍光領域の面積の関係性を表したグラフが得られた（図 3.3b）．結果として，培
養時間が長くなるごとに，緑色蛍光領域の面積が広くなることが分かった．さらに，
培養日数ごとの新生血管のゲル側方向（上部流路方向）および逆側方向（中央流路方
向）に生じた分岐端の数をグラフ化した（図 3.3c）．結果として，培養日数が長くなる
につれて，分岐端の総数が増加することが分かった．この結果から，本デバイスを用
いて血管内皮細胞を含むスフェロイドを培養することで，血管内皮細胞の遊走を観察
し，緑色蛍光領域の面積によって定量化することが可能であることが示された．ただし，
培養 7 日目の時点では，ゲル側方向への分岐端が約 9 割を占めており，逆側方向には
約 1 割しか分岐端が形成されていなかった．この結果から，ゲルが存在することによっ
て，ゲルがスフェロイドおよびスフェロイドを構成する細胞にとって足場として機能
し，血管内皮細胞の遊走を補助することが示唆された．また，培養 11 日目までは，ゲ
ル側方向に形成された分岐端の数が増加していたが，それ以降はプラトーの状態となっ

スフェロイド

カルセイン
染色したゲル

接触境界

赤：
RFP-HUVEC

緑：
カルセイン

100 µm

100 µm

100 µm

(a)

断面 ii-ii’

断面 i-i’

i

ii

ii’

i’

100 µm

(b)

スフェロイド

(c)

図 3.2 片側のみにゲル形成領域を有するデバイスを用いたスフェロイドの捕捉．(a) 共焦点
顕微鏡で撮像した Z-stack の平面図および断面図，(b) 倒立顕微鏡による明視野像，(c) 共焦点
顕微鏡で撮像した Z-stack の 3D 表示．(© 2020 IEEE)
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た．培養 11 日目以降も，緑色蛍光領域の面積は拡大していたことから，ゲル方向に形
成された新生血管は，培養 11 日目まで分岐を繰り返しながら伸長するが，それ以降は
伸長の速度が緩まり，形状のリモデリングや管腔の安定化等が起きている可能性が示
唆された．一方で，培養 7 日目以降から，逆側方向への新生血管の分岐端の数が線形
的に増加した．この結果から，培養 7 日目以降は，GFP-HUVEC が中央流路内のガラ
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図 3.3  片側のみにゲル形成領域を有するデバイスを用いたスフェロイドの培養．(a) 培養 7

日目および 培養 11 日目のスフェロイド，(b) 培養日数と GFP-HUVEC による緑色蛍光領域の
面積との関係を示すグラフ，n = 2，(c) 培養日数と新生血管の枝分かれにより生じた末端の数
を示すグラフ．n = 2．(© 2020 IEEE)



ス底面を遊走することが可能になることが分かった．この原因は明らかにできていな
いが，スフェロイド内の NHDF から産生された ECM が中央流路のガラス底面に徐々
に付着し蓄積されたことによると推察される．以上の結果から，1 週間の培養におい
ては，血管内皮細胞の遊走はゲルの方向に向かって起きるが，1 週間半以上に渡る培
養を行うと，ゲル以外の方向にも細胞の遊走が起きることが明らかになった．そのため，
本論文の第 4 章で，実際に生化学物質を用いて培養を行った際には，培養期間を 1 週
間とした．
　培養 7 日目のスフェロイドおよびゲル中の遊走された血管内皮細胞を，共焦点顕微
鏡を用いて Z-stack で撮像した（図 3.4）．x-z 断面の結果から，形成された新生血管は
GFP-HUVEC によって囲まれた管腔構造を有することが分かった．さらに，複数の x-z

断面の比較により，2 つの管腔構造が徐々に繋がり，一つの管腔構造となっている部
分が存在したことから，本デバイスを用いて形成された新生血管は，分岐形状も有す
ることが分かった．これらの結果から，本デバイス内における血管内皮細胞からなる
スフェロイドの培養によって，7 日間の培養でゲルの方向に血管新生が起きたことが
示唆された．以上より，本デバイスを用いることで，20 日間に渡るスフェロイドの培
養が可能であり，さらに血管新生を含む血管内皮細胞の遊走といった現象の観察が可
能であることが示唆された．
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緑：GFP-HUVEC

管腔構造

図 3.4  共焦点顕微鏡により撮像された培養 7 日目のスフェロイドと新生血管．矢印は管腔構
造．(© 2020 IEEE)
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　本節ではさらに，上述したデバイスと同様に，スフェロイドの捕捉部の両側にゲル
形成領域が存在するデバイスを用いたスフェロイドの培養を行った．HPF：HUVEC＝4：
1（20,000：5,000）の細胞数比で作製したスフェロイドを捕捉し，6 日間培養した後に
4% パラホルムアルデヒド固定液（武藤化学株式会社）により室温で 20 分間固定した．
続いて PBS(-) で試料を 3 回洗浄した後，0.2% Triton-X（PBS(-) に溶解）を流路内に導
入して室温で 20 分間静置することで，膜透過処理を行った．PBS(-) で試料を 3 回洗浄
し，2% ウシ血清アルブミン（bovine serum albumin，BSA）溶液（PBS(-) に溶解）を流
路内に導入し，室温で 2 時間静置することで，ブロッキング処理を行った．マウス由
来抗ヒト CD31 抗体を 1/400 の濃度で 2%BSA 溶液に稀釈させ，流路内に導入して 4℃
の冷蔵庫内で終夜静置させることで，一次抗体反応を行った．翌日に試料を PBS(-) で
3 回洗浄し，Alexa Fluor® 568 修飾ヤギ由来抗マウス抗体を 1/500 の濃度で 2%BSA 溶
液に稀釈させ，流路内に導入して室温で 2 時間静置することで，二次抗体反応を行った．

図 3.5 培養 6 日目スフェロイドの CD31 蛍光免疫染色像（赤：CD31，緑：F アクチン，青：
細胞核）．(a) スフェロイドおよびゲル中に遊走した細胞の全体像，(b) a の白点線枠内の領域を
拡大した Z-stack 像．矢印は管腔を形成していると見られる箇所．
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図 3.6  ピペットチップを用いた中央流路への培地供給の手法．(a) 培地供給の手法の概要図，
(b) 二本のピペットチップが中央流路の二つの送液口に差し込まれた培養中のデバイス．

試料を PBS(-) で 3 回洗浄した後に，Alexa Fluor® 488 修飾ファロイジンおよび Hoechst

を 1/1000 の濃度で PBS(-) に稀釈させ，流路内に導入して室温で 1 時間静置することで，
細胞内骨格の F アクチンおよび核を染色した．試料を PBS(-) で 3 回洗浄し，共焦点顕
微鏡により撮像を行ったところ，HUVEC からなる管腔構造が形成されたことが分かっ
た（図 3.5）．この結果より，本デバイスを用いることで，CD31 の発現および管腔の
形成を伴うスフェロイドの培養が可能であることが示された．

3.3　ゲル壁面に播種した血管内皮細胞の培養

　本節ではデバイス中での血管内皮細胞の培養について記載する．本デバイスを用
いて 2.3 節に記載した方法でゲルを形成した後に，2.8 節に記載した通りに各流路に
EGM-2 培地を導入した．続いて，5.0×106 cells/mL の細胞密度で GFP-HUVEC を懸濁し
た EGM-2 培地をマイクロチップを用いて上部流路に約 20 µL 導入した．この際に，細
胞懸濁液が中央流路に混入しないよう，中央流路の 2 箇所の送液口に先端を切ったマ
イクロチップを差し込んでおいた．GFP-HUVEC を上部流路側のゲルに接着させるた
め，上部流路側が鉛直上向き方向，下部流路側が鉛直下向き方向になるようにデバイ
スを傾けてインキュベータ内で 15 分間静置した．重力によって上部流路に導入された
細胞がゲル表面に沈降し，ゲル表面に接着した．続いて，上部流路に EGM-2 培地を
約 20 µL 導入することで未接着の細胞を洗い流し，下部流路側のゲルにも同様の操作
によって GFP-HUVEC を播種した．この際に，GFP-HUVEC を播種してから 1 時間以
上洗い流さずにゲルへの接着のための培養を続けてしまうと，沈降した細胞が流路内
で凝集し始め，さらに培養を続けるとほとんどの細胞が丸くなって浮遊した．この結
果から，5.0×106 cells/mL という細胞密度の条件では，培地内の栄養や酸素が不足し，
1 時間以上の培養により少なからず細胞にダメージが及ぶことが示唆された．ただし，
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15 分以内の培養と，その後の余分な細胞の除去によって，問題なく細胞がゲルに接着
することが示された．細胞の播種後，培地チャンバ内に 4 mL の EGM-2 培地を加えて
培養を行った．中央流路の二つの送液口に先端を切ったピペットチップを差し込み，
そこに添加物を加えた培地を 100 µL または 200 µL 加えることで，中央流路側から上
部流路側および下部流路側への，間質流が生じる条件で培養を行った（図 3.6）．ピペッ
トチップ内の培地は，一日ごとに全量を交換した．結果として，GFP-HUVEC が上部
流路側および下部流路側のゲルの壁面から，中央流路側へとゲル内部に遊走された様

500 μm500 μm500 μm

500 μm500 μm500 μm

(a)

0日目 2日目 4日目

0日目 2日目 4日目
(b)

図 3.7 本デバイスを用いた血管内皮細胞の培養．(a) 毎日 100 µL ずつ培地交換した際の血管
内皮細胞の遊走，(b) 毎日 200 µL ずつ培地交換した際の血管内皮細胞の遊走．矢印は管腔を形
成していないと見られる箇所．
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子が観察された（図 3.7）．遊走された GFP-HUVEC の様子から，管腔構造を形成して
いないと見られるため，本実験による血管内皮細胞の遊走では，血管新生は起きず，個々
の細胞が遊走したと考えられる．以上の結果から，本デバイスを用いることで，ゲル
壁面からの血管内皮細胞の遊走を観察することができた．ただし，本実験で用いた培
地等の培養条件では，血管新生は起きず，血管内皮細胞の遊走が見られただけにとど
まったので，血管新生を用いた応用を行うためには，培養条件の改善が望まれる．

3.4　スフェロイドとゲル壁面に播種した血管内皮細胞の共培養

　本節では，血管内皮細胞をゲル壁面に播種した後に，スフェロイドを捕捉して共培
養を行った．3.3 節と同様の手法でデバイスの上部流路および下部流路に面したゲルの
壁面に GFP-HUVEC を播種し，培地チャンバに 8 mL の EGM-2 培地を加えた．2 日間
の培養後，中央流路に RFP-HUVEC：HPF：MCF-7 ＝ 1：3：1（5,000：15,000：5,000）
の細胞数比で形成したスフェロイドを捕捉した．2.8 節での定義と同様に，スフェロ
イドを捕捉した日を培養 0 日目とし，培養 20 日目までインキュベータ内で培養を行っ
た．培養時は 2 日に 1 回，8mL の EGM-2 培地を全量交換した．結果として，ゲル壁
面からスフェロイドの方向への血管新生が起きた（図 3.8a）．共焦点顕微鏡を用いて
Z-stack で撮像したところ，x-z 断面の観察結果から，形成された新生血管は管腔構造
を有することが分かった（図 3.8b）．この試料の上部流路の二箇所の送液口に先端を切っ
たマイクロチップを差し込み，蛍光マイクロビーズ（直径 15 µm）を懸濁した EGM-2

培地を導入した．結果として，蛍光マイクロビーズが新生血管の内部に流れこむ様子
が観察された（図 3.8c）．以上の結果から，本デバイスを用いてゲルの壁面に播種した
血管内皮細胞と捕捉したスフェロイドを共培養することで，ゲル中に内部に送液可能
な新生血管が形成されることが示唆された．
　続いて，別の試料で 12 日目まで培養を行ったところ，壁面の GFP-HUVEC とスフェ
ロイドに含まれる RFP-HUVEC の両方がゲル中に血管新生を起こした様子が観察さ
れた（図 3.9a）．共焦点顕微鏡を用いた Z-stack での観察を行ったところ，複数箇所に
おける y-z 断面の観察から，形成された新生血管が管腔構造を有していることが観察
された（図 3.9b）．さらに，一部の新生血管については，管腔構造が GFP-HUVEC と
RFP-HUVEC の両細胞によって構成されていることが観察された．この結果から，本
デバイスを用いて血管内皮細胞を含むスフェロイドと，ゲルを挟んで反対側に播種し
た血管内皮細胞とを共培養することによって，双方からゲル内部に向かって血管新生
が起き，それらの新生血管の一部が繋がって一つの管腔構造を形成することが示唆さ
れた．



 

　形成された新生血管内に培地を送液可能であることを示すために，この試料を 20 日
目まで培養した後に，下部流路の二箇所の送液口に先端を切ったマイクロチップを差
し込み，マイクロビーズ（直径 10 µm）を懸濁した EGM-2 培地を導入した．結果とし

図 3.8 ゲル壁面に播種された血管内皮細胞により形成された新生血管．(a) 明視野像，(b) 共
焦点顕微鏡による Z-stack 像（矢印は管腔），(c) 新生血管内部への蛍光マイクロビーズの送液（矢
印は管腔に入り込んだマイクロビーズ）．
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図 3.9 スフェロイド（RFP-HUVEC を含む）およびゲル壁面に播種された血管内皮細胞
（GFP-HUVEC）の両細胞により構成された管腔構造．(a) 全体像，(b) 下部流路側ゲル内の

Z-stack 像．矢印は赤と緑の二色で構成された管腔構造．
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て，下部流路に導入されたマイクロビーズが，下部流路側のゲル内の新生血管が存在
する位置を通って流れ，上部流路側のゲル内の新生血管が存在する位置を通って上部
流路まで達した（図 3.10）．これらの結果から，本デバイス内で形成された新生血管が，
培地が通ることの可能な流路として機能し，それにより，片側の流路から流した培地
を逆側の流路へと送液することが可能であると示唆された．

図 3.10 下部流路からのマイクロビーズの送液による上部流路への輸送．(a) 明視野像でのマ
イクロビーズの軌跡，(b) 軌跡の重ね合わせにより明らかになったビーズが通ったと考えられ
る新生血管．



 

3.5　培地灌流を用いた培養

　連続的な栄養供給や，流体力学的刺激を伴う培養という本デバイスの更なる応用可
能性について概念実証を行うため，3.4 節に記載した手法でゲル壁面への血管内皮細胞
の播種およびスフェロイドの捕捉を行ったデバイス内で，各流路への培地灌流を行い，
培養への影響を確認した．本研究ではまず，スフェロイドのゲルへの接着の流れに対
する耐久性を評価するため，2.12 節で記した実験と同じセットアップを用いて，一定
流量で 5 分間，EGM-2 培地を流した．送液後 5 分間以上の間隔を設けてから，流量を
増加させて次の送液を行い，スフェロイドがゲルから剥離するまで実験を繰り返すこ
とで，スフェロイドのゲルへの接着の耐久性を評価した．各流量の条件で培地の送液
を行ったところ，流量に応じて，スフェロイドが流れの方向に押されて変形する様子
が観察された．最終的には図 3.11a に示すように，片側のゲルからスフェロイドが剥
離する様子が観察された．図 3.11b のグラフは，それぞれの流量条件下におけるスフェ
ロイドの左端位置の変位量を表している．2 つの試料を用いて実験を行ったところ，
3000 µL/ 分まで剥離せず 3200 µL/ 分の流量条件で剥離したという結果と，3400 µL/ 分
まで剥離せず 3800 µL/分の流量条件で剥離したという結果が得られた．この結果から，
本デバイスの手法を用いたスフェロイドのゲルへの接着により，ポンプによる送液に
対して 3000 µL/ 分程度の流量まではスフェロイドがゲルから剥離しないことが示唆さ
れた．続いて，培地灌流を伴う培養を実施するため，装置等のセットアップを行った．
試作段階のデバイスでは，デバイスの蓋にデスクドリル（K-16，ホーザン株式会社）
で穴を開け，そこに生検トレパン（直径 1 mm）で穴を開けたシリコスポンジシート（厚
さ 5 mm，5-3030-04，アズワン株式会社）を詰め，ETFE チューブを差し込むことで外
部のポンプとの接続を検討した．しかし，このセットアップでは，ETFE チューブが
蓋の穴を通した位置で固定され，ETFE チューブを微小流路の送液口に差し込むとい
う操作の難易度が高く，コンタミネーションのリスクが高いと考えられた．また，培
地交換の際に ETFE チューブを逐一引き抜くことが必要だったため，操作性に乏しかっ
た．そこで，ポート付きの培地チャンバを用いるというより操作性の優れたデバイス
を着想した．2.2.3 項に記載した通り，本デバイスは，培地チャンバの側部にチューブ
と接続可能なポートを有しており，このポートを介して，デバイスの内部にある微小
流路をデバイスの外部にあるポンプと接続することが可能である．一般的に，培養用
の微小流体デバイスへのチューブ接続作業は，クリーンベンチ内で手作業により行わ
れ，細かな技術が必要とされるため，コンタミネーションが起きるリスクが高い．本
研究では，コンタミネーションを防ぐために，培地やデバイス内部に直接触れないよ

70



 

うに，ピンセットを用いてチューブ接続作業を行った．さらに，2.4 節に記載した通り，
デバイスの使用前に，70% エタノール，紫外光およびオゾンガスによる滅菌処理を施
した．また，2.6 節に記載した通り，市販の EGM-2 培地にペニシリン / ストレプトマ
イシンを加えることで，微生物によるコンタミネーションのリスクを低減した．実際に，
紫外線消毒保管庫（DM-90，アズワン株式会社）を用いて 5 分間の滅菌処理を行った
のみのデバイスを用いると，培地灌流時に高確率でカビのコンタミネーションが発生
した．また，紫外光およびオゾンガスによる滅菌処理を施したデバイスを用いた場合
でも，微生物によるコンタミネーションが発生することがあった．したがって，70%

エタノール，紫外光およびオゾンガスによる滅菌処理と，培地へのペニシリン / スト
レプトマイシンの添加が，コンタミネーションの防止に重要であることが分かった．
　ペリスタポンプ（低流量型，SJ-1211 Ⅱ -L，アトー株式会社）を用いて培地灌流を

図 3.11 スフェロイド接着後の中央流路への流れに対するスフェロイドの耐久性．(a) 3200 µL/

分の流量で培地を送液した時のスフェロイドのゲルからの剥離，(b) 培地送液の流量に対する
スフェロイドの左端位置の変位量を示したグラフ．n = 2．
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行った．まず，灌流時に送液を担うチューブ内に気泡が混入するリスクを低減するた
めに，培地用の液溜めを作製した．遠沈管（25 mL，AGC テクノグラス株式会社）の
蓋に直径 3.0 mm のドリルを用いて二箇所に穴を開け，それぞれの穴に細いシリコー
ンチューブ（外径 2 mm）を介して ETFE チューブが片側にのみ嵌め込まれたストレー
トミニフィッティング（内径 1.5 mm，VFI116，株式会社アイシス）を，ETFE チュー
ブの嵌め込まれた側が容器の内部側（蓋の裏側）になるように差し込み，エポキシ系
接着剤を隙間を埋めるように塗布した後に一晩乾燥させることで接着した．加工した
フィッティング付きの蓋を元の遠沈管の容器に嵌め込むことで，培地用の液溜めとし
て使用した．続いて，作製した培地用の液溜め，細いシリコーンチューブおよび太い
シリコーンチューブ（外径 3.0 mm，内径 1.0 mm，または外径 4.0 mm，内径 2.0 mm，
アズワン株式会社），ETFE チューブ，メスルアーフィッティング，オスルアーロック
コネクタ（ITRM106，株式会社アイシス）を，紫外光およびオゾンガスで滅菌処理した．
それらを連結させて太いシリコーンチューブをペリスタポンプのカセットに取り付け，
70% エタノール，PBS(-) の順にチューブ内に各溶液を 10 mL 以上，10 分間以上ずつ流
すことで，チューブの内部を洗浄した．続いて，オスルアーロックコネクタにフィル
タ（膜孔径 0.45 µm，SLHV033RS，Merck Millipore Ltd.）を取り付け，培地用の液溜め
に 20 mL の EGM-2 培地を加え，チューブ内を EGM-2 で満たしてから，培地チャンバ
に 8mL の EGM-2 培地を加えたデバイスと接続し，ペリスタポンプの電源を入れて培
地灌流を行った．接続の詳細を以下に記す（図 3.12a）．まず，培地チャンバ内の培地
の液面下に先端が浸かった細いシリコーンチューブを，培地チャンバ片側にあるポー
トの内側に接続し，そのポートの外側に長めに切った別の太いシリコーンチューブを
接続した．その太いシリコーンチューブはペリスタポンプのカセットに取り付けられ
ており，それがカセット内のローラーの回転によってしごかれることで，培地が吸引
される．その太いシリコーンチューブの逆側の先端をフィルタを取り付けたオスルアー
ロックコネクタに接続し，フィルタにメスルアーフィッティングを取り付け，さらに
その先に太いシリコーンチューブを接続した．その太いシリコーンチューブを，培地
用の液溜めの一方のストレートミニフィッティングに接続し，もう一方のストレート
ミニフィッティングにさらに別の太いシリコーンチューブを接続した．この時，後者
のストレートミニフィッティングの容器の内部側に取り付けられている ETFE チュー
ブの先端が液溜め中の培地の液面よりも下に位置するようし，さらに培地の液溜めの
蓋をしっかりと締めることで，培地が一方のストレートミニフィッティング側から送
液されることで液溜め内部の圧力が上がり，逆側のストレートミニフィッティング側
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から培地が押し出され，接続された太いシリコーンチューブへと送液がなされるよう
にした．最後に，その太いシリコーンチューブを，培地チャンバの上述したポートと
逆側のポートの外側に接続し，そのポートの内側に細いシリコーンチューブを介して
ETFE チューブを接続し，ETFE チューブの逆側の先端を微小流路の送液口に差し込ん
だ．この詳述した接続によって，ペリスタポンプによって培地チャンバから培地が汲
み上げられ，フィルタおよび培地用の液溜めを通って微小流路へと送液がなされ，さ
らに微小流路を通過した培地が再び培地チャンバ内へと排出される培地灌流のシステ
ムが実現された（図 3.12b）．

図 3.12 培地灌流を伴う培養の概要図とセットアップ．(a) 概要図，(b) セットアップの模式図，
(c) ペリスタポンプに接続された液溜めおよび培養デバイス．



 

　実際に，このシステムを用いて，中央流路，上部流路，下部流路に培地灌流をしな
がら培養を行った．本実験では，ゲル形成領域の長さが 200 µm のデバイスを用いた．
また，GFP-HUVEC：NHDF ＝ 1：4（3,000：12,000）の条件で形成されたスフェロイ
ドを用いた．培養中は 2 日間ごとに培地チャンバ中の培地を 8 mL ずつ全量交換し，4

日間ごとに培地用の液溜め中の培地を 20 mL ずつ全量交換した．本実験における培地
灌流は，外径 4 mm，内径 2 mm の太いシリコーンチューブを用いて，ペリスタポンプ
のダイヤルを「1」に合わせて行った（図 3.12c）．培地灌流の開始前に，本条件におけ
る培地の送液流量を実測したところ，55 µL/ 分だった．まず，陰性対照として，培地
灌流を行わずに培養した試料の結果を示す．結果として，14 日間の培養を行ったとこ
ろ，上部流路側および下部流路側のゲルの方向，中央流路の方向等の複数の方向に血
管内皮細胞が遊走した（図 3.13a）．中央流路の観察から，培養 14 日目には HPF と見
られる蛍光を発していない細胞が遊走されていたが，培養 19 日目には中央流路に残存
していた細胞は減少していた．この結果は，スフェロイドを挟むように形成されたゲ
ルが，細胞にとっての足場となりやすく，ガラス底面の中央流路よりも遊走が起きや
すいことを示唆している．一方で，同一条件で培養した別の試料では，培養 14 日目お
よび培養 19日目の両日とも，HPFおよび GFP-HUVECが中央流路に遊走されていた（図
3.13b）．このような結果の違いが生じた原因は不明だが，これらの結果から，培地灌
流を行わずに培養した試料では，複数の方向に血管新生および血管内皮細胞の遊走が
起き，また試料によっても異なるが，中央流路にも細胞が遊走されることが示唆された．
この結果は，3.2 節の結果とも概ね合致している．
　続いて，中央流路に培地灌流を行った培養の結果として，RFP-HUVEC を含むスフェ
ロイド側および GFP-HUVEC を播種したゲル壁面側の双方からゲル内部に向かって血
管内皮細胞の遊走が見られた（図 3.14）．また，一部では，両側から遊走された血管内
皮細胞が接触している様子が観察された．3.2 節の結果では，培養 7 日目以降はスフェ
ロイドから中央流路へも血管内皮細胞の遊走が起きたが，本節の実験では，中央流路
への血管内皮細胞の遊走は比較的に観察されなかった．この結果から，中央流路への
培地灌流によって，スフェロイドからの血管内皮細胞の遊走が抑制されたことが示唆
された．この原因の一つとして，培地の流れによって，そもそも血管内皮細胞自体が
微小流路外に流失した可能性が考えられる．また，もう一つの原因として，スフェロ
イドに含まれる線維芽細胞から分泌される ECM の成分が，培地によって流され，こ
れらの ECM の成分の中央流路のガラス底面への付着および蓄積が阻害されることで，
血管内皮細胞の中央流路への遊走が促進されなかったと考えられる．さらに，本節で
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前述した通り，本研究で用いているゲルが ECM の成分により構成されているため，
そもそも中央流路のガラス底面よりも細胞の足場としての機能が優れていることも，
原因として考えられる．一方で，明視野の観察では，中央流路への細胞の遊走が見ら
れることから，スフェロイドを構成する線維芽細胞である HPF は，中央流路に遊走し

図 3.13 培地灌流なしの条件におけるスフェロイドからの血管新生．(a) 試料 1 の結果，(b) 試
料 2 の結果．点線の円は新生血管の端部．
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たと考えられる．この結果から，中央流路への血管内皮細胞の遊走が観察されなかっ
たのは，中央流路のガラス底面に HPF 由来の ECM が付着しないためではないと推察
された．ここで，本実験における培地灌流によるせん断応力を計算する．流量が 50 

図 3.14 中央流路への培地灌流ありの条件におけるスフェロイドからの血管新生．点線の円は
GFP-HUVEC と RFP-HUVEC 双方から遊走した内皮細胞が接した箇所．
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µL/ 分の時，図 2.24 より，流速は 79.0 mm/ 秒である．それが中央の流速で，壁からは
250 µm 離れているので，速度勾配は 316 [1/s] である．既存の報告より，37℃における
培地の粘度を 9.5 × 10-4 [Pa·s] と置くと，以下の式 3.1 より，本実験でのせん断応力は，2.7 

dyn/cm2 である [96]．

　　　　　　　　　　　　　　　　　　　　　　　　　・・・（式 3.1）

既存研究より，培地の約 8.0 × 10-3–3.5 × 10-2 dyn/cm2のせん断応力を伴う培地灌流によっ
てスフェロイド（オルガノイド）内部の血管形成が促進されることが報告された [97]が，
本研究でのせん断応力はおよそ 2.7 dyn/cm2 であり，大きすぎるせん断応力の条件下で
は，新生血管の伸長や血管内皮細胞の遊走が起きにくいことが示唆された．
　続いて，上部流路および下部流路への培地灌流を行った培養の結果を示す（図 3.15）．
本実験では，まず 14 日間，上部流路への培地灌流を行った．その後，培養 14 日目で，
培地灌流を行う流路を下部流路に切り替えて，20 日目までさらに培養を続けた．培養
7 日目の拡大図から，上部流路に播種された RFP-HUVEC は，ゲル内部に向かって遊
走されることはなく，逆に流路側に向かって遊走した様子が観察された．さらに，培
養 14 日目の時点で，多くの RFP-HUVEC が上部流路に残存していない様子が観察され
た．ここで，本実験における培地灌流によるせん断応力を前述の通り計算する．上部
流路および下部流路への培地灌流を考えると，流量が 50 µL/ 分の時，図 2.26 より流速
は 7.5 mm/s である．それが中央の流速だと仮定すると，壁からは 250 µm 離れている
ので，速度勾配は 32 [1/s] である．従って式 3.1 より，本実験でのせん断応力は，0.28 

dyn/cm2 である．以上の結果から，0.28 dyn/cm2 のせん断応力を伴う本実験の培地灌流
の条件では，血管内皮細胞を培地灌流が行われている流路方向に遊走させ，さらに血
管内皮細胞を高いせん断応力によって流路およびゲルから剥がし取り，流失させてし
まうことが示唆された．続いて，明視野での観察から，培養日数が経過するにつれて，
HPF と見られる蛍光を発さない細胞が，中央流路に遊走した様子が観察された．HPF

が中央流路に遊走した一方で，GFP-HUVEC は中央流路にはほとんど遊走しなかった．
培養 7 日目では，GFP-HUVEC の一部が中央流路に遊走した様子が観察されたが，培
養 8 日目の時点で既に，GFP-HUVEC は中央流路に残存していなかった．培養 7 日目
および培養 14 日目の観察から，培地灌流を行っていた上部流路側のゲルの方向に対し
て，GFP-HUVEC が含まれるスフェロイドから血管内皮細胞が遊走することが分かっ
た．また，培地灌流を行う流路を下部流路に切り替えてから 6 日間が経過した培養 20
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図 3.15 上部流路および下部流路への培地灌流ありの条件におけるスフェロイドからの血管新
生．点線の円は血管内皮細胞が遊走した領域．培養 14 日目まで上部流路に培地灌流し，培養
14 日目からは下部流路への培地灌流に切り替えた．



 

図 3.16 上部流路および下部流路への培地灌流ありの条件におけるスフェロイドからの血管新
生．点線の円は血管内皮細胞が遊走した領域．培養 14 日目まで下部流路に培地灌流し，培養
14 日目からは上部流路への培地灌流に切り替え．

79



 

日目における結果から，今度は逆に，下部流路側のゲルに向かって血管新生が起きる
様子が観察された．これらの結果から，上部流路および下部流路への培地灌流によって，
培地灌流が行われている流路側の方向に向かってスフェロイドからの血管新生を含む
血管内皮細胞の遊走が誘引されることが示唆された．この原因としては，培地灌流に
よる豊富な酸素および栄養の供給が考えられる．
　前述した実験と同様にして，まず 14 日間，下部流路への培地灌流を行った後，培養
14 日目で，培地灌流を行う流路を上部流路に切り替えて，20 日目までさらに培養を続
けるという実験を行った．結果として，概ね前述したことと合致する様子が観察され
た（図 3.16）．以上で述べてきた結果をまとめると，中央流路への培地灌流では，血管
内皮細胞の遊走は中央流路ではなく両側のゲルの方向に偏り，上部流路および下部流
路への培地灌流では，培地灌流を行った流路の方向に血管新生を含む血管内皮細胞の
遊走が誘導されることが示唆された．

3.6　培地灌流による細胞の生存への効果

　本節では，中央流路への培地灌流による細胞の生存への効果を調べた．本実験では，
HUVEC（蛍光タンパク質の発現なし）：HPF：MCF-7 ＝ 1：3：1（5,000：15,000：5,000）
の条件で形成したスフェロイドを用いた．また，デバイスはゲル形成領域の長さが
500 µm のものを用いた．本実験における培地灌流は，3.5 節の手法により中央流路に
行い，外径 3 mm，内径 1 mm の太いシリコーンチューブを用いて，ペリスタポンプの
ダイヤルを「2.5」に合わせて行った．ペリスタポンプに複数のカセットを取り付けて
行ったため，カセットごとにばらつきは存在したが，送液流量は約 50 µL/ 分であった．
3.5 節と同じく，培養中は 2 日間ごとに培地チャンバ中の培地を 8 mL ずつ全量交換し，
4 日間ごとに培地用の液溜め中の培地を 20 mL ずつ全量交換しながら 15 日間の培養を
行った．明視野での観察から，灌流なしの静置培養を行った試料（図 3.17a）と灌流あ
りの培養を行った試料（図 3.17b）との間に複数の差異が見られた．まず，中央流路へ
の細胞の分布の広がりの違いから，灌流なしの試料では灌流ありの試料に比べ，中央
流路への細胞の遊走が少ないことが分かった．ただし，明視野像から得られる定性的
な情報として，中央流路の細胞が存在する部分の色の濃さから，灌流なしの試料の方
が，細胞が密集して存在していると推察される．また，中央流路の捕捉部と逆側への
細胞の分布を比較したところ，灌流なしの試料では中央流路の捕捉部と逆側の流路に
まで細胞が遊走しているのに対して，灌流ありの試料では細胞の遊走は比較的少ない
ことが分かった．これらの結果から，中央流路への培地灌流によって，培地灌流の流
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図 3.17 培養時の試料．(a) 培地灌流なし．(b) 培地灌流あり .
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れの下流方向に細胞の分布が移行することが示唆された．これは，培地灌流によって
中央流路への酸素や栄養の供給がなされたためであると考えられる．また，培地灌流
によって一部の細胞が洗い流されことで，細胞の密集が緩和されたと考えられる．さ
らに，ゲルを観察したころ，灌流なしの試料ではゲル内にも細胞が遊走されたが，灌
流ありの試料ではゲル内に遊走した細胞が少なかった．これは，通常の状態ではゲル
が細胞の足場となり，ゲルへの細胞の遊走が起きやすいが，培地灌流によって中央流
路への酸素や栄養の供給が増進されると，細胞が中央流路側に遊走されやすくなるた
めだと考えられる．
　続いて，細胞の生存を調べるために，LIVE/DEAD® アッセイキット（Thermo Fisher 

Scientific Inc.）を用いて生死判定染色を行った．LIVE/DEAD® アッセイキットには，
カルセイン -AM とエチジウムホモダイマー -1 が含まれる．カルセイン -AM は，生細
胞の細胞質に入り込み，エステラーゼ活性によって加水分解されることで，膜不透過
性のカルセインとなり，緑色の蛍光を示す．また，エチジウムホモダイマー -1 は，膜
損傷部分から死細胞の内部に透過し，核内の DNA に入り込んで赤色の蛍光を示す．
10 mL の FBS 無添加の DMEM に 10 µL のカルセイン -AM，5 µL のエチジウムホモダ
イマー -1 を加えて溶解させ，生死染色液を調製した．具体的な染色の手順としては，
培養した試料の培地チャンバから培地を除去し，PBS(-) を用いて 2 回洗浄した後に，
生死染色液を各流路に導入し，30 分間インキュベータ内に静置した．中央流路におけ
る細胞の生死の観察の結果，灌流なしの試料では細胞の生死の状態が混在しており，
特にスフェロイドの周囲やゲル形成領域の壁面近くでは死細胞が多い状態だった（図
3.18a）．しかし，灌流ありの試料では送液口に近い方の細胞についてはほとんどが生
細胞であり，死細胞が比較的多いのはスフェロイドの周囲のみだった．さらに，灌流
ありの試料では，中央流路の捕捉部側の送液口の周囲にも死細胞がやや集まっていた
（図 3.18b）．これらの結果から，培地灌流を行うことで，酸素や栄養が供給され，細胞
が生存しやすくなったことが示唆された．また，前述した細胞の密集度の結果と総合
して，培地灌流によって死細胞が洗い流され，それによって細胞の密集度が緩和され
るとともに，生存している細胞の割合が高くなることが示唆された．さらに，ゲル内
の細胞を観察したところ，灌流ありの試料では生細胞も死細胞もほとんど存在しない
様子が観察された．これは，前述した明視野での結果とも合致している．
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3.7　結言

　本章では，本デバイスを用いて，血管内皮細胞と線維芽細胞からなるスフェロイド
および血管内皮細胞の培養を行うことで，管腔構造や分岐形状を有する新生血管の形
成や血管内皮細胞の遊走が起きることを確認し，本デバイスがそれらの培養や観察に
利用可能であることを示した．また，本デバイスにスフェロイドを捕捉し，ゲルを介

図 3.18 生死染色した試料．(a) 培地灌流なし，(b) 培地灌流あり .
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した逆側に血管内皮細胞を播種して培養し，さらにマイクロビーズの送液を確認する
ことによって，ゲル内部を横断して送液可能な新生血管が形成されることが示唆され
た．さらに，本デバイスを用いた応用として，培地灌流を伴う培養を行った．各流路
への培地灌流による内皮細胞の遊走への効果は，培地灌流を行う流路によって異なり，
中央流路への培地灌流では，中央流路への血管内皮細胞の遊走が減少したが，上部流
路および下部流路への培地灌流では，培地灌流がなされた方向に血管内皮細胞の遊走
が起きることが示唆された．さらに，中央流路への培地灌流は，デバイス内の細胞の
生存を高める効果を有することが示唆された．
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第 ４ 章 　
二 方 向 へ の 生 化 学 物 質 の 　
濃 度 勾 配 下 に お け る 培 養

4.1　緒言

　本章では，本デバイスを用いて二方向から増殖因子や血管新生を促進する化学物質
を導入し，その条件下で血管内皮細胞と線維芽細胞からなるスフェロイドの培養を行
うことで，血管内皮細胞のゲルへのスプラウト領域の面積や方向といった遊走性への
効果を定量評価できることを示す．具体的には，まず，片側の流路に基本培地を，も
う片側の流路に異なる増殖因子や血管新生を促進する化学物質を加えた基本培地を流
し，スフェロイドを培養することで，本デバイスが様々な増殖因子や化学物質の効果
を調べるために利用可能であることを示す．次に，増殖因子として代表的な VEGF を
用いて，片側の流路に基本培地を，もう片側の流路に濃度の異なる VEGF を加えた基
本培地を流し，スフェロイドを培養することで，本デバイスが異なる濃度に対応した
効果の差異を定量的に評価可能であることを示す．最後に，両側の流路にそれぞれ異
なる濃度の VEGF を加えた基本培地を流し，スフェロイドを培養することで，本デバ
イスが二方向に異なる濃度の増殖因子や化学物質が存在した時の各方向での効果やそ
の差異を定量的に評価可能であることを示す．
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4.2　本実験の培養手法および血管内皮細胞の遊走性の定量解析手法

4.2.1　本章の実験の培養手法
　本節では，本章の実験の培養手法について記載するとともに，血管内皮細胞の遊走
性の定量評価のための解析手法について記載する．
　本章の実験では，本デバイスの上部流路および下部流路に対して，増殖因子や化学
物質等の異なる生化学物質を添加した培地を加えてスフェロイドを培養することで，
様々な生化学物質による血管内皮細胞の遊走性への効果を調べる．そこで，まず生化
学物質を添加するための基本となる培地を調製した．本章の実験では 2 種類の培地を
用いた．一つ目は，EGM-2 培地から VEGF を抜き，ペニシリン / ストレプトマイシン
を加えた培地，つまり EBM に，2%（v/v）FBS，ヒドロコルチゾン，FGF-2，IGF-1，
EGF，ゲンタマイシン / アンホテリシン -B，ヘパリン，1%（v/v）ペニシリン / スト
レプトマイシンが添加された培地（基本培地 A）を用いた．この基本培地 A は，血管
新生や血管内皮細胞の遊走に関わる種々の生化学物質が混在しているため，生体内の
複雑な環境を模倣し，そのような複雑な環境下での生化学物質の効果を見るために用
いた．また，二つ目の培地として，EGM-2 培地の基礎培地である EMB に，2%（v/v）
FBS と 1%（v/v）ペニシリン / ストレプトマイシンのみが添加された培地（基本培地 B）
を用いた．この基本培地 B は，EGM-2 培地にキットとして含まれる種々の生化学物質
が排除されたことにより，血管新生や血管内皮細胞の遊走への効果が低減されている．
そのため，培地に添加される生化学物質による血管新生や血管内皮細胞の遊走への効
果をより純粋に見るために用いた．
　次に，本実験で用いた生化学物質について記載する．増殖因子としては，血管内皮
増殖因子（vascular endothelial growth factor-A165，VEGF-A165），ホルボール 12- ミリ
スタート 13- アセタート（phorbol 12-myristate 13-acetate，PMA），スフィンゴシン -1-

リン酸（sphingosine-1-phosphate，S1P），および単球走化性タンパク質 -1（monocyte 

chemoattractant protein-1，MCP-1）を用いた．また，化学物質として塩化コバルト（CoCl2）
を用いた．これらの生化学物質を，それぞれ基本培地 A および基本培地 B に添加する
ことで，添加培地を調製した．
　以下に詳細な実験の手順を記す．まず，本デバイスを用いて 2.3 節に記載した方法
でゲルを形成し，2.8 節に記載した方法でスフェロイドを捕捉して，一晩培養を行う
ことでスフェロイドとゲルを接着させた．本章の実験では，GFP-HUVEC：HPF ＝ 1：
4（5,000：20,000）の条件で形成したスフェロイドを使用した．次に，培養 1 日目の試



87

料の上部流路と下部流路の 4 箇所の送液口に，先端を切ったピペットチップを差し込
み，下部流路に差し込まれたピペットチップおよび上部流路に差し込まれたピペット
チップに基本培地または添加培地を，それぞれ各流路ごとに 200 µL ずつになるよう加
えた（図 4.1）．ピペットチップ内の培地は，1 日ごとに 200 µL ずつ全量を交換したが，
その際には，各流路に差し込まれた 2 本のピペットチップの両方から培地を吸い取り，
片方のピペットチップのみに 200 µL の培地を加えることで，実質的に各流路ごとへの
培地供給量が 1 日当たり 200 µL になるようにした．このように 200 µL の培地を毎日
交換することによって，24 時間ごとに上部流路および下部流路内の培地の生化学物質
の濃度が更新され，また静水圧によってゲルを通って中央流路に向かう方向への間質
流が誘導されることにより，2.14 節で示唆された通り，上部流路および下部流路内の
生化学物質の濃度が維持されると考えた．さらに，デバイスの培養チャンバには 4 mL

の基本培地 A を加え，2 日ごとに 4 mL ずつ全量を培地交換した．中央流路は培地チャ
ンバに接続されているため，内部の生化学物質の濃度は培地交換ごとに供給された新
鮮な基本培地 A または基本培地 B によってある程度は初期化されると考えられる．こ
れにより，ゲルや中央流路に生化学物質の濃度勾配が形成され，24 時間以内にゲル内
の全領域がそれぞれの流路に加えられた添加培地の濃度と等しくなるというサイクル
が作られ，それが 24 時間ごとに繰り返されるという培養条件が構築されると考えられ
る．以上述べた系を用いて，スフェロイドから両側のゲルへの内皮細胞の遊走を観察
した．本実験では，血管新生のみならず，血管新生に似ているが管腔形成を伴わない
血管内皮細胞の遊走等が観察された．そこで以下では，血管新生を含め血管内皮細胞

培地 A

培地 B

スフェロイド

スプラウト

ECMゲル

スプラウト
の伸長

化学勾配 B

化学勾配 B

培地チャンバ

ピペットチップ

図 4.1 二方向への生化学物質の濃度勾配下における培養の概要図（図 1.1 の再掲）.
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の遊走の結果として生じた形跡を，まとめて「スプラウト」と呼称することとした．
倒立顕微鏡を使用して，培養 1 日目，培養 3 日目，培養 5 日目，および培養 7 日目の
血管内皮細胞の遊走を明視野および蛍光で観察した．培養 3 日目，培養 5 日目，培養
7 日目の蛍光像から，それぞれ上部流路側および下部流路側のゲルの方向への血管内
皮細胞のスプラウト領域（蛍光領域）の面積を，培養 1 日目，培養 3 日目，培養 5 日目，
培養 7 日目の蛍光像から，それぞれ上部流路側および下部流路側のゲルの方向への血
管内皮細胞のスプラウトの伸長長さ（最長到達距離）を測定した．これらの画像解析
には Fiji ソフトウェアを使用した．以下に項にそれぞれのデータの解析手法を記載す
る．
　
4.2.2　血管内皮細胞のスプラウト領域の面積の解析
　血管内皮細胞のスプラウト領域の面積については，まず，Fiji ソフトウェア上に，解
析したい試料の蛍光像を開き，Analyze > Set Scale により，画像のスケールを設定した．
続いて，Image > Type > 8-bit で，画像を 8-bit 形式に変換した．次に，Image > Adjust > 

Threshld で，Default 方式，B&W 方式にて，20–255 に閾値を設定し，画像を二値化した．
ここで，解析したい試料の蛍光像と同一の視野範囲で撮像した明視野像を Fiji ソフト
ウェア上で開き，Image > Type > 8-bit で，8-bit 形式に画像を変換した．Image > Stack 

> Images to Stack で，明視野像と二値化した蛍光像の 2 枚の画像をスタックした．これ
により，明視野像で試料の中央流路の位置を確認し，表示画像を切り替えることで，
確認した位置の蛍光像における位置を見ることが可能である．Toolbar の Line Selection 

Tools から Straight Line を選択し，明視野像の中央流路の壁面の位置に沿って，Shift

キーを押しながら線分を引いた．この時，中央流路の捕捉部側の壁面だけでなく，ス
フェロイド捕捉部を越えて逆側の壁面まで通るように線分の位置を指定した．ここで，
表示画像を蛍光像に変更することにより，蛍光像に対して流路壁面の位置に線分が引
かれた状態になる．Analyze > Tools > ROI Manager で起動した ROI Manager を用いて，
Add によりこの線分の領域を ROI として定めた．この作業を中央流路の両壁面に対し
て行った．これら 2箇所のROIにおいて，ROI Managerで，More > Fillをすることにより，
二値化した蛍光像の黒の領域が，中央流路の壁面の位置で 3 つ（試料によってはさら
に多く）の領域に分断された（図 4.2a）．そこで，Image > Stack > Stack to Images により，
スタックしていた明視野像と蛍光像を再び独立した画像に分けた．明視野像は，中央
流路の壁面の位置を確認するために用いるだけなので，この時点で Fiji ソフトウェア
から画像を閉じた．最後に，蛍光像を選択し，Analyze > Analyze Particle により，分析
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を行った．範囲の指定では，Area(unit^2): 1000-Infinity，Roundness: 0–1 の条件を用い，
Outline を表示する設定で分析を行った．結果として，条件に合った領域が画像で表示
され，それぞれの領域の面積が csv ファイルとして得られた（図 4.2b）．以上述べてき
た手法により，全ての試料の画像を解析し，得られた面積の値を Excel 上で整理して，
各条件で培養した結果として得られた，培養日数と上部流路側および下部流路側のゲ
ルのそれぞれの方向への血管内皮細胞のスプラウト領域の面積との関係を表すグラフ
を作成した．
　本解析手法により，概ね血管内皮細胞の遊走の動向を調べることが可能である．一
方で，本解析手法には欠点も存在する．まず一つ目の欠点は，個々の血管内皮細胞の
遊走に大きな違いがあった場合に，大きく遊走した細胞群による面積をスプラウト領
域の面積の値に反映できない点である．本解析手法では，最終的には Analyze Particle

によって，連続した血管内皮細胞の蛍光領域をスプラウト領域の面積として算出して
いる．従って，血管新生やそれに近いが管腔形成はなされていない血管新生様のスプ
ラウト，つまり細胞同士が協調的に遊走した試料においては，遊走の現象を反映した
計測結果を得ることが可能である．しかし，個々の細胞の遊走性が大きい試料におい
ては，蛍光像を二値化した際に，蛍光が一定以上の強度を有していた領域（図 4.2a に
おける黒い領域）が疎らに表示されることが多く見受けられる．このような場合，最
終的な Analyze Particle の処理を施した際に，検出される領域が分断されてしまい，デー
タに反映されない．本解析手法の二つ目の欠点は，実際には血管内皮細胞が存在して
いないにもかかわらず，血管内皮細胞のスプラウト領域の面積に含まれてしまう領域

(a) (b)

図 4.2 Fiji ソフトウェアによる血管内皮細胞のスプラウト領域の面積の計測時における画像
処理．(a) 二値化処理後の画像，(b) Analyze Particles 処理後の画像．
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が存在する点である．Analyze Particle によって検出される領域は，黒い領域で囲われ
た面積全体を反映してしまう．そのため，ある領域において，周縁部を血管内皮細胞
が覆うように存在しているが，中央部には血管内皮細胞が存在しない状態だった場合
に，画像を二値化して Analyze Particle によって領域を検出してしまうと，中央部も領
域の一部として周縁部と一緒くたに検出されてしまい，面積の値にも中央部の面積が
反映されてしまう．三つ目の欠点は，血管内皮細胞の三次元的な遊走をデータに反映
できない点である．本解析手法では，蛍光像を二値化によって処理してしまうため，
ある一定の蛍光強度を持つ領域は，血管内皮細胞が遊走した領域として全て同等の値
として扱われる．しかし，現実には，ゲル形成領域の高さは 400 µm あり，スフェロイ
ドからゲルの方向へと伸長する新生血管や遊走する内皮細胞は，平面ではなく三次元
的な空間情報を有している．本実験の手法では，倒立型の蛍光顕微鏡を用いて試料を
撮像しているため，このような三次元的な情報の一部は失われてしまう．しかし，蛍
光強度のデータには平面上の同位置に存在していた個々の血管内皮細胞の蛍光の強度
だけではなく，その立体的な重ね合わせによる蛍光強度の増強が反映されている．そ
のため，画像を二値化するのではなく，蛍光強度の分布を計測することによって，よ
り三次元的な内皮細胞の遊走に関する情報を失うことなく解析結果に反映することが
できる可能性がある．

4.2.3　血管新生様のスプラウトの伸長長さの解析
　続いて，スフェロイドからのスプラウトの伸長長さの解析手法を記す．まず，Fiji

ソフトウェア上で，計測したい試料の明視野像と蛍光像を開いた．この時に，それぞ
れの画像は共に同一の試料の同一の視野範囲で撮像したものを用いた．次に，Analyze 

> Set Scale で画像のスケールを設定し，さらに Image > Stack > Images to Stack で，明
視野像と蛍光像をスタックした．これにより，明視野像で中央流路の中央位置を規定
することができる．その中央位置を基準にして，上部流路側および下部流路側のそれ
ぞれのゲルの方向に向かって伸長した，スプラウトの最長到達距離を計測すること
が可能である．操作としては，Toolbar の Line Selection Tools から Straight Line を選択
し，明視野像の中央流路の中央位置を，捕捉部の狭窄した流路の位置を参考にして見
つけ出し，その中央位置を通り中央流路と平行な直線上に端点を取り，Shift キーを
押しながらその直線と直行する線分を引いた．続いて，表示画像を蛍光像に切り替
え，スプラウトの末端をもう片側の端点として指定し線分を取り直した．Analyze > 

Measurement により，線分の長さを csv 形式のデータとして得た．この作業を上部流路



 91

側と下部流路側の両方向に対して行った．本解析手法では，スプラウトに対して，そ
の x 軸方向への伸長長さをデータとして得ている．従って，斜めに伸長したスプラウ
トの長さを正確に反映したデータを得た訳ではない．逆に，「中央流路からどれくらい
上部流路および下部流路の方向へとスプラウトが到達できたか」という単純化された
データを得ることができ，大きさとしてのスプラウトの伸長の程度を比較考察するた
めに役立つと考えられる．スプラウトの伸長の大きさと方向性が組み合わされた情報
を考えた時に，本デバイスの系における方向性の情報は既に，上部流路側の方向かあ
るいは下部流路側の方向かの 2 方向として定めることができている．従って，本解析
手法のように各流路側の方向それぞれにおける大きさのデータを得ることは，種々の
生化学物質による血管新生や血管内皮細胞の遊走への効果を考察する際に必要十分で
あると考えられる．
　以上述べた通り，本解析手法により，スプラウトの伸長に関するデータを得ること
ができるが，この解析手法にも欠点が考えられる．それは，各試料の内一つのスプラ
ウトについての情報のみが反映されたデータしか得られない点である．本解析手法で
は，代表的な一つのスプラウトに注目して，伸長長さを最長到達距離から測定している．
そのため，例えば試料中に複数本のスプラウトが含まれていた場合に，それぞれのス
プラウトの平均的な伸長に関する情報が失われてしまう．また，それに関連して，ス
プラウトの密度や本数等の情報も失われてしまう．そのため，試料中での複数のスプ
ラウトの間の伸長長さに大きな差が見られる場合は，データが現象とはかなり異なる
情報を与えてしまう危険性があると考えられる．ただし，スプラウトの密度については，
4.2.2. 項に述べた血管内皮細胞のスプラウト領域の面積の結果と総合することで，その
情報をある程度反映したデータが得られると考えられる．
　なお，本実験における血管新生様のスプラウトの伸長長さの計測にあたって
は，既存研究等で用いられている Analyzeskeleton (http://fiji.sc/AnalyzeSkeleton) や，
Angiogenesis Analyzer for ImageJ [98] といった Fiji ソフトウェアにもプリセットで搭載
されている，あるいは搭載可能なプラグインを用いる手法や，Matlab を用いた解析
[99] も検討したが，以下の理由からこれらの手法を本実験に適用することが難しかっ
た．まず，本実験では必ずしも血管新生が起こる訳ではなく，単なる血管内皮細胞の
遊走が起きる場合も多く存在するためである．上記のプラグインでは，血管の形状を
検出して分析を行うが，血管新生ではない単なる血管内皮細胞の遊走が起きた試料で
は，血管の形状が生じる代わりに，血管内皮細胞がゲル内の一面に広がるように遊走
することがあり，プラグインによって血管の形状を検出することができなかった．ま
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た，もう一つの理由として，4.2.1. 項でも述べた通り，新生血管が生じたとしても，ゲ
ルの高さ方向の厚みが 400 µ ｍと厚いので，新生血管が重なるように形成されるため，
プラグインでの検出が機能しなかったことも挙げられる．

4.3　片側に異なる生化学物質を加えた場合の遊走性への効果

　本節では，本デバイスの片側の流路に基本培地を，もう片側の流路に増殖因子や化
学物質等の異なる生化学物質を加えた基本培地を流し，スフェロイドを培養すること
で，様々な増殖因子や化学物質による血管内皮細胞の遊走性への効果を調べた．本
節の実験では，基本培地 A に，S1P を 500 nM，CoCl2 を 100 µM，PMA を 50 ng/mL，
VEGF-A165 を 50 ng/mL の濃度になるようにそれぞれ添加し，それぞれの添加培地を，
S1P(+) 培地，CoCl2(+) 培地，PMA(+) 培地，および VEGF(+) 培地と定義して用いた．
まず陰性対照条件として，上部流路および下部流路の両方に基本培地 A を加えて培養
を行った（図 4.3）．結果として，上部流路側と下部流路側の両方向に向かって血管新
生が生じた様子が観察された（図 4.3a）．二つのグラフから，培養日数が経過するにつ
れて血管内皮細胞のスプラウト領域の面積およびスプラウトの伸長長さが共に増大す
ることが分かった（図 4.3b,c）さらに，これらの上部流路側および下部流路側の方向
への遊走は，画像およびグラフからほとんど均等に行われることが分かった．これは，
基本培地 A に含まれる FGF-2 や IGF によって，血管内皮細胞の増殖や血管新生が促進
されたことによるものだと考えられる [100,101]．また，本研究の培養法では培地の静
水圧が生じているため，間質流（interstitial flow）による影響もあると考えられる [83,91]．
間質流は，生体においては間質液の流れのことを指し，例えば，毛細血管から漏れ出
した血液の血漿成分が ECM を通ってリンパ管に流れ込む際に生じる流れである．本
デバイスでは，上部流路および下部流路に印加された静水圧と，ゲルを挟んで反対側
にある中央流路における静水圧との圧力勾配によって，上部流路および下部流路から
中央流路に向かう培地の流れがゲル中に形成されていると考えられる．
　同様に下部流路に基本培地 A を，上部流路に S1P(+) 培地を加えた条件においても，
上部流路と下部流路の両方向に向かって血管新生が起きた（図 4.4）．血管内皮細胞の
スプラウト領域の面積を比較した結果，下部流路に基本培地 A を，上部流路に S1P(+)

培地を加えた条件では，上部流路および下部流路の両方に基本培地 A を加えた条件よ
りも，血管内皮細胞のスプラウト領域の面積とスプラウトの伸長長さが共に増大する
ことが分かった．特に，血管内皮細胞のスプラウト領域の面積は，ダネットの検定の
結果から，有意に大きくなった．S1P は過剰な芽生えを抑制することで血管叢を安定
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化することや [10,11]，血管内皮細胞で覆った流路からの，個々の細胞の走化性運動を
促進することが過去の報告から明らかにされてきた [6]．本実験の結果では，個々の細
胞の遊走ではなく，むしろ集団的で協調的な血管内皮細胞の遊走が生じ，多数の細胞
からなる長いスプラウトが形成された．この結果から，基本培地 A に含まれる FGF-2
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図 4.3 上部流路および下部流路の両方に基本培地 A を加えた条件での培養結果．(a) 培養 1

日目，培養 3 日目，培養 5 日目，培養 7 日目における GFP-HUVEC の蛍光像，(b) 血管内皮細
胞のスプラウト領域の面積，n = 3，mean±s.e.，(c) スプラウトの伸長長さ．n = 3，mean±s.e.
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や IGF 等の血管新生促進因子と S1P が協調して働くことで，血管を安定化しながら伸
長に寄与したことが示唆された．さらに，S1P を含む培地を上部流路から作用させた
にもかかわらず，上部流路と下部流路の両方向に対して血管がほぼ同じ長さと面積ず
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図 4.4 下部流路に基本培地 A を上部流路に S1P(+) 培地を加えた条件での培養結果．(a) 培養
1 日目，培養 3 日目，培養 5 日目，培養 7 日目における GFP-HUVEC の蛍光像，(b) 血管内皮
細胞のスプラウト領域の面積，n = 3，mean±s.e.，(c) スプラウトの伸長長さ．n = 3，mean±s.e.
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つ伸長した．この結果から，S1P による S1P1 受容体の活性化が，濃度勾配による影響
を介さないことが示唆された．即ち，S1P は方向性のある遊走（走化性，chemotacsis）
ではなくランダムな遊走（ケモキネシス，chemokinesis）を誘導することが示唆された．
また，S1P は，血小板が凝集する際に大量に細胞外に放出されるため，血清中にも豊
富に含まれている．既存の報告での値から計算すると，本実験で使用した基本培地 A

には，2%（v/v）FBS 由来の S1P が 40 nM 程度の濃度でもともと含まれていると考え
られる [102]．したがって，基本培地 A と S1P(+) 培地との間における S1P 濃度の差は，
40 nM と 540 nM の差だということになり，S1P による血管内皮細胞の遊走性への効果
は，比較的には S1P(+) 培地により多く期待されるが，基本培地 A もその効果が全く無
い訳ではないことが推察される．
　下部流路に基本培地 A を，上部流路に CoCl2(+) 培地を加えた条件では，上部流路
および下部流路の両方に基本培地 A を加えて培養を行った条件と比較して，スプラウ
トの伸長長さは同程度だったが，血管内皮細胞のスプラウト領域の面積はより広かっ
た（図 4.5）．この結果は新生血管が密に芽生えていることからも観察される．ただ
し，ダネットの検定による比較を行った結果，両側 5％の有意水準を適用すると統計
的に有意な差は見られなかった．CoCl2 は，HIF1- αの安定化を促すことで，低酸素シ
グナル伝達を活性化することが知られている [103]．HIF1- αは VEGF 等の血管新生を
媒介する遺伝子の発現を調節する機能を持つ．例えば過去の報告では，Bone Marrow 

Mesenchymal Stem Cells と HUVEC を用いて，CoCl2 による VEGF とヴォン・ヴィレブ
ランド因子（von Willebrand factor，VWF）の発現の向上が確認された [15]．本研究に
おいても，作用機序は不明確ではあるが，CoCl2 の媒介により血管新生の密度がやや
増加したことが示唆された．また，CoCl2 を含む培地を上部流路から作用させたにも
かかわらず，上部流路と下部流路の両方向に対してスプラウトの伸長長さも血管内皮
細胞のスプラウト領域の面積もほぼ同程度に増加した．この結果から，CoCl2 はケモ
キネシス様の効果を有する可能性が示唆された．CoCl2 は，VEGF のように直接的に血
管新生を誘導するのではなく，間接的に血管新生や血管内皮細胞の遊走に効果を及ぼ
すため，応答に即時性がなく，濃度勾配の効果が消失するためであることも，本結果
が得られた原因の一つであると考えられる．
　一方で下部流路に基本培地 A を，上部流路に PMA(+) 培地を加えた条件では，
PMA(+) 培地を加えた上部流路の方向に向かって細く長い形状のスプラウトが形成さ
れた（図 4.6）．この結果は，上部流路側および下部流路側の各方向への血管内皮細胞
のスプラウト領域の面積およびスプラウトの伸長長さを示したグラフにおいて，どち
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らの値も上部流路側の方が高くなっていることからも分かる（図 4.6b,c）．スチューデ
ントの t 検定から両側 5% の有意水準を適用すると，培養 7 日目の上部流路側および
下部流路側の各方向への血管内皮細胞のスプラウト領域の面積および培養 5 日目のス
プラウトの伸長長さにおいて，統計的に有意な差があることが分かった．この結果を，E-02
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図 4.5 下部流路に基本培地 A を上部流路に CoCl  2(+) 培地を加えた条件での培養結果．(a) 

培養 1 日目，培養 3 日目，培養 5 日目，培養 7 日目における GFP-HUVEC の蛍光像，(b) 血
管内皮細胞のスプラウト領域の面積．n = 3，mean±s.e.，(c) スプラウトの伸長長さ．n = 3，
mean±s.e.
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本節でこれまで述べてきた陰性対照条件，S1P(+) 培地を用いた条件，および CoCl2(+)

培地を用いた条件と比較すると，PMA(+) 培地を用いた条件において，上部流路側へ
の血管内皮細胞の遊走が増大したとは言えない．PMA(+) 培地を用いた条件におけるD-01
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図 4.6 下部流路に基本培地 A を上部流路に PMA(+) 培地を加えた条件での培養結果．(a) 

培養 1 日目，培養 3 日目，培養 5 日目，培養 7 日目における GFP-HUVEC の蛍光像，(b) 血
管内皮細胞のスプラウト領域の面積．n = 3，mean±s.e.，(c) スプラウトの伸長長さ．n = 3，
mean±s.e.
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特徴は，むしろ下部流路側への血管内皮細胞の遊走が減少した点にある可能性がある．
それにより，相対的に上部流路側への血管内皮細胞の遊走が大きくなったと考えられ
る．既存の報告から，PMA は protein kinase C α（PKC α）を活性化し，さらに PKC

αが VEGF 等の誘導を介して血管新生を誘導することが知られている [104,105]．本研
究の結果は，PMA が血管内皮細胞の遊走の方向に影響を及ぼすことを示唆している．
これらの結果は，本実験の条件である 50 ng/mL の PMA による血管内皮細胞の遊走へ
の効果が，基本培地 A に含まれる FGF- βや IGF よりも優先して血管新生を誘導する
ことを示唆している．
　下部流路に基本培地 A を，上部流路に MCP-1(+) 培地を加えた条件では，上部流路
側と下部流路側の両方向への血管内皮細胞の遊走が減少した（図 4.7）．多くの既存の
報告の中で，MCP-1 は不明な作用機序によって血管新生を促進することが述べられて
きた．ただし，微小流体デバイスを用いて血管新生を評価した先行研究においては，
MCP-1 を単独で用いた場合（当該研究では 75 ng/mL の濃度条件）には顕著な血管新
生への影響は得られないことが示されていた [6]．本研究の結果ではさらに，原因は不
明瞭であるが，MCP-1 を含む培地では FGF- βや IGF といった血管内皮細胞の遊走を
促進する生化学物質および間質流の存在下であっても，血管内皮細胞の遊走が減少す
ることが示唆された．本結果では，上部流路側および下部流路側の両方向への遊走が
減少したが，上部流路側への血管内皮細胞の遊走の方が下部流路側よりはやや大きい
ことが画像およびグラフから分かった．ただし，これらの差には統計的な有意差が無
いことがスチューデントの t 検定から明らかになっている．MCP-1 の濃度についてさ
らに比較考察を行ったところ，ある既存の報告において，MCP-1 を添加した培地で rat 

aortic ring assay（ラットの胸部大動脈を用いた ex vivo の血管新生能評価）を行うと，
MCP-1 を 10 ng/mL の濃度条件で用いると有意な効果を示すが，100 ng/mL の濃度条件
で用いると効果が減少することが報告されていた [106]．本研究においても，低濃度で
の MCP-1 を用いることで血管新生および血管内皮細胞の遊走への効果が表れる可能性
が予想されるため，さらなる条件の検討が今後の課題だと考えられる．
　最後に，下部流路に基本培地 A を，上部流路に VEGF(+) 培地を加えた条件で培養を
行った（図 4.8）．結果として，血管内皮細胞のスプラウト領域の面積およびスプラウ
トの伸長長さが，どちらも下部流路側の方向よりも上部流路側の方向に対して大きく
なった．両側5%を有意水準としてスチューデントの t検定を行ったところ，培養3日目，
培養 5 日目，および培養 7 日目における血管内皮細胞のスプラウト領域の面積と，培
養 5 日目，および培養 7 日目におけるスプラウトの伸長長さについて，上部流路側の
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値には下部流路側の値に対して統計的に有意な差があることが分かった．また，血管
内皮細胞のスプラウト領域の面積およびスプラウトの伸長長さのいずれの値も，培養
日数を経るごとに増大した．その結果，本条件での培養 7 日目における上部流路側へG-05

(a)

(b) (c)

0

5

10

15

20

25

3 5 7Sp
ro

ut
 A

re
a 

[×
10

4  µ
m

2 ]

Culture Day [d]

Lower
(MCP-1(-))

Upper
(MCP-1(+)) Lower

(MCP-1(-))
Upper

(MCP-1(+))

0
200
400
600
800

1000
1200

1 3 5 7Sp
ro

ut
 le

ng
th

 [µ
m

]

Culture Day [d]

Day 01

Day 01 Day 03 Day 05 Day 07

Day 03 Day 05 Day 07

100 µm

図 4.7 下部流路に基本培地 A を上部流路に MCP-1(+) 培地を加えた条件での培養結果．(a) 

培養 1 日目，培養 3 日目，培養 5 日目，培養 7 日目における GFP-HUVEC の蛍光像，(b) 血
管内皮細胞のスプラウト領域の面積，n = 3，mean±s.e.，(c) スプラウトの伸長長さ．n = 3，
mean±s.e.
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の血管内皮細胞のスプラウト領域の面積およびスプラウトの伸長長さの値は，陰性対
照条件でのそれらの値よりも大きくなった．その値は，両側 5% を有意水準としたダ
ネットの検定により，統計的に有意な差を有していることが分かった．これらの結果
から，VEGF は強力な走化性能を有することが示唆された．B-02
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図 4.8 下部流路に基本培地 A を上部流路に VEGF(+) 培地を加えた条件での培養結果．(a) 

培養 1 日目，培養 3 日目，培養 5 日目，培養 7 日目における GFP-HUVEC の蛍光像，(b) 血
管内皮細胞のスプラウト領域の面積．n = 3，mean±s.e.，(c) スプラウトの伸長長さ．n = 3，
mean±s.e.
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　以下に，本節の実験の結果をまとめた（図 4.9）．
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図 4.9 下部流路に基本培地 A を上部流路に各種の添加培地を加えた条件での培養結果．(a) 

培養 7 日目における各条件での GFP-HUVEC の蛍光像，(b) 培養 7 日目における血管内皮細胞
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4.4　片側に異なる濃度の VEGF を流した場合の遊走性への効果

　本節では，増殖因子として代表的な VEGF を用いて，本デバイスの片側の流路に基
本培地 B を，もう片側の流路に濃度の異なる VEGF を加えた基本培地 B を加え，スフェ
ロイドを培養することで，異なる濃度の VEGF による血管内皮細胞の遊走性への効果
とその差異を調べた．本節では基本培地として，EBM に 2%（v/v）FBS と 1%（v/v）
ペニシリン / ストレプトマイシンが添加された培地（基本培地 B）を用いた．
様々な濃度の VEGF による血管新生および血管内皮細胞の遊走への効果を分析する
た め に，0，0.01，0.1，0.5，1，2，3，4，5，10，20，50，100 ng/mL の VEGF-A165

を，基本培地 B に添加し，それぞれ VEGF(0) 培地（基本培地 B と同じ），VEGF(0.01)

培地，VEGF(0.1) 培地，VEGF(0.5) 培地，VEGF(1) 培地，VEGF(2) 培地，VEGF(3) 培
地，VEGF(4) 培地，VEGF(5) 培地，VEGF(10) 培地，VEGF(20) 培地，VEGF(50) 培地，
VEGF(100) 培地と名付け，以降の実験で用いた．本実験では，僅かな VEGF の濃度差
による血管新生および血管内皮細胞の遊走に対する効果の違いを調べるため，EGM-2

培地に通常含まれる種々の生化学物質による血管内皮細胞の遊走への影響を可能な限
り排除したいと考えたため，添加物の少ない培地として基本培地 B を選択した．
　VEGF によるスフェロイドからの血管新生への影響を調べるために，下部流路から
基礎培地 B を，上部流路から様々な濃度の VEGF を含む培地を加えて，スフェロイド
を 7 日間培養した．まず，陰性対照として上部流路および下部流路の両方に基本培地
B を加えて培養を行った．結果として，上部流路側と下部流路側のどちらの方向にも
血管内皮細胞が遊走しなかった様子が蛍光像から観察された（図 4.10a）．二つのグラ
フからも同様に，血管新生および血管内皮細胞の遊走が起きなかったことが示唆され
た（図 4.10b,c）．これらの結果から，本実験に用いた基礎培地 B が，血管新生および
血管内皮細胞の遊走に対してほとんど効果を有さないことが示唆された．そのため，
基礎培地 B が，本節の実験において，添加物である VEGF のわずかな濃度の違いによ
る血管新生および血管内皮細胞の遊走への効果を見るための基礎培地として，望まし
いものであることが示された．さらに，この結果を 4.3 節の上部流路および下部流路
の両方に基本培地 A を加えて培養を行った結果と比較すると，4.3 節においてスフェ
ロイドから両側のゲル方向に血管新生が生じたのは，基本培地 A の成分と基本培地 B

の成分による差，つまり，FGF-2 や IGF といった種々の生化学物質による血管新生の
促進効果によるものであることが示唆された．スフェロイドの形状に関して，培養日
数を経るごとに，スフェロイドが徐々に二つのゲルとスフェロイドとの接着部を結ぶ
線分を長軸とする長球状になり，サイズが小さくなった様子も見られた．また，明視
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野像から，培養日数を経るごとに中央流路に死細胞と見られる浮遊した細胞群が増加
しており，これらの細胞の一部は蛍光を有していることが分かった．これらの結果から，
この条件においては，スフェロイドに含まれていた GFP-HUVEC および HPF の一部が，
接着性を失ったことでスフェロイド外に漏出したと考えられる．このことは，本実験V1-06
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図 4.10 上部流路および下部流路の両方に基本培地 B を加えた条件での培養結果．(a) 培養 1
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で用いた基本培地 B には，GFP-HUVEC および HPF の培養に際して，細胞間接着に必
要な因子等がやや不足していることを示唆している．また，明視野像から，二つのゲ
ルの方向への細胞の遊走が起きている様子が見られた．これらの細胞は，蛍光を発し
ていないことから，HPF だと考えられる．このことから，基礎培地 B のみを用いた培
養においても，HPF のゲル方向への遊走は起きることが示唆された．
　同様に，下部流路に基本培地 B を，上部流路に VEGF(0.01) 培地および VEGF(0.1)

培地を加えた条件での培養を行った．結果としては，先述した上部流路および下部流
路の両方に基本培地 B を加えた条件と殆ど変わらず，上部流路側と下部流路側のどち
らの方向にも血管新生が生じなかった（図 4.11a）．グラフの結果からは，僅かながら
基礎培地 B を加えた下部流路側よりも VEGF を添加した上部流路側への血管内皮細
胞の遊走およびスプラウトの伸長が大きかったことが分かった（図 4.11b,c）．ただし，
スプラウトと呼べるほどの明らかな血管内皮細胞による芽生えは観察されておらず，
あくまでスフェロイドの延長として GFP-HUVEC の先端の位置が，やや上部流路側に
偏っていたという結果が得られたのみである．また，統計的に有意な差は無く，誤差
を考えると，上部流路側および下部流路側への血管内皮細胞の遊走はどちらもほとん
ど等しく 0 に近い値だったと考えられる．これらの結果から，上部流路に加える培地
の VEGF 濃度が 0–0.1 ng/mL の範囲では，血管内皮細胞の遊走への影響はほとんど無
いことが示唆された．
　続いて，下部流路に基本培地 B を，上部流路に VEGF(1) 培地を加えた条件での培養
を行った．その結果，血管内皮細胞が上部流路側の方向に遊走した様子が観察された
（図 4.12a）．グラフの結果から，血管内皮細胞のスプラウト領域の面積およびスプラウ
トの伸長長さが，どちらも下部流路側の方向よりも上部流路側の方向に対して大きく
なったことが分かった（図 4.12b,c）．両側 5% を有意水準としてスチューデントの t 検
定を行ったところ，培養 3 日目，培養 5 日目，および培養 7 日目における血管内皮細
胞のスプラウト領域の面積とスプラウトの伸長長さについて，上部流路側の値には下
部流路側の値に対して統計的に有意な差があることが分かった．これらの結果から，
VEGF 濃度が 1 ng/mL の条件では，血管内皮細胞の遊走に対して促進効果があること
が示された．さらに，その効果は濃度勾配の方向に対して働くことから，走化性の効
果であることが示唆された．
　次に，下部流路に基本培地 B を，上部流路に VEGF(5) 培地を加えた条件で培養を行っ
た．その結果は，上述した下部流路に基本培地 B を，上部流路に VEGF(1) 培地を加え
た条件での培養とほとんど同じく，血管内皮細胞が上部流路側の方向に遊走した様子
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図 4.11 下部流路に基本培地 B を上部流路に VEGF(0.01) 培地を加えた条件での培養結果．(a) 

培養 1 日目，培養 3 日目，培養 5 日目，培養 7 日目における GFP-HUVEC の蛍光像，(b) 血管
内皮細胞のスプラウト領域の面積，(c) スプラウトの伸長長さ．(i) n = 3，(ii) n = 5，mean±s.e.
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が観察された（図 4.13a）．また，グラフの結果も，血管内皮細胞のスプラウト領域の
面積およびスプラウトの伸長長さが，どちらも培養 3 日目，培養 5 日目，および培養
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図 4.12 部流路に基本培地 B を上部流路に VEGF(1) 培地を加えた条件での培養結果．(a) 培養
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7 日目において，下部流路側の方向よりも上部流路側の方向に対して統計的に優位な
差をもって大きかったことが分かった（図 4.13b,c）．本実験の結果ではさらに，下部
流路側への血管内皮細胞のスプラウト領域の面積およびスプラウトの伸長長さが，培V2-04
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図 4.13 部流路に基本培地 B を上部流路に VEGF(5) 培地を加えた条件での培養結果．(a) 培養
1 日目，培養 3 日目，培養 5 日目，培養 7 日目における GFP-HUVEC の蛍光像，(b) 血管内皮
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養日数の経過に従って，減少したことが分かった．一方で，下部流路に基本培地 B を，
上部流路に VEGF(1) 培地を加えた条件では，下部流路側への血管内皮細胞のスプラウ
ト領域の面積およびスプラウトの伸長長さは，培養日数にかかわらずほぼ一定の値を
示していた．これらの結果から，VEGF の濃度が 1 ng/mL から 5 ng/mL に増大したこ
とによって，さらに血管内皮細胞に対する走化能が大きくなったことが示唆された．
　最後に，下部流路に基本培地 B を，上部流路に VEGF(10) 培地および VEGF(20) 培
地を加えた条件での培養を行った．その結果は，上述した上部流路に VEGF(1) 培地お
よび VEGF(5) 培地を加えた条件での結果と同様に，血管内皮細胞が上部流路側の方向
に遊走した様子が観察された（図 4.14a）．また，グラフの結果も，血管内皮細胞のス
プラウト領域の面積およびスプラウトの伸長長さが，どちらも培養 3 日目，培養 5 日
目，および培養 7 日目において，下部流路側の方向よりも上部流路側の方向に対して
統計的に優位な差をもって大きかったことが分かった（図 4.14b,c）．一方で，上部流
路に VEGF(10) 培地および VEGF(20) 培地を加えた条件では，ゲルの領域を超えて，上
部流路のガラス底面上にまで血管内皮細胞の遊走が起きた様子が観察された．さらに，
蛍光像の定性的な観察から，上部流路側のゲルの先端辺りにおいては，血管内皮細胞
の遊走が他の血管内皮細胞同士と協調的ではなくなり，個々の細胞がガラス底面上を
遊走したと考えられる．これらの結果から，VEGF の濃度が 10 ng/mL および 20 ng/mL

の条件では，血管内皮細胞の遊走性が増大し，かつその効果が生化学物質の存在する
流路に近くなるほどに増大することで，それぞれの血管内皮細胞の遊走が協調的な遊
走から，独立した個々の細胞による遊走に切り替わることが示唆された．
　以上の結果にさらに VEGF の濃度が 0.5 ng/mL，2 ng/mL，3 ng/mL，4 ng/mL，50 

ng/mL，および 100 ng/mL の条件での結果を加えてまとめると，図 4.15 のようになっ
た．結果として，VEGF 濃度が 0–0.1 ng/mL の範囲では，培養 7 日目における上部流
路の方向へのスプラウトの絶対的な伸長長さも短く，また上部流路と下部流路のそれ
ぞれの方向へのスプラウトの伸長長さの差も小さい．しかし，VEGF 濃度が 1–100 ng/

mL の範囲では，VEGF の濃度が大きくなるにつれて，培養 7 日目における上部流路
の方向へのスプラウトの伸長長さが長くなり，上部流路と下部流路のそれぞれの方向
へのスプラウトの伸長長さの差も大きくなった．この結果は，VEGF 濃度が 1–100 ng/

mL の範囲では，VEGF がスフェロイド内の GFP-HUCVEC に作用し，血管新生を誘導
し，遊走性を向上させたことを示している．また，各条件同士の比較において注目で
きる点として，血管内皮細胞のスプラウト領域の面積の解析において，VEGF の濃度
が 20 ng/mL の時のスプラウト領域の面積が，VEGF の濃度が 10 ng/mL の時のスプラ
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ウト領域の面積よりも小さくなったことが挙げられる（図 4.15b）．この理由は，4.2.2

項で述べた解析手法の一つ目の欠点を反映している．つまり，高濃度の VEGF による
GFP-HUVEC の遊走性の向上により，Analyze Particle の処理によって一続きのスプラ
ウトとして検出されないほど GFP-HUVEC が散り散りになって移動してしまい，GFP-

HUVEC が移動しすぎた領域は，解析時に分断され，データとして反映されなかった
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図 4.15 下部流路に基本培地 B を上部流路に各濃度の VEGF 培地を加えた条件での培養結果．
(a) 培養 7 日目における各条件での GFP-HUVEC の蛍光像，(b) 培養 7 日目における血管内皮細
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と考えられる．生体中における，健康な成人の血中に含まれる VEGF の濃度は，数十
から数百 pg のオーダーであることが既存の報告より明らかになっている [107–109]．
一方で，悪性腫瘍患者の血中 VEGF 濃度は，健康な成人の約 2 倍であり，さらに腫瘍
の間質中においては数 ng/mg から 10 ng/mL 程度の濃度範囲であることが調べられてき
た．こうした先行研究と比較したところ，本研究の結果は，1 ng/mL を超えた濃度か
ら統計的に有意な差をもって血管内皮細胞の遊走を促進する効果が見られており，ま
た生体中ではほとんど見られない 10 ng/mL 以上の高濃度においては，遊走への効果が
プラトーに達している傾向が見られた点で，生体の環境を反映した応答評価が可能で
あることが示唆された．

4.5　両側に異なる濃度の VEGF を流した場合の遊走性への効果

　本節では，本デバイスの両側の流路にそれぞれ異なる濃度の VEGF を加えた基本培
地を流し，スフェロイドを培養することで，二方向に異なる濃度の増殖因子や化学物
質が存在した時の各方向での血管内皮細胞の遊走性への効果やその差異を調べた．ま
ず，基本培地として，4.3 節と同じく，基本培地 A を用いて培養を行った．基本培地
A に 50 ng/mL および 100 ng/mL の VEGF を溶解した培地を調製し，それぞれ VEGF(+)

培地および VEGF(++) 培地と名付け，以降の実験で使用した．下部流路に VEGF(+) 培
地，上部流路におよび VEGF(++) 培地をそれぞれ導入し，スフェロイドの培養を 7 日
間行った．結果として，上部流路側および下部流路側の両方の方向に対して，血管内
皮細胞の遊走が起きた（図 4.16a）．グラフの結果からは，VEGF(+) 培地を導入した下
部流路側への方向の方が，VEGF(++) 培地を導入した上部流路側への方向よりも，血
管内皮細胞の遊走およびスプラウトの伸長が誤差の範囲で僅かながら大きかったこと
が分かった（図 4.16b,c）．一方で 4.3 節にて行った下部流路に基礎培地 B，上部流路に
VEGF(+) 培地をそれぞれ導入した条件の結果では，上部流路側のみに血管内皮細胞の
遊走が起きた様子が見られていた（図 4.8）．これらの結果から，両側に異なる濃度の
VEGF を導入した際には，VEGF による走化性能が二方向に対して働いたことが明ら
かになり，それ故に，本デバイスが二方向への生化学物質による血管内皮細胞の遊走
への効果を実現したことが示された．
　続いて，基本培地 B を用いて培養を行うことで，添加された生化学物質による遊走
への効果をより純粋に評価した．基本培地 B に 1 ng/mL，2 ng/mL，3 ng/mL，4 ng/mL，
5 ng/mL の濃度で VEGF を添加した培地を用意し，4.4 節に詳述した方法で，条件 1

（上部流路：2 ng/mL，下部流路：0 ng/mL），条件 2（上部流路：3 ng/mL，下部流路：1 
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ng/mL），条件 3（上部流路：4 ng/mL，下部流路：2 ng/mL），条件 4（上部流路：5 ng/

mL，下部流路：3 ng/mL）の 4 条件にて培養を行った（図 4.17）．本実験のように異な
る濃度の生化学物質を導入した場合には，両側からそれぞれの濃度に応じた遊走への
効果が働くことが予想される．図 4.15b に示された結果から，2 ng/mL 以上の VEGF 濃C-02
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図 4.16 下部流路に VEGF(+)培地を上部流路に VEGF(++)培地を加えた条件での培養結果．(a) 

培養 1 日目，培養 3 日目，培養 5 日目，培養 7 日目における GFP-HUVEC の蛍光像，(b) 血管
内皮細胞のスプラウト領域の面積，n = 3，mean±s.e.，(c) 血管新生様のスプラウトの伸長長さ．
n = 3，mean±s.e.
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度では，血管内皮細胞の遊走への効果がプラトーに達しているため，本実験の結果は，
条件 1 および 2 では両方向への遊走の効果に差が生じるが，条件 3 および 4 では差が
生じないと予想できる．実際の結果から，条件 1 および 2 では統計的に有意な差をもっ
て遊走への効果に差が見られることが分かった．一方で，条件 3 および 4 においては，
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(i) (ii) (iii) (iv)
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図 4.17 上部・下部流路にそれぞれ異なる濃度の VEGF を含む培地を導入した培養による内皮
細胞の遊走．(a) 培養 7 日目における GFP-HUVEC の蛍光像，(b) 血管内皮細胞のスプラウト領
域の面積．比較のため，図 4.15 で既に示したデータを一部再掲した．n = 3，mean±s.e.
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統計的に有意な差は見られないものの，濃度が高い側へのスプラウトのスプラウト領
域の面積が大きい傾向が見られた．これらの条件では，上部流路および下部流路に導
入する培地の VEGF 濃度の差がいずれの条件でも等しく 2 ng/mL となるため，2.14 節
の図 2.27 に示したように，濃度勾配の傾き自体は各条件とも同じになると考えられる．
ところが，結果としては，GFP-HUVEC の遊走は各条件によって異なることが分かっ
た．以上の結果から，2 ng/mL 以上の高濃度な条件においては，細胞表面の受容体で
の VEGF への応答がほとんど飽和し，濃度勾配の方向性を感知しにくくなることが示
唆された．このことは，血管内皮細胞が生化学物質の濃度勾配に応答して遊走する際に，
濃度の差だけではなく，濃度の絶対値により遊走の方向性等の決定への影響が異なる
ことが示唆されたと換言することも可能だと考えられる．

4.6　結言

　本章では，本デバイスの外側の二本の流路に，各種の増殖因子（VEGF，S1P，
PMA，MCP-1）や血管新生を促進する化学物質（CoCl2）を導入し，その条件下でス
フェロイドの培養を行った．観察の結果として得られた画像を解析することにより，
血管内皮細胞の両側のゲルへのスプラウト領域の面積を数値データとして取得した．
解析結果に基づく定量的な評価から，各生化学物質が，走化性能やケモキネシス能に
類似した，血管内皮細胞の遊走への異なる効果を示すことが分かった．さらに，デバ
イスに濃度の異なる VEGF を導入し，スフェロイドの培養を行った．結果として，血
管内皮細胞の遊走への効果は，濃度によって異なり，1 ng/mL 以上の濃度条件におい
て，統計的に有意な効果を示すことが明らかになった．最後に，二方向に異なる濃度
の VEGF を導入し，スフェロイドの培養を行った．結果として，異なる濃度の VEGF

がそれぞれ導入された二つの流路に対して，血管内皮細胞の遊走が起きた．この結果
から，VEGF による走化性能が二方向に対して働いたことが明らかになり，本デバイ
スが二方向への生化学物質の濃度勾配とそれによる血管内皮細胞の遊走への効果を実
現したことが示された．さらに，濃度勾配の傾きが等しい場合でも，濃度の絶対値が
異なると遊走への効果も異なるという示唆が本デバイスを用いることで得られた．
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第 ５ 章 　
結 論

5.1　結論

　本研究では，血管内皮細胞からなるスフェロイドを，二方向に形成された生化学物
質の濃度勾配下で，培養および観察可能なデバイスを構築した．さらに，作製したデ
バイスを用いて，種々の生化学物質の影響下でスフェロイドを培養し，血管内皮細胞
の遊走を定量解析することで，生化学物質による遊走性への効果を定量的に評価可能
であることを示した．
　本研究ではまず，本デバイスを二方向への生化学物質の濃度勾配の存在下における
血管内皮細胞の遊走性を観察・評価に用いるために必要だと考えられる基本的な機能
を，（i）ゲルの形成，（ii）スフェロイドの捕捉，（iii）各流路への送液，（iv）物質の濃
度勾配の形成により確認した．本デバイスでは，微小流路における上部流路と中央流路，
および下部流路と中央流路にそれぞれ挟まれた領域にゲル形成領域を設けた．このゲ
ル形成領域は，上部流路および下部流路から内側に窪んだ形状を持ち，同時にその高
さが上部流路，下部流路，および中央流路と比較して低くなっているという 2 つの構
造的な特徴により，ゲルをゲル形成領域に局所的に形成可能だった．また，中央流路
に流路が狭窄した箇所が存在し，そこが流れてきたスフェロイドを捕捉する捕捉部と
して機能するため，内皮細胞と繊維芽細胞からなるスフェロイドを静水圧を用いて捕
捉することが可能だった．捕捉したスフェロイドを一晩培養したところ，ゲルに接着し，
中央流路の逆側から培地を 3000 µL/ 分という高流量で送液しても，スフェロイドが流
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れ去ることなくゲルに接着したことが分かった．この状態で，上部流路および下部流
路への送液が可能だったため，ゲルが中央流路と上部・下部流路とを物理的に隔てて
いることと送液によっても破損しない充分な強度を有していることが確認された．さ
らに，上部流路および下部流路から蛍光デキストランを含む培地を流したところ，20

分間で濃度勾配が形成されることが分かった．以上の結果から，本デバイスが 2 方向
への生化学物質の濃度勾配を形成でき，内皮細胞を含むスフェロイドからの内皮細胞
の遊走性を観察するために必要な基本的な機能を備えていることが示された．
　本研究では続いて，本デバイスを用いてスフェロイドの静置培養を行うことで，捕
捉されたスフェロイドからゲルに細胞の遊走が実際に起きることを確認した．デモン
ストレーションとして，片側のみにゲルを形成できるデバイスを用い，スフェロイド
を 22 日間静置培養したところ，血管新生を含む血管内皮細胞のゲル方向への遊走が観
察された．この結果から，本デバイスが，上述した 4 つの要件に加え，実際にスフェ
ロイドを培養でき，またゲルへの細胞遊走を観察可能であることが示された．
本論文では最後に，実際に本デバイスを用いて，二方向への生化学物質の濃度勾配の
存在下における血管内皮細胞の遊走性を観察・評価した．上部流路および下部流路に
それぞれ別の生化学物質を含む培地を流してスフェロイドを培養したところ，各生化
学物質の種類や，異なる濃度に応じて，内皮細胞の遊走性が異なることが分かった．
さらに，観察結果の画像から血管内皮細胞のスプラウト領域の面積等を解析すること
により，使用する生化学物質の種類や濃度による血管内皮細胞の遊走への効果を定量
評価可能であることが示された．二方向から異なる濃度の VEGF による濃度勾配を形
成し，スフェロイドを培養した結果，VEGF の走化性能により二方向への血管内皮細
胞の遊走が観察された．この結果から，本デバイスが二方向への生化学物質の濃度勾
配とそれによる血管内皮細胞の遊走への効果を実現し，またそれを観察および定量評
価可能であることが示された．
　本研究を通して，種々の生化学物質を用いながらスフェロイドからの血管内皮細胞
の遊走を観察および定量評価することで，作製した培養デバイスが二方向の生化学物
質の濃度勾配存在下における血管内皮細胞の遊走性の汎用的な調査に有用であること
を示した．本デバイスは，複雑な生化学物質の環境を有する生体において，胚発生期
や腫瘍の成長時において重要とされる血管新生の方向性が決定される仕組みを調べる
ために，有用なツールとして応用可能であると期待される．



 117

5.2　今後の展望

　本研究の今後の展望としては，先述したような，腫瘍等の疾患治療のための薬剤開発，
さらには移植医療を目指した三次元組織構築に重要な内部への血管ネットワークの構
築といった幅広い領域への応用可能性を実装することが考えられる．
　腫瘍等の疾患治療のための薬剤開発については，まずスフェロイドの構成として血
管内皮細胞，線維芽細胞の他に，腫瘍由来の細胞を加えることで，腫瘍モデルとして
利用可能なスフェロイドを形成し，それを本研究のデバイス内で培養し，添加物とし
て抗血管新生薬を用いることで，血管内皮細胞の遊走に対する抑制効果が現れること
を実証する．さらに，生体内の腫瘍の微小環境を模倣して，抗血管新生薬と共に，様々
な血管新生促進物質を加えて実験を行うことにより，種々の生化学物質が豊富に存在
するような，生体により近い状況下における抗血管新生薬の効果をスクリーニングす
ることができると考えられる．
　移植医療を目指した三次元組織構築については，本デバイスの特徴の一つである，
培地灌流機能を活用した応用が考えられる．例えば，3.4 節に記載したように，本デバ
イスを用いて形成された新生血管の流路を介して培地をスフェロイドの内部に送液し
たり，3.6 節に記載したように，中央流路への培地灌流を行いながらスフェロイドを培
養することによって，スフェロイドの生存率を向上させてより大きなスフェロイドを
培養可能にしたり，内部に送液可能な血管ネットワークを構築したりするといったこ
とが実現可能だと期待される．また，血管新生が生じるために必要十分な生化学物質
の濃度勾配をかけるタイミングを調べるために，本デバイスが役立つと考えられる．
例えば，培養開始から最初の数日間のみ生化学物質の濃度勾配のかかった状態を保持
し，その後は生化学物質の濃度勾配が存在しない状態で培養を続けた場合に，血管新
生は生じるのか，また血管新生が生じるための最低限度の時間的条件を調べることは
できるのか等の疑問を本デバイスで解決することにより，より効率的に血管新生を制
御する条件を確立することができれば，組織工学の分野に寄与し得ると期待される．
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きましたことに，改めて感謝申し上げます．ご多忙な中でも自ら手を動かして実験を
進める研究者としての姿や，学内の様々な学務に携わったり，高校訪問等の学外への
アウトリーチ活動を行ったりする教育者としての姿から，公共に奉仕する姿勢を学ば
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せて頂いたと考えております．
　次に，筆者の研究生活を最も近くで支えて下さった竹内研究室の皆様に御礼を申し
上げます．まず，聶銘昊 助教には，本研究の共著者として，研究推進にあたっての具
体的な指針やアドバイスを頂きました．また，学会発表や論文執筆にあたっては論理
構成を一緒に考えて頂いたり，英語の文章校閲を丁寧に行って頂いたり等，聶先生の
ご協力とご指導なくしては，本研究は成立しませんでした．普段から気さくに声をか
けられる柔和な雰囲気のお陰で，安心して研究を進められるという精神面でのサポー
トを賜ると同時に，時には真剣に今後の研究の方針をどうするのかと問答をしていた
だき身が引き締まることもありました．筆者に関わり続けて下さったことに深く感謝
申し上げます．
　また，三浦重徳 特任講師にも，本研究の共著者として，特に血管関連の知識やロジッ
クをご教授頂き，大変感謝しております．三浦先生の懐の深い知識量と的確なアドバ
イスのお陰で，終盤期に効率よく研究を進めることができたと実感しております．投
稿論文執筆時の一週間では，両足に縋りつくかのような勢いで助けを求めた筆者に対
して，深夜を超えて早朝まで文章校正にお付き合いいただく等，見放すこと無くご指
導下さったことに心より感謝しております．
　森本雄矢 准教授には，博士課程が始まってすぐの頃に，「論文を書け」と強いプレッ
シャーを与えて頂きました．当時は大変でしたが，あの時に森本先生が何度も激励の
言葉をかけて下さらなかったら，鎖状ファイバの研究が論文化されるまでにもっと時
間がかかり，本論文の研究への着手がずっと遅れていたに違いありません．新しいテー
マに移り，共著者としての関りが無くなった後も，事ある度に声をかけて下さったこ
とに深く感謝しております．
　森宣仁 博士（現 産業技術総合研究所 研究員）には，修士課程の 2 年間で，竹内研
究室のルールや細胞培養の基本から，国際学会の予稿の書き方，修士のテーマでの論
文執筆に至るまで，丁寧にご指導頂きました．その後，森さんが竹内研究室を離れて
からも，研究のための文章やスライドを作る機会がある度に，森さんが研究室に残さ
れた論文やスライドを参考にさせて頂きました．実は，この博士論文も森さんの博士
論文のフォーマットをそのまま使用して執筆しているものです．また，森さんに教え
て頂いた技術をきっかけとして，皮膚関連のテーマで二人，血管関連のテーマでも二
人の後輩を教えることになり，森さんがご卒業された後にも，3 年間ずっと森さんに
お世話になりっぱなしだったように思います．
　研究員として研究室生活で関わって下さいました，大崎寿久 特任助教，小田悠加 特
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任助教，島亜衣 特任助教，小沢文智 博士，澤山淳 博士，高山由貴 博士（キヤノンメディ
カルシステムズ株式会社），古橋麻衣 さん（日清食品ホールディングス株式会社），三
村久敏 博士，Dina Myasnikova 博士，および神谷厚輝 博士（現 群馬大学 准教授），佐
藤暁子 さん（現 女子美術大学 准教授），清水久史 博士（現 東京大学 特任助教），杉浦
広峻 博士（現 東京大学 助教），杉本悠 博士（現 東京大学 特任研究員），長田翔伍 博士（現 

東京医科歯科大学 助教），山田哲也 博士（現 東京工業大学 助教）には，ミーティング
や普段の会話において，貴重なご助言，ご指摘を頂きました．研究室で 5 年間楽しく
生活でき，たくさんの思い出を作れたのは，皆様との普段の何気ない会話や，学会出
張時の交流のお陰です．この場をお借りして深く御礼申し上げます．
　技術補佐員として研究室での生活をご支援下さいました，青柳星見 さん，伊藤茜 さ
ん，小貫真委子 さん，斎藤知美 さん，清澤まひろ さん，故 勢司泰久 さん，時下祥子 博士，
滝本晶 博士，野上こずえ さん，松永栄美 さん，矢野真理子 さん，吉田寛文 さんにも
感謝申し上げます．特に，小貫さんには，装置の使用方法から備品・試薬の場所まで，
研究室に関する幅広い事柄を教えて頂きました．また，装置の整備や消耗品の管理等
をしていただいたおかげで，研究を円滑に推進することができました．事務補佐員の
荒川桂子 さん，伊藤真以子 さん，今井友美 さん，牧野美奈子 さん，山口かほり さん，
渡邉守絵 さんにも感謝申し上げます．物品購入，伝票処理，出張申請等の事務手続き
で大変お世話になりました．
　博士課程を共に過ごさせて頂きました，岡谷泰佑 博士（現 東北大学 助教），松平謙
英 博士（現 ソニー株式会社），酒井香苗 博士（トヨタ紡織株式会社），高森翔 博士，
平田優介 博士，菅原啓亮 さん，安永竣 さん，新田慧 さん，趙炳郁 さんに感謝申し上
げます．特に，平田さんとは，同期として 5 年間を共に過ごさせて頂きました．本論
文の統計データに有意差を示す＊が付いたのは，平田さんが懇切丁寧に統計について
説明してくれ，さらにダネットの検定のR言語のスクリプトの作成という手厚いサポー
トをして下さったお陰です．また，この 1 年間は，平田さんが一緒に頑張っている姿
を見て，厳しい時期を乗り越えることができました．同期に平田さんがいてくれて本
当に良かったです．ありがとう．
　修士課程学生および学部生として筆者と共に研究室で過ごして下さいました，申東
哲 さん，五反田真秀 さん，横溝晃世 さん，石井康彬 さん，Jaras Edvin さん，木原一
挙 さん，島谷純平 さん，鈴木良介 さん，早田龍太郎 さん，立花岳志 さん，平野聖治 

さん，古谷嘉崇 さん，水木佑哉 さん，ヴァルハマ健 さん，伊藤嘉玖 さん，Nebibanga 

Evina さん，河井理雄 さん，清水直人 さん，砂川晃広 さん，松本美希 さん，森藤陸
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太 さん，山田拓実さん，李珍和 さん，秋山正道 さん，稲垣智之 さん，金城立来 さん，
中山智仁 さん，成田侑史 さん，橋本和泉 さん，林凌 さん，堀内健太 さん，松下和磨 

さん，松村茜 さん，宮澤岳志 さん，伊藤元規 さん，上野永遠 さん，大岸憲人 さん，
中根卓馬 さん，菱沼拓未 さん，福島健太 さん，福島皓平 さん，山本幹久 さんに感謝
いたします．研究室での生活や研究に対する姿勢等，たくさんのことを学ばせて頂き
ました．特に，早田さん，稲垣さん，中山さん，林さんとは，メンターとして研究に
関わらせて頂き，こちらが教えているようで逆に様々なことを学ぶことができた貴重
な経験をすることができました．
　続いて，筆者がこのような素晴らしい環境で学ぶ機会を得ることができるまでにお
世話になった先生方への感謝をこの場をお借りして記させて頂きます．まず，筆者の
巣鴨高等学校在学時の担任である新井君男 先生に御礼申し上げます．新井先生には，
「嘘をつかず，誠実であれ」「物事を真摯に受け止めろ」といった教えを賜り，人とし
てどうあるべきかを教えて頂きました．さらには，高校生のための研究体験プログラ
ム（JST 助成「未来の科学者養成講座」最先端研究を取り入れたジュニア科学者養成
プログラム 2009 年度 最先端リサーチ「体験」）をご紹介下さり，それが筆者が研究の
世界に興味を持つきっかけとなりました．そのプログラムで筆者にとって初めての研
究をご指導下さったのが東京大学生産技術研究所 岡部徹 教授でした．岡部先生には，
高校在学時だけではなく大学入学後にも学部生のための研究体験プログラム（UROP）
を通じて，沖縄やボストンで行われた学会に参加し発表する機会を賜り，研究の世界
の楽しさを教えて頂きました．さらには，御礼の仕方や申請書の書き方等を始めとし，
社会で生きる人として必要な基本的なことを叩き込んで頂きました．岡部先生にご紹
介頂きながら UROP に関連して数多くの学びの機会を賜り，東京大学生産技術研究所 

大島まり 教授，同 藤井輝夫 教授，同 川越至桜 准教授を始めとする先生方に折に触れ
て目をかけて頂きました．誠にありがとうございました．また，学部 4 年次に研究を
ご指導頂いた東京大学先端科学技術研究センター 岡本晃充 教授および山口哲志 准教
授にも感謝申し上げます．特に，山口先生には実験や発表に関して直接ご指導頂いた
だけではなく，大学院で竹内研究室に進むことを後押しして頂きました．筆者が大学
院で竹内研究室に移ること検討し相談した際に，「研究室の教員としては引き止めたい．
けれど，研究者の先輩としては背中を押すよ」と温かい声をかけて下さったことに今
でも感謝しております．
　最後になりますが，大学院を修了するまで 27 年間筆者を支えて下さった両親に深く
感謝いたします．
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付録　スフェロイド解析マクロ全文

図 S1　Fiji ソフトウェアを用いたスフェロイドの自動解析マクロの全文

図 S1　Fiji ソフトウェアのスフェロイド自動解析マクロ全文．
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